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   Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation for the specific task, in particular its warning notices and 
safety instructions. Qualified personnel are those who, based on their training and experience, are capable of 
identifying risks and avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be adhered to. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 

 

 Siemens AG 
Industry Sector 
Postfach 48 48 
90026 NÜRNBERG 
GERMANY 

Order number: 6SL3097-4AF00-0BP0  
Ⓟ 02/2010 

Copyright © Siemens AG 2007, 
2008, 2009. 
Technical data subject to change
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Preface 

SINAMICS documentation 
The SINAMICS documentation is organized in two parts: 
● General documentation/Catalogs 
● Manufacturer/service documentation 
A current overview of the documentation in the available languages is provided on the 
Internet: 
http://www.siemens.com/motioncontrol 
Select the menu items "Support" --> "Technical Documentation" --> "Overview of 
Publications." 
The Internet version of DOConCD (DOConWEB) is available on the Internet: 
http://www.automation.siemens.com/doconweb 
Information on the range of training courses and FAQs (Frequently Asked Questions) are 
available on the Internet: 
http://www.siemens.com/motioncontrol 
Select the menu item "Support". 

Usage phases and their tools/documents (as an example)  

Table 1 Usage phases and the available documents/tools 

Usage phase Document/tool 
Orientation SINAMICS S Sales Documentation 
Planning/configuration • SIZER Configuration Tool 

• Configuration Manuals, Motors 

Deciding/ordering SINAMICS S Catalogs 
Installation/assembly • SINAMICS S120 Manual for Control Units and Additional 

System Components 
• SINAMICS S120 Manual for Booksize Power Units 
• SINAMICS S120 Manual for Chassis Power Units 
• SINAMICS S120 Manual for AC Drives 

Commissioning • STARTER parameterization and commissioning tool 
• SINAMICS S120 Getting Started 
• SINAMICS S120 Commissioning Manual 
• SINAMICS S120 CANopen Commissioning Manual 
• SINAMICS S120 Function Manual 
• SINAMICS S120/S150 List Manual 

Usage/operation • SINAMICS S120 Commissioning Manual 
• SINAMICS S120/S150 List Manual 

http://www.siemens.com/motioncontrol
http://www.automation.siemens.com/doconweb
http://www.siemens.com/motioncontrol
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Usage phase Document/tool 
Maintenance/servicing • SINAMICS S120 Commissioning Manual 

• SINAMICS S120/S150 List Manual 

References • SINAMICS S120/S150 List Manual 

Target group 
This documentation is intended for machine manufacturers, commissioning engineers, and 
service personnel who use the SINAMICS S drive system. 

Benefits 
The Commissioning Manual describes all the information, procedures and operational 
instructions required for commissioning and servicing SINAMICS S120. 

Search tools 
The following guides are provided to help you locate information in this manual: 
1. Contents 
2. List of abbreviations 
3. Index 
Standard scope 
The scope of the functionality described in this document may differ from the scope of the 
functionality of the drive system that is actually supplied. 
● It may be possible for other functions not described in this documentation to be executed 

in the drive system. However, no claim can be made regarding the availability of these 
functions when the equipment is first supplied or in the event of servicing. 

● Functions that are not available in a particular product version of the drive system may be 
described in the documentation. The functionality of the supplied drive system should 
only be taken from the ordering documentation. 

● Extensions or changes made by the machine manufacturer must be documented by the 
machine manufacturer. 

For reasons of clarity, this documentation does not contain all of the detailed information on 
all of the product types. This documentation cannot take into consideration every 
conceivable type of installation, operation and service/maintenance. 
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Technical Support 
If you have any questions, please contact us on the following hotline: 
 
 Europe/Africa 
Phone +49 180 5050 - 222 
Fax +49 180 5050 - 223 
Internet http://www.siemens.de/automation/support-request 

 

 
 America 
Phone +1 423 262 2522 
Fax +1 423 262 2200 
E-mail mailto:techsupport.sea@siemens.com 

 

 
 Asia/Pacific 
Phone +86 1064 757 575 
Fax +86 1064 747 474 
E-mail mailto:support.asia.automation@siemens.com 

 
 

 Note 
National telephone numbers for technical support are provided under the following Internet 
address:  
http://www.siemens.com/automation/service&support 
Calls are subject to charge (e.g. € 0.14/min from fixed lines within Germany). 
Tariffs of other phone providers may differ. 

 

Questions on the manual 
If you have any questions (suggestions, corrections) regarding this documentation, please 
fax or e-mail us at: 
 
Fax +49 9131 98 2176 
E-mail mailto:docu.motioncontrol@siemens.com 

A fax form is available in the appendix of this document. 

Internet address for SINAMICS 
http://www.siemens.com/sinamics 

mailto:techsupport.sea@siemens.com
mailto:support.asia.automation@siemens.com
http://www.siemens.com/automation/service&support
mailto:docu.motioncontrol@siemens.com
http://www.siemens.com/sinamics
http://www.siemens.de/automation/support-request
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Notation 
The following notation and abbreviations are used in this documentation: 

Notation for parameters (examples): 
● p0918 Adjustable parameter 918 
● r1024 Visualization parameter 1024 
● p1070[1] Adjustable parameter 1070, index 1 
● p2098[1].3 Adjustable parameter 2098, index 1, bit 3 
● p0099[0...3] Adjustable parameter 99, indices 0 to 3 
● r0945[2](3) Visualization parameter 945, index 2 of drive object 3 
● p0795.4 Adjustable parameter 795, bit 4 

Notation for faults and alarms (examples): 
● F12345 Fault 12345 
● A67890 Alarm 67890 
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ESD Notes 
 

CAUTION  
Electrostatic sensitive devices (ESD) are single components, integrated circuits or devices 
that can be damaged by electrostatic fields or electrostatic discharges. 
Regulations for the ESD handling: 
During the handling of electronic components, pay attention to the grounding of the person, 
workplace and packaging! 
Electronic components may be touched by persons only when 
• these persons are grounded using an ESD bracelet, or 
• these persons in ESD areas with a conducting floor wear ESD shoes or ESD grounding 

straps. 
Electronic components should be touched only when this is unavoidable. The touching is 
permitted only on the front panel or on the circuit board edge. 
Electronic components must not be brought into contact with plastics or clothing made of 
artificial fibers. 
Electronic components may only be placed on conducting surfaces (table with ESD coating, 
conducting ESD foamed material, ESD packing bag, ESD transport container). 
Electronic components may not be placed near display units, monitors or televisions 
(minimum distance from the screen > 10 cm). 
Measurements must only be taken on boards when the measuring instrument is grounded 
(via protective conductors, for example) or the measuring probe is briefly discharged before 
measurements are taken with an isolated measuring device (for example, touching a bare 
metal housing). 
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Safety notices 
 

DANGER  
• Commissioning is absolutely prohibited until it has been completely ensured that the 

machine, in which the components described here are to be installed, is in full 
compliance with the provisions of the EC Machinery Directive. 

• SINAMICS devices and AC motors may only be commissioned by suitably qualified 
personnel. 

• The personnel must take into account the information provided in the technical customer 
documentation for the product, and be familiar with and observe the specified danger 
and warning notices. 

• When electrical equipment and motors are operated, the electrical circuits automatically 
conduct a dangerous voltage. 

• Dangerous mechanical movements are possible during system operations. 
• All the work carried out on the electrical machine or system must be carried out with it in 

a no-voltage condition. 
• SINAMICS devices with three-phase motors must only be connected to the power 

supply via a universal current-sensitive residual current operated device with selective 
switching once it has been verified that the SINAMICS device is compatible with the 
residual current operated device in accordance with IEC 61800-5-1. 

 

 
 

WARNING  
• The successful and safe operation of this equipment and motors is dependent on 

professional transport, storage, installation and mounting as well as careful operations, 
service and maintenance. 

• Information and data from the catalogs and quotations also apply to special versions of 
the equipment and motors. 

• In addition to the danger and warning information provided in the technical customer 
documentation, the applicable national, local, and plant-specific regulations and 
requirements must be taken into account. 

• Only protective extra-low voltages (PELV) that comply with EN60204-1 may be 
connected to all connections and terminals between 0 and 48 V. 

 

 
 

CAUTION  
• The motors can have surface temperatures of over +80 °C. 
• This is why temperature-sensitive components, e.g. cables or electronic components 

must not be in contact with or attached to the motor. 
• When connecting up cables, please ensure that they 

– are not damaged 
– are not subject to tensile stress 
– cannot be touched by rotating components. 
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CAUTION  
• As part of routine tests, SINAMICS devices with three-phase motors undergo a voltage 

test in accordance with IEC 61800. Before the voltage test is performed on the electrical 
equipment of industrial machines to EN 60204-1, Section 18.4, all connectors of 
SINAMICS devices must be disconnected/withdrawn to prevent the equipment from 
being damaged. 

• Motors should be connected up according to the circuit diagram provided otherwise they 
may be destroyed. 

 

 
 

CAUTION  
Terminals for pulse inhibit (EP terminals) 
The Safe Torque Off (STO) safety function must be parameterized in order to use the pulse 
inhibit terminals at the Motor Modules, booksize, booksize compact, chassis and Cabinet 
Modules and at the Power Modules, chassis and blocksize. (Safety Integrated Basic 
Functions or Extended Functions) 
Here, the procedure is described in the FHS and FH1 Function Manuals. 

 

 
 

 Note 
When operated in dry areas, SINAMICS devices with three-phase motors conform to Low-
Voltage Directive 2006/95/EC. 
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Preparations for Commissioning 1
 

Before commissioning observe the conditions described in this chapter. 
● The preconditions for commissioning must be fulfilled (in the next chapter) 
● The relevant checklist must have been worked through 
● The BUS components required for communication must be wired up 
● DRIVE-CLiQ wiring rules must be complied with (refer to the examples) 
● ON-OFF drive responses 
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1.1 Requirements for commissioning 
The following are necessary for commissioning a SINAMICS S drive system: 
● STARTER commissioning tool 
● An interface, e.g. PROFIBUS, CANbus, PROFINET or serial 
● Completely wired-up drive line-up (see the Manual) 
The following diagram shows a sample configuration with booksize and chassis components. 

 
Figure 1-1 Component configuration (example) 
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1.2 Check lists to commission SINAMICS S 

Checklist (1) for commissioning booksize power units 
The following checklist must be carefully observed. Read the safety instructions in the 
Manuals before starting any work.  

Table 1- 1 Checklist for commissioning (booksize)  

Check OK 
Are the environmental conditions in the permitted range?   
Is the component firmly attached to the fixing points provided?  
Is the specified air flow for cooling the devices ensured?  
Have the ventilation clearances for the components been observed?  
Is the memory card correctly inserted in the Control Unit?  
Are all necessary components of the configured drive line-up available, installed and 
connected? 

 

Do the temperature monitoring circuits fulfill the specifications of protective separation 
according to DIN EN 61800-5-1? 

 

Have the DRIVE-CLiQ topology rules been observed?  
Have the line-side and motor-side power cables been dimensioned and routed in 
accordance with the environmental and routing conditions? 

 

Have the maximum permissible cable lengths between the frequency converter and 
the motor (depending on the type of cables used) been observed? 

 

Have the power cables been properly connected to the component terminals with the 
specified torque?  

 

Have all of the remaining screws been tightened to the specified torque?  
Has all wiring work been successfully completed?  
Are all connectors correctly plugged in and screwed in place?  
Have all the covers for the DC link been closed and latched into place?  
Have the screens been correctly connected through a large surface area?  

Checklist (2) for commissioning chassis power units 
The following checklist must be carefully observed. Read the safety instructions in the 
Manuals before starting any work.  

Table 1- 2 Checklist for commissioning (chassis)  

Activity OK 
Are the environmental conditions in the permitted range?  
Are the components correctly installed in the cabinets?  
Is the specified air flow for cooling the devices ensured?  
Is an air short-circuit between the air inlet and outlet for the chassis components 
prevented by the installation arrangements? 

 

Have the ventilation clearances for the components been observed?  
Is the memory card correctly inserted in the Control Unit?  
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Activity OK 
Are all necessary components of the configured drive line-up available, installed and 
connected? 

 

Do the temperature monitoring circuits fulfill the specifications of protective separation 
according to DIN EN 61800-5-1?  

 

Have the DRIVE-CLiQ topology rules been observed?  
Have the line-side and motor-side power cables been dimensioned and routed in 
accordance with the environmental and routing conditions? 

 

Have the maximum permissible cable lengths between the frequency converter and 
the motor (depending on the type of cables used) been observed? 

 

Is the ground for the motors directly connected to the ground for the Motor Modules 
(shortest distance)? 

 

Are the motors connected with shielded power cables?  
Are the power cable shields connected as closely as possible to the terminal box 
across a wide area? 

 

Have the power cables been properly connected to the component terminals with the 
specified torque?  

 

Have all of the remaining screws been tightened to the specified torque?  
Has the total power of the DC busbar been dimensioned sufficiently?  
Has the busbar/wiring for the DC connection between the infeed and the Motor 
Modules been dimensioned sufficiently with regard to the load and installation 
conditions? 

 

Are the cables between the low-voltage switchgear and the power unit protected with 
line fuses? Line protection(1) should be taken into account.  

 

Have measures been taken to relieve strain on the cables?  
For external auxiliary infeed: Have the cables for the auxiliary infeed been connected 
according to the Manual? 

 

Have the control cables been connected in accordance with the required interface 
configuration and the shield applied? 

 

Have the digital and analog signals been routed with separate cables?   
Has the distance from power cables been observed?  
Has the cabinet been properly grounded at the points provided?  
Has the connection voltage for the fans in the chassis components been adapted 
accordingly to the supply voltages? 

 

For operation on non-grounded supply systems: Has the connection bracket for the 
interference suppression on the infeeds been removed? 

 

Is the period from the date of manufacture to initial commissioning or the downtime of 
the power components less than two years(2)? 

 

Is the drive operated by higher-level controller/control room?  
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Checklist (3) for commissioning blocksize Power Modules 
The following checklist must be carefully observed. Read the safety instructions in the 
Manuals before starting any work.  

Table 1- 3 Check list for commissioning blocksize  

Check OK 
Are the environmental conditions in the permitted range?   
Is the component firmly attached to the fixing points provided?  
Is the specified air flow for cooling the devices ensured?  
Have the ventilation clearances for the components been observed?  
Is the memory card correctly inserted in the Control Unit?  
Are all necessary components of the configured drive line-up available, installed and 
connected? 

 

Do the temperature monitoring circuits fulfill the specifications of protective separation 
according to DIN EN 61800-5-1? 

 

Have the line-side and motor-side power cables been dimensioned and routed in 
accordance with the environmental and routing conditions? 

 

Have the maximum permissible cable lengths between the frequency converter and 
the motor (depending on the type of cables used) been observed? 

 

Have the power cables been properly connected to the component terminals with the 
specified torque?  

 

Have all of the remaining screws been tightened to the specified torque?  
Has all wiring work been successfully completed?  
Are all connectors correctly plugged in and screwed in place?  
Have the screens been correctly connected through a large surface area?  

 
(1) Combined fuses are recommended for conductor and semi-conductor protection 
(VDE 636, Part 10 and Part 40 / EN 60269-4). For information about the relevant fuses, see 
the catalog. 
(2) If the downtime period is longer than two years, the DC link capacitors must be reformed 
(see the "Maintenance and Servicing" chapter in the Manual). If the downtime period is less 
than two years, reforming is not necessary. The cabinet rating plate can be used to ascertain 
the date of manufacture.  



Preparations for Commissioning  
1.3 PROFIBUS components 

 Commissioning Manual 
22 Commissioning Manual, (IH1), 11/2009, 6SL3097-4AF00-0BP0 

1.3 PROFIBUS components 
We recommend the following components for communication via PROFIBUS:  
1. Communication modules if PG/PC interface via the PROFIBUS interface 

– CP5511 (PROFIBUS connection via PCMCIA card in the notebook as programming 
device) 
PROFIBUS card CP5511 permits a maximum of 10 slave connections to be 
established. For large projects (many CUs) with several drive units - and therefore 
more than 10 PROFIBUS slaves - problems can be encountered when STARTER 
goes online with the notebook. 
Remedy: Replace interface card CP5511 with a CP5512 interface card or via menu 
item "Select target system/target devices..." only select the drive units that you 
actually want to work with. 

– CP5512 (PROFIBUS connection via CARDBUS) 
Configuration: PCMCIA type 2 card + adapter with 9-pin SUB-D socket for connection 
to PROFIBUS.  
For MS Windows 2000/XP Professional and PCMCIA 32 only 
Order No.: 6GK1551-2AA00 

– CP5611 A2 (PROFIBUS connection via short PCI card) 
Configuration: Short PCI card with 9-pin SUB-D socket for connection to PROFIBUS. 
Not for Windows 95/98SE 
Order No.: 6GK1561-1AA01 

– CP5613 A2 (PROFIBUS connection via short PCI card) 
Configuration: Short PCI card with 9-pin SUB-D socket for connection to PROFIBUS. 
Order No.: 6GK1561-3AA01 

– CP5711 (PROFIBUS connection via USB port (USB V2.0)) 
Configuration: USB port (USB V2.0) + adapter with 9-pin SUB-D socket connector to 
connect to PROFIBUS.  
Used with driver SIMATIC Net PC Software Edition 2008 + SP2 
Order No.: 6GK1571-1AA00 

2. Connecting cable 
– between: CP 5xxx ↔ PROFIBUS 

Order No.: 6ES7901-4BD00-0XA0 
– MPI cable (SIMATIC S7) 

Order No.: 6ES7901-0BF00-0AA0 
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Cable lengths 

Table 1- 4 Permissible PROFIBUS cable lengths 

Baud rate [bit/s] Max. cable length [m] 
9.6 k to 187.5 k 1000 
500 k 400 
1.5 M 200 
3 to 12 M 100 

1.4 PROFINET components 
We recommend the following components for communication via PROFINET: 
1. Communication modules if PG/PC interface via the PROFINET interface 

 

 
 

Note 
A standard Ethernet interface can be used for pure commissioning with STARTER.  
The CBE20 supports all Ethernet cables (crossover cable and Ethernet cable).  

 

2. Recommended connecting cable  
– Industrial Ethernet FC TP Standard Cable GP 2 x 2 (up to max. 100 m) 

Standard bus cable with rigid conductors and a special design for fast installation 
Order No.: 6XV1840-2AH10 

– Industrial Ethernet FC TP Flexible Cable GP 2 x 2 (up to max. 85 m) 
Order No.: 6XV1870–2B 

– Industrial Ethernet FC Trailing Cable GP 2 x 2 (up to max. 85 m) 
Order No.: 6XV1870–2D 

– Industrial Ethernet FC Trailing Cable 2 x 2 (up to max. 85 m) 
Order No.: 6XV1840–3AH10 

– Industrial Ethernet FC Marine Cable 2 x 2 (up to max. 85 m) 
Order No.: 6XV1840–4AH10 

3. Recommended connectors 
– Industrial Ethernet FC RJ45 Plug 145 for Control Unit 

Order No.: 6GK1901-1BB30-0Ax0 



Preparations for Commissioning  
1.5 Connection via serial interface 

 Commissioning Manual 
24 Commissioning Manual, (IH1), 11/2009, 6SL3097-4AF00-0BP0 

1.5 Connection via serial interface 

Prerequisites  
There must be a serial interface (COM) on the PC from which the connection is to be made. 

Connecting cable 
A zero modem cable is required to connect the serial interfaces of the PG/PC to the 
SINAMICS S120. 

Settings 
1. In the STARTER, go to Project > Set PG/PC interface and select the Serial cable (PPI) 

interface. 
If this interface is not in the selection list, you will first have to add it using Select. 
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Note 
If the interface cannot be added to the selection menu, the driver for the serial interface 
has to be installed.  
This is located under the following path on the STARTER CD: 
\installation\starter\starter\Disk1\SerialCable_PPI\ 
The STARTER must not be active while the driver is being installed. 

 

2. Enter the following settings. The "0" address and the transmission rate (e.g. 19.2 kbit/s) 
are important here. 

 
Figure 1-2 Setting the interface 

3. The Control Unit's PPI address is pre-set to "3" in the factory. 
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4. Also set the bus address to "3" during set-up, or under "properties" in the drive unit 
context menu. 

 
Figure 1-3 Setting the bus address 

5. A null modem cable must be used to connect the PC (COM interface) to the Control Unit. 
This interface must not be switched. 

1.6 Rules for wiring with DRIVE-CLiQ 
Rules apply for wiring components with DRIVE-CLiQ. A distinction is made between binding 
DRIVE-CLiQ rules, which must be unconditionally observed and recommended rules, 
whichshould  then be maintained so that the topology, generated offline in STARTER, no 
longer has to be changed.  
The maximum number of DRIVE-CLiQ components and the possible wiring form depend on 
the following factors: 
● The binding DRIVE-CLiQ wiring rules 
● The number and type of activated drives and functions on the Control Unit in question 
● The computing power of the Control Unit in question 
● The set processing and communication cycles 
Below you will find the binding wiring rules and some other recommendations as well as a 
few sample topologies for DRIVE-CLiQ wiring. 
The components used in these examples can be removed, replaced with others or 
supplemented. If components are replaced by another type or additional components are 
added, the SIZER tool should be used to check the topology. 
If the actual topology does not match the topology created offline by STARTER, the offline 
topology must be changed accordingly before it is downloaded. 
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1.6.1 General rules from CU320-2 

DRIVE-CLiQ rules 
The wiring rules below apply to standard cycle times (servo 125 µs, vector 400 µs). For cycle 
times that are shorter than the corresponding standard cycle times, additional restrictions 
apply due to the computing power of the CU (configuration via the SIZER tool). 
The rules below apply on a general basis, unless limited, as a function of the firmware 
version. 
● A maximum of 8 DRIVE-CLiQ nodes can be connected in one row. A row is always seen 

from the perspective of the Control Unit. 
● A maximum of 24 nodes can be connected to one DRIVE-CLiQ line at a Control Unit. 
● A maximum of 12 V/f (or 6 servo/vector) drives + infeed module + supplementary module 

are permitted. 
● Ring wiring is not permitted. 
● Components must not be double-wired. 

 
Figure 1-4 Example: DRIVE-CLiQ line at terminal X103 of a Control Unit  

● The TM54F must not be operated on the same DRIVE-CLiQ line as Motor Modules. 
● The Terminal Modules TM15, TM17 and TM41 have faster sample cycles than the TM31 

and TM54F. For this reason, the two Terminal Module groups must be connected to 
separate DRIVE-CLiQ lines. 

● Only one Line Module can be connected to a Control Unit. Further Line Modules may be 
connected in parallel to this Line Module. 

● If using chassis design components, no more than one Smart Line Module and one Basic 
Line Module may be jointly operated on one Control Unit (mixed operation on a DRIVE-
CLiQ line). 

● The default sampling times may be changed. 
● A maximum of 12 Motor Modules can be connected to the CU320-2. 
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● Mixed operation (servo with vector V/f control) is possible. 
● One servo axis corresponds to 2 V/f axes 
● During mixed operation of servo and vector V/f control, separate DRIVE-CLiQ lines must 

be used for Motor Modules (mixed operation is not permissible on Double Motor 
Modules). 

● For V/f control, more than 4 nodes can only be connected to one DRIVE-CLiQ line of the 
Control Unit. 

● A maximum of 9 encoders can be connected. 
● A maximum of 8 Terminal Modules can be connected to the CU320-2. 
● The Active Line Module booksize and Motor Modules booksize 

– can be connected to one DRIVE-CLiQ line in servo mode. 
– must be connected to separate DRIVE-CLiQ lines in vector mode. 

● The Line Module (chassis) (Active Line, Basic Line, Smart Line) and the Motor Modules 
(chassis) must be connected to separate DRIVE-CLiQ lines. 

● Motor Modules in chassis format with different current controller cycles must be 
connected to separate DRIVE-CLiQ lines. For this reason, chassis Motor Modules and 
booksize Motor Modules must be connected to separate DRIVE-CLiQ lines. 

● A maximum of 2 VSM may be connected to a Line Module. 
● The Voltage Sensing Module (VSM) should be connected to a free DRIVE-CLiQ port of 

the corresponding Active Line Module / Motor Module (due to automatic assignment of 
the VSM). 

● The sampling times (p0115[0] and p4099) of all components that are connected to a 
DRIVE-CLiQ line must be divisible by one another with an integer result. If the current 
controller sampling time on a DO has to be changed to another pattern that does not 
match the other DOs on the DRIVE-CLiQ line, the following options are available: 
– Reconnect the DO to a separate DRIVE-CLiQ line. 
– Also change the current controller sampling time and the sampling time of the 

inputs/outputs of the DOs not involved so that they again fit into the time grid. 
● For supplementary telegrams at DRIVE-CliQ (e.g. Safety Extended, spindle sensor 

systems, diagnostic telegrams), the drives must distributed across various PORTS. 
● For integrated platforms, a IDC(FW2.x) / SoC2 (FW4.x) combination is NOT permitted. 
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 Note 
A Double Motor Module, a DMC20, a TM54F and a CUA32 each correspond to two DRIVE-
CLiQ participants. This also applies to Double Motor Modules, of which just one drive is 
configured. 

 

 Note 
You can call up the "Topology" screen in STARTER to change and/or check the DRIVE-
CLiQ topology for each drive unit. 

 

 Note 
To enable the function "Automatic configuration" to assign the encoders to the drives, the 
recommended rules below must be observed. 

 

Recommended rules  
● The DRIVE-CLiQ cable from the Control Unit must be connected to X200 on the first 

booksize power unit or X400 on the first chassis power unit. 
● The DRIVE-CLiQ connections between the power units must each be connected from 

interface X201 to X200/from X401 to X400 on the follow-on component. 
● A Power Module with the CUA31 should be connected to the end of the DRIVE-CLiQ line. 

 
Figure 1-5 Example: DRIVE-CLiQ line 

● The motor encoder must be connected to the associated power unit. 

Table 1- 5 Connecting the motor encoder via DRIVE-CLiQ 

Component Connecting the motor encoder via DRIVE-CLiQ 
Single Motor Module booksize X202 
Double Motor Module booksize • Motor connection X1: Encoder at X202 

• Motor connection X2: Encoder at X203 

Single Motor Module chassis X402 
Power Module blocksize • CUA31: Encoder at X202 

Power Module chassis X402 
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 Note 
If an additional encoder is connected to a Motor Module, it is assigned to this drive as 
encoder 2 in the automatic configuration. 

 

 
Figure 1-6 Example of a topology with VSM for chassis components 

Table 1- 6 VSM connection 

Design Component VSM connection 
Booksize Active Line Module X102 at the Control Unit 
Chassis Active Line Module  X402 at the Active Line Module 
Blocksize Power Modules The VSM is not supported. 

 
 

 Note 
Booksize format 
The VSM must be connected to a separate DRIVE-CLiQ interface on the Control Unit. 

 

● Only one final node should ever be connected to free DRIVE-CLiQ ports of components 
within a DRIVE-CLiQ line (e.g. Motor Modules wired in series),  
for example, one Sensor Module or one Terminal Module, without forwarding to additional 
components. 

● If possible, Terminal Modules and Sensor Modules of direct measuring systems should 
not be connected to the DRIVE-CLiQ line of Motor Modules but rather to free DRIVE-
CLiQ ports of the Control Unit. 
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1.6.2 Sample wiring for vector drives 

Drive line-up comprising three Motor Modules (chassis) with identical pulse frequencies or vector 
(booksize) 

Motor Modules (chassis) with identical pulse frequencies or vector (booksize) can be 
connected to a DRIVE-CLiQ interface on the Control Unit. 
In the following diagram, three Motor Modules are connected to interface X101. 

 

 Note 
This topology does not match the topology created offline by STARTER and must be 
changed. 

 

 
Figure 1-7 Drive line-up (chassis) with identical pulse frequencies 
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Drive line-up comprising four Motor Modules (chassis) with different pulse frequencies 
Motor Modules with different pulse frequencies must be connected to different DRIVE-CLiQ 
interfaces on the Control Unit. 
In the following diagram, two Motor Modules (400 V, output ≤ 250 kW, pulse frequency 
2 kHz) are connected to interface X101 and two Motor Modules (400 V, output > 250 kW, 
pulse frequency 1.25 kHz) are connected to interface X102. 

 

 Note 
This topology does not match the topology created offline by STARTER and must be 
changed. 

 

 
Figure 1-8 Drive line-up (chassis) with different pulse frequencies 
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1.6.3 Sample wiring of Vector drives connected in parallel 

Drive line-up with two parallel-connected Line Modules and Motor Modules (chassis) of the same type 
Parallel-connected Line Modules (chassis) and Motor Modules (chassis) of the same type 
can be connected to a DRIVE-CLiQ interface of the Control Unit. 
In the following diagram, two Active Line Modules and two Motor Modules are connected to 
the X100 and X101 interface. 
For further information on parallel connection, see the chapter "Parallel connection of power 
units" in this Function Manual. 

 

 Note 
This topology does not match the topology created offline by STARTER and must be 
changed. 

 

 

 
Figure 1-9 Drive line-up with parallel-connected power units (chassis) 
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1.6.4 Sample wiring: Power Modules 

Blocksize 

 
Figure 1-10 Wiring example for Power Modules Blocksize 
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Chassis 

 
Figure 1-11 Wiring example for Power Modules Chassis 
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1.6.5 Changing the offline topology in STARTER 
The device topology can be changed in STARTER by moving the components in the 
topology tree. 

Table 1- 7 Example: changing the DRIVE-CLiQ topology 

 Topology tree view Remark 

 

Select the DRIVE-CLiQ component. 

 

Keeping the mouse button depressed, 
drag the component to the required 
DRIVE-CLiQ interface and release the 
mouse button. 

 
 
 

 

You have changed the topology in 
STARTER. 
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1.6.6 Sample wiring for servo drives 
The following diagram shows the maximum number of controllable servo drives and extra 
components. The sampling times of individual system components are: 
● Active Line Module: p0115[0] = 250 µs 
● Motor Modules: p0115[0] = 125 µs 
● Terminal Module/Terminal Board p4099 = 1 ms 

 
Figure 1-12 Sample servo topology 
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1.6.7 Wiring example for vector V/f drives 
The following diagram shows the maximum number of controllable vector V/f drives and 
extra components. The sampling times of individual system components are: 
● Active Line Module: p0115[0] = 250 µs 
● Motor Modules: p0115[0] = 125 µs 
● Terminal Module/Terminal Board p4099 = 1 ms 
● Max. 12 axes can be controlled in V/f mode 

 
Figure 1-13 Topology example for vector V/f control  

 

1.6.8 Notes on the number of controllable drives 

1.6.8.1 Introduction 
The number and type of controlled drives and the extra activated functions on a Control Unit 
can be scaled by configuring the firmware. The maximum possible functionality depends on 
the computing power of the Control Unit used and may be checked in each case using the 
SIZER projecting tool. 
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1.6.8.2 Number of controllable drives 
The following specifications provide a rough guide to the potential drive numbers for each 
Control Unit CU320-2 DP as a function of the current and speed controller clock cycles or 
the sampling times of the frequency/voltage channel with vector V/f control. 

 

 Note 
The following information is valid for power units of booksize and chassis format. 
The maximum number of drives is reduced by one in each case when blocksize power units 
are used. 

 

Servo control  
● Servo without extra function modules (e.g. setpoint channel):  

PROFIBUS DP cycle ≥1 ms 
– 6 drives (sampling times: Current controller 125 µs / speed controller 125 µs /  

TM 250 µs), of which max. 3 induction motors or 
– 3 drives (sampling times: Current controller 62.5 µs / speed controller 62.5 µs /  

TM 250 µs), also induction motors 
– 5 drives, all induction motors (sampling times: Current controller 125 µs / speed 

controller 125 µs / TM 250 µs) 
– 6/5 motor measuring systems (with 6 drives/with 5 drives) 
– 6/3 direct measuring systems (125 µs / 62.5 µs current controller cycle) 
– 1 Terminal Module TM31 or 1 Terminal Board TB30 with 1 ms sampling time 
– 1 Active Line Module with 250 µs sampling time without Voltage Sensing Module 

● Servo without extra function modules (e.g. setpoint channel):  
500 µs and ≤ PROFIBUS DP cycle < 1 ms, valid for integrated SINAMICS drives for 
SIMOTION and SINUMERIK 
– 6 drives (sampling times: Current controller 125 µs / speed controller 125 µs), of which 

max. 2 induction motors or  
3 drives (sampling times: Current controller 62.5 µs / speed controller 62.5 µs), also 
induction motors 

– Remaining modules as above 
● Servo with CBE20 function module:  

PROFINET IO bus cycle time ≥ 1 ms 
– 6 drives (sampling times: Current controller 125 µs / speed controller 125 µs), of which 

max. 2 induction motors or  
2 drive (sampling times: current controller 62.5 µs / speed controller 62.5 µs), 
induction motor also possible 

– 6 motor measuring systems 
– 3 direct measuring systems 
– 1 Terminal Module TM31 or 1 Terminal Board TB30 with 1 ms sampling time 
– 1 Active Line Module with 250 µs sampling time without Voltage Sensing Module 
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● Servo with CBE20 function module:  
500 µs ≤ PROFINET IO bus cycle time < 1 ms 
– 4 drives (sampling times: Current controller 125 µs / speed controller 125 µs), of which 

max. 2 induction motors or  
2 drive (sampling times: current controller 62.5 µs / speed controller 62.5 µs), 
induction motor also possible 

– Remaining modules as above 
● Servo with EPOS function module 

– 4 drives (sampling times: current controller 125 µs / speed controller 125 µs / position 
controller 1 ms / positioning 4 ms) 

– 6 motor measuring systems 
– 1 Active Line Module with 250 µs sampling time without Voltage Sensing Module 

Vector control (cycles for EPOS: Position controller cycle  = 1 ms / IPO cycle = 4 ms) 
● Vector without additional function modules 

– 3 drives (sampling times: Current controller 250 µs / speed controller 1000 µs /  
TM 250 µs) 

– 5 drives (sampling times: Current controller 400 µs / speed controller 1600 µs /  
TM 1600 µs) 

– 6 drives (sampling times: Current controller 500 µs / speed controller 2000 µs /  
TM 2000 µs) 

● Vector with function module basic positioner (EPOS) 
– 3 drives (sampling times: Current controller 250 µs / speed controller 1000 µs) 
– 6 drives (sampling times: Current controller 500 µs / speed controller 2000 µs) 

Vector control with V/f  
without additional function modules 
● 12 drives (sampling times: Speed controller 500 µs / TM 250 µs) 
The details for the vector drives include: 
● 1 Active Line Module with 250 µs (also applies to Chassis) 
● 1 motor encoder per drive (not with vector V/f control) 
● 1 Terminal Module TM31 or 1 Terminal Board TB30 with 1 ms sampling time 

Mixed operation 
● Mixed operation, servo 

– Mixed operation, servo 62.5 µs / servo 125 µs is permissible (current controller) 
– Mixed operation, servo 125 µs / servo 250 µs is permissible (current controller) 
– Other combinations of servo mixed operation are not permissible 

● Mixed operation, vector 
– Mixed operation, vector 250 µs / vector 500 µs is permissible (current controller) 
– Other combinations of vector mixed operation are not permissible 
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● Mixed operation vector and vector V/f control 
– 2 drives (sampling times: current controller 250 µs / speed controller 1000 µs) 
– 4 drives (sampling times: current controller 500 µs / speed controller 2000 µs) 

● Mixed operation of servo and vector V/f control 
5 drives with the following sampling times: 
– Servo: Current controller 125 µs / speed controller 125 µs 
– Vector V/f control: Speed setting 500 µs 

 

 
 

Note 
Possible restrictions 
For TM54F, TM41, TM15 and TM17 High Feature, restrictions are possible regarding 
the number of axes. 

 

1.6.8.3 Using additional functions 

Using EPOS 
Taking into account the necessary reserves, according to the standard setting in the 
following table, up to 6 axes can be installed with the supplementary EPOS function: 
 
Current controller Speed controller EPOS Axes 
125 µs 125 µs 4000 µs 4 
250 µs 250 µs 4000 µs 5 
250 µs 250 µs 8000 µs 6 

CU320-2 controller cycles under EPOS 

Using DCC 
The remaining computation times of the utilizationlevel that customers can use can be 100% 
freely allocated.  
For a quantity structure of up to 6 axes (servo or vector), DCC is permissible as long as the 
remaining computation time of the standard functions in p9976 remains available; this means 
either by eliminating some standard features (such as the setpoint channel, DSC, TMs, TB) 
or by using just a few DCC blocks or only DCC blocks in extremely slow time slices. 
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Using Safety Integrated Extended Functions 
You must carefully observe the following rules when using Safety Integrated Extended 
Functions: 
● Maximum of 6 servo axes for default cycle time settings (monitoring cycle: 12 ms; current 

controller cycle: ≥ 125 μs). 
● Of which a maximum of 4 servo axes in a DRIVE-CLiQ line. 
● Maximum of 6 vector axes with default cycle time settings (monitoring cycle: 12 ms; 

current controller cycle: ≥ 250 μs). 
● The TM54F must be directly connected to the CU using DRIVE-CLiQ. Motor Modules or 

infeed must not be connected to a TM54F. 
● A Double Motor Module, a DMC20, a TM54F and a CUA32 each correspond to two 

DRIVE-CLiQ participants. 

Additional supplementary functions 
Additional supplementary functions / options, which are not included in the basic scope, can 
mean that the number of axes must be reduced (however, this is not mandatory). 
The functions can be: 
● Additional DO encoder 
● Use of speed/torque feedforward control (splines) 
● >0: TM15 / TM17 / TM41 / > 3 TM31 
● Use of OA applications (Open Architecture) 
● Extended torque control / kT estimator 
● Use of APL (advanced position control: Oscillation damping, load mechanical system) 
● Use of DSC (Dynamic Servo Control), splines 
● More than 1 ALM 
● Use of CUA (if the first components in the Topo (due to PS-IF SD)) 
● Use of an extended brake control 
● Use of a technology controller 

1.6.8.4 Optimizing DRIVE CLiQ 

Symmetrical distribution for control cycles 62.5 µs and 32.5 µs 
For faster computation times of the main CU, the drives must be distributed across the 
DRIVE-CLiQ connections as follows: 
● PORT X100: Infeed, axes 2,4,6... 
● PORT X101: Axes 1,3,5,... 
Axes 1,2,3,4,5,6,... are intended to signify the sequence of the drive controllers. 
The advantage of this arrangement is that 2 measured values are always received in parallel 
at the CU. 
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1.7 Powering-up/powering-down the drive system 

Powering up the infeed 

 
Figure 1-14 Powering up the infeed 
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Powering up the drive 

 
Figure 1-15 Powering up the drive 

Off responses 
● OFF1 

– n_set = 0 is input immediately to brake the drive along the deceleration ramp (p1121). 
– When zero speed is detected, the motor holding brake (if parameterized) is closed 

(p1215). The pulses are suppressed when the brake application time (p1217) expires. 
Zero speed is detected if the actual speed drops below the threshold (p1226) or if the 
monitoring time (p1227) started when the speed setpoint ≤ speed threshold (p1226) 
has expired. 
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● OFF2 
– Instantaneous pulse suppression, the drive "coasts" to a standstill. 
– The motor holding brake (if parameterized) is closed immediately. 
– Switching on inhibited is activated. 

● OFF3 
– n_set=0 is input immediately to brake the drive along the OFF3 deceleration ramp 

(p1135). 
– When zero speed is detected, the motor holding brake (if parameterized) is closed. 

The pulses are suppressed when the brake application time (p1217) expires. Zero 
speed is detected if the actual speed drops below the threshold (p1226) or if the 
monitoring time (p1227) started when the speed setpoint ≤ speed threshold (p1226) 
has expired. 

– Switching on inhibited is activated. 

Control and status messages 

Table 1- 8 Power-on/power-off control 

Signal name Internal control word Binector input PROFdrive/Siemens 
telegram 1 ... 352 

0 = OFF1 STWA.00 
STWAE.00 

p0840 ON/OFF1 STW1.0 

0 = OFF2 STWA.01 
STWAE.01 

p0844 1st OFF2 
p0845 2nd OFF2 

STW1.1 

0 = OFF3 STWA.02 p0848 1st OFF3 
p0849 2nd OFF3 

STW1.2 

Enable operation STWA.03 
STWAE.03 

p0852 Enable operation STW1.3 

 

Table 1- 9 Switch-in/switch-out status signal 

Signal name Internal status word Parameter PROFdrive/Siemens 
telegram 1 ... 352 

Ready for switching on ZSWA.00  
ZSWAE.00 

r0899.0 ZSW1.0 

Ready for operation ZSWA.01  
ZSWAE.01 

r0899.1 ZSW1.1 

Operation enabled ZSWA.02  
ZSWAE.02 

r0899.2 ZSW1.2 

Pulse inhibit ZSWA.06  
ZSWAE.06 

r0899.6 ZSW1.6 

Pulses enabled ZSWA.11 r0899.11 ZSW2.10 1) 
1) only available in Interface Mode p2038 = 0 
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Function diagrams (see SINAMICS S120/S150 List Manual)  
● 2610 Sequence control - sequencer 
● 2634 Missing enable signals, line contactor control 
● 8732 Basic Infeed - sequencer 
● 8832 Smart Infeed - sequencer 
● 8932 Active Infeed - sequencer 
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Commissioning 2
2.1 Procedure when commissioning 

Once the basic requirements have been met, commissioning can proceed in the following 
steps: 

Table 2- 1 Commissioning 

Step Activity 
1 Create project with STARTER. 
2 Configure the drive unit in STARTER. 
3 Save the project in STARTER. 
4 Go online with the target device in STARTER. 
5 Load the project to the target device. 
6 The motor starts to run. 

 
 

 Note 
If motors with a DRIVE-CLiQ interface are used, all motor and encoder data should be saved 
in a non-volatile manner for spare part usage of the Sensor Module on the motor via p4692 = 
1 (for more information, see Function Manual). 

 

 

2.1.1 Safety guidelines 
 

DANGER  
A hazardous voltage will be present in all components for a further five minutes after the 
system has been shutdown.  
Note the information on the component!  

 

CAUTION  
A project with Safety Integrated can be generated offline; an acceptance test must be 
carried out when commissioning, which is only possible online. 

 

 Note 
The design guidelines and safety information in the Manuals must be carefully observed 
(refer to the documentation SINAMICS S120, Manual GH1). 
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CAUTION  
In STARTER, after the changeover of the axis type via p9302/p9502 and subsequent 
POWER ON, the units that depend on the axis type are only updated after a project upload.

 

2.2 STARTER commissioning tool 

Brief description 
The STARTER commissioning tool is used to commission drive units from the SINAMICS 
product family.  
STARTER can be used for the following: 
● Commissioning 
● Testing (via the control panel) 
● Drive optimization 
● Diagnostics 

System prerequisites 
The system requirements for STARTER can be found in the "Readme" file in the STARTER 
installation directory. 

2.2.1 Important STARTER functions 

Description 
STARTER supports the following tools for managing the project:  
● Restoring the factory settings 
● Commissioning Wizard 
● Configuring and parameterizing a drive 
● Creating and copying data sets 
● Loading from the PG/PC into the target device 
● Copy RAM to ROM 
● Loading from the target device into the PG/PC 
● Displaying toolbars 
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Restoring the factory settings 
You can use this function to set all the parameters in the working memory of the Control Unit 
to the factory settings. To ensure that the data on the memory card is also reset to the 
factory settings, choose the "Copy from RAM to ROM" function. 
This function can be activated as follows: 
● Right-click Drive unit -> Target system -> Restore factory settings 
● Drive unit grayed out -> "Restore factory settings" button 
For more information about STARTER, see Getting Started for SINAMICS S120. 

Creating and copying data sets (offline) 
Drive and command data sets (DDS and CDS) can be added in the drive's configuration 
screen. For this, the appropriate buttons must be pressed. Before data sets are copied, all 
the wiring needed for both data sets should be completed. 

Download to target device 
You can use this function to load the current STARTER project to the Control Unit. To start, 
a consistency check is made for the project; if inconsistencies are detected, then the 
associated messages are output. You must resolve these inconsistencies before loading. If 
no inconsistencies are detected, then the data is loaded into the work memory of the Control 
Unit and then a reset is initiated.  
This function can be activated as follows: 
● Right-click Drive unit -> Target system -> Load to target system 
● Drive unit grayed out -> "Load to target system" button 
● "ONLINE/OFFLINE comparison" screen -> "Load to PG/PC" button 
● Project to all drive units simultaneously: 

"Load project to target system" button, menu Project -> Load to target system 

Copy RAM to ROM 
You can use this function to save volatile Control Unit data to the non-volatile memory 
(memory card). This ensures that the data is still available after the 24 V Control Unit supply 
has been switched off. 
This function can be activated as follows: 
● Extras -> Setting -> Download -> Activate "Copy from RAM to ROM" 

This means that every time data is loaded to the target system by choosing "Load project 
to target system", the data is stored in the non-volatile memory. 

● Right-click Drive unit -> Target system -> Copy from RAM to ROM 
● Drive unit grayed out -> "Copy from RAM to ROM" button 
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Load to PG/PC 
You can use this function to load the current Control Unit project to STARTER. 
This function can be activated as follows: 
● Right-click Drive unit -> Target system -> Load to PG/PC 
● Drive unit grayed out -> "Load to PG" button 
● "ONLINE/OFFLINE comparison" screen -> "Load to PG" button 

Displaying toolbars 
The toolbars can be activated by choosing View -> Toolbars (checkmark).  
For more information about data sets, refer to the Principles chapter in the FH1 Function 
Manual. 
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2.2.2 Activating online operation: STARTER via PROFIBUS 

Description 
The following options are available for online operation via PROFIBUS:  
● Online operation via PROFIBUS 

STARTER via PROFIBUS (example with two CU320-2)  

 
Figure 2-1 STARTER via PROFIBUS 4.3 

Settings in STARTER for direct online connection via PROFIBUS 
The following settings are required in STARTER for communication via PROFIBUS: 
● Tools -> Set PG/PC Interface... 
Add/remove interfaces 
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● Extras -> Set PG/PC interface... -> Properties 
Activate/deactivate "PG/PC is the only master on the bus". 

 

 
 

Note 
• Baud rate 

– Connect STARTER to an operational PROFIBUS: 
STARTER automatically detects the baud rate used by SINAMICS for PROFIBUS.

– Switching the STARTER for commissioning:  
The Control Unit automatically detects the baud rate set in STARTER. 

• PROFIBUS addresses 
The PROFIBUS addresses for the individual drive units must be specified in the 
project and must match the address settings on the devices.  

 

 

2.2.3 Activating online operation: STARTER via Ethernet 

Description  
The Control Unit can be commissioning using PG/PC via the integrated Ethernet Interface. 
This interface is provided for commissioning purposes only and cannot be used to control the 
drive in operation. Routing in conjunction with a possibly inserted CBE20 expansion card is 
not possible.  

Preconditions 
● STARTER from version 4.1.5 or higher 
● Latest version of the PST initialization tool (Primary Setup Tool) 

The Primary Setup Tool is available on the STARTER CD or it can be downloaded free of 
charge from the Internet: 
http://support.automation.siemens.com/WW/view/en/19440762 

STARTER via Ethernet (example)  

 
Figure 2-2 STARTER via Ethernet (example) 

http://support.automation.siemens.com/WW/view/en/19440762
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Procedure for establishing online operation via Ethernet 
1. Installing the Ethernet interface in the PG/PC according to the manufacturer's 

specifications 
2. Setting the IP address in Windows XP. 

The PG/PC is assigned a free IP address here (e.g. 169.254.11.1). The factory setting of 
the internal Ethernet interface X127 of the Control Unit is 192.254.11.22. 

3. Setting the online interface in STARTER. 
4. Assigning the IP address and the name via STARTER or PST (node initialization). 

The Ethernet interface must be initialized so that the STARTER can establish 
communication. Selecting online mode in STARTER. 

Setting the IP address in Windows XP  
On your desktop, right-click "Network environment" -> Properties -> double-click on the 
network card and choose -> Properties -> Internet Protocol (TCP/IP) -> Properties -> Enter 
the IP addresses and the subnet mask. 

 
Figure 2-3 Internet Protocol (TCP/IP) properties 
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Settings in STARTER 
In STARTER, communication via Ethernet should be set as follows (the Ethernet interface 
that we use in this example has the designation Realtek RTL8139): 
Tools -> Set PG/PC Interface... 

 
Figure 2-4 Setting the PG/PC Interface 
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Right-click Drive unit -> Target device -> Online access -> Module address 

 
Figure 2-5 Setting online access 

Assigning the IP address and the name  
 

 Note 
ST (Structured Text) conventions must be satisfied for the name assignment of IO devices in 
Ethernet (SINAMICS components). The names must be unique within Ethernet.  
The characters "-" and "." are not permitted in the name of an IO device. 
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Assignment with the PST initialization tool 
You can use the PST initialization tool (Primary Setup Tool) to assign an IP address and a 
name to the Ethernet interface. 
● Connect the PG/PC and CU 320-2 using an Ethernet cable. 
● Switch on the Control Unit. 
● Start the Primary Setup Tool (on the STARTER CD). 
● Settings -> Network card -> Select the network card 
● Network -> Search (or F5) 
● Select the Ethernet device -> Module -> Assign name -> Enter the station name -> OK 
● Module -> Load 
● Network -> Search (or F5) 
● Select "Int. Ethernet interface" under the Ethernet device -> Assign IP address -> Enter 

the IP address (factory setting 169.254.11.22) -> Enter the subnet mask (255.255.0.0). 
The subnet masks must match before STARTER can be run. 

● Module -> Load 
 

 Note 
The IP address and device name for the Control Unit are stored on the memory card (non-
volatile).  

 

Assignment with STARTER, "Accessible nodes" function 
Use the STARTER to assign an IP address and a name to the Ethernet interface. 
● Connect the PG/PC and the Control Unit using an Ethernet cable. 
● Switch on the Control Unit. 
● Open STARTER. 
● Either create a new project or open an existing one 
● A search is performed for available nodes in Ethernet via Project -> Accessible nodes or 

the "Accessible nodes" button. 
● The SINAMICS drive object is detected and displayed as a bus node with IP address 

192.254.11.22 and without name. 
● Mark the bus node entry and select the displayed menu item "Edit Ethernet node" with 

the right mouse button. 
● In the following "Edit Ethernet node" screen, enter the device name for the Ethernet 

interface and click the "Assign name" button. For the IP configuration, enter the subnet 
mask (255.255.0.0). Then click the "Assign IP configuration" button and close the mask. 
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● The "Update (F5)" button displays the IP address and name in the entry for the bus node. 
If not, close the "Accessible nodes" screen and perform another search for accessible 
nodes. 

● If the Ethernet interface is displayed as bus node, mark the entry and click the "Accept" 
button. 

● The SINAMICS drive is displayed as drive object in the project tree. 
● Further configurations can be performed for the drive object. 
● Click "Connect to target system" and load the project to the Control Unit's memory card 

with Target system -> Load -> To target device. 
 

 Note 
The IP address and device name for the Control Unit are stored on the memory card (non-
volatile). 

 

Parameterizing the interface using the expert list  
Assign the "Name of Station" using parameter p8900 
Assign the "IP Address of Station" using parameter p8901 (factory setting 192.254.11.22) 
Assign the "Default Gateway of Station" using parameter p8902 (factory setting 0.0.0.0) 
Assign the "Subnet Mask of Station" using parameter p8903 (factory setting 255.255.0.0) 
Activate the configuration with p8905=1 
Activate the configuration and save with p8905=2 
 

2.2.4 Activating online operation: STARTER via PROFINET IO 

Description 
Online operation with PROFINET IO is implemented using TCP/IP. 

Preconditions 
● STARTER from version 4.1.5 or higher 
● Latest version of the initialization tool PST (Primary Setup Tool) 

The Primary Setup Tool is available on the STARTER CD or it can be downloaded free of 
charge from the Internet: 
http://support.automation.siemens.com/WW/view/en/19440762 

http://support.automation.siemens.com/WW/view/en/19440762
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STARTER via PROFINET IO (example) 

 
Figure 2-6 STARTER via PROFINET (example) 

Procedure for activating online mode with PROFINET 
1. Setting the IP address in Windows XP 

The PG/PC is assigned a fixed, free IP address here. 
2. Settings in STARTER 
3. Assigning the IP address and the name via PST (node initialization) or STARTER 

The PROFINET interface must be given a name so that the STARTER can establish 
communication. 

4. Selecting online mode in STARTER. 
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Setting the IP address in Windows XP 
On your desktop, right-click "Network environment" -> Properties -> double-click Network 
card -> Properties -> Select Internet Protocol (TCP/IP) -> Properties -> Enter the freely-
assignable addresses 

 
Figure 2-7 Internet Protocol (TCP/IP) properties 
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Settings in STARTER 
The following settings are required in STARTER for communication via PROFINET:  
● Tools -> Set PG/PC Interface... 

 
Figure 2-8 Setting the PG/PC Interface 
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● Right-click Drive unit -> Target device -> Online access -> Module address 

 
Figure 2-9 Setting online access 

Assigning the IP address and the name  
 

 Note 
ST (Structured Text) conventions must be satisfied for the name assignment of IO devices in 
PROFINET (SINAMICS components). The names must be unique within PROFINET.  
The characters "-" and "." are not permitted in the name of an IO device. 

 

Assignment with the PST initialization tool 
You can use the PST (Primary Setup Tool) to assign an IP address and a name to the 
PROFINET interface (e.g. CBE20). 
● Connect the direct Ethernet cable from the PG/PC to the PROFINET interface. 
● Switch on the Control Unit. 
● Start the Primary Setup Tool (on the STARTER CD). 
● Settings -> Network card -> Select the network card 
● Network -> Search (or F5) 
● Select the PROFINET device -> Module -> Assign name -> Enter the station name -> OK 
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● Module -> Load 
● Network -> Search (or F5) 
● Select "Ind. Ethernet interface" branch under the PROFINET device -> Assign IP address 

-> Enter the IP address (e.g. 169.254.11.22) -> Enter the subnet mask (e.g. 255.255.0.0) 
The subnet masks must match before STARTER can be run. 

● Module -> Load 
 

 
 

Note 
The IP address and device name for the Control Unit are stored on the memory card 
(non-volatile).  

 

Assignment with STARTER, "Accessible nodes" function 
Use the STARTER to assign an IP address and a name to the PROFINET interface (e.g. 
CBE20). 
● Connect the direct Ethernet cable from the PG/PC to the PROFINET interface. 
● Switch on the Control Unit. 
● Open STARTER. 
● A search is performed for available nodes in PROFINET via Project -> Accessible nodes 

or the "Accessible nodes" button. 
● The SINAMICS drive object with CBE20 is detected and displayed as a bus node with IP 

address 0.0.0.0 and without name. 
● Mark the bus node entry and select the displayed menu item "Edit Ethernet node" with 

the right mouse button. 
● In the following "Edit Ethernet node" screen, enter the device name for the PROFINET 

interface and click the "Assign name" button. Enter the IP address (e.g. 192.168.0.2) in 
the IP configuration and specify the subnet screen (e.g. 255.255.255.0). Then click the 
"Assign IP configuration" button. Close the screen. 

● The "Update (F5)" button displays the IP address and name in the entry for the bus node. 
If not, close the "Accessible nodes" screen and perform another search for accessible 
nodes. 

● If the PROFINET interface is displayed as bus node, mark the entry and click the 
"Accept" button. 

● The SINAMICS drive with CBE20 is displayed as drive object in the project tree. 
● Further configurations can be performed for the drive object. 
● Click "Connect to target system" and load the project to the Control Unit's memory card 

with Target system -> Load -> To target device. 
 

 
 

Note 
The IP address and device name for the Control Unit are stored on the memory card 
(non-volatile). 
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2.3 Basic Operator Panel 20 (BOP20) 

Product Brief 
The Basic Operator Panel 20 (BOP20) is a basic operator panel with six keys and a 2-line 
display unit with background lighting. The BOP20 can be plugged onto the SINAMICS 
Control Unit and operated.  

The following functions are possible using BOP20 
● Input and changing parameters 
● Display of operating modes, parameters and alarms 
● Display and acknowledgement of faults 
● Powering-up/powering-down while commissioning 
● Simulation of a motorized potentiometer 
You will find information on the operation in the next chapter 

2.3.1 Operation with BOP20 (Basic Operator Panel 20) 

2.3.1.1 General information about the BOP20 
The BOP20 can be used to switch on and switch off drives during the commissioning phase 
as well as display and modify parameters. Faults can be diagnosed as well as 
acknowledged.  
The BOP20 is snapped onto the Control Unit. To do this, the blanking cover must be 
removed (for additional notes on installation, see the Manual). 

Overview of displays and keys 

 
Figure 2-10 Overview of displays and keys 
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Information on the displays 

Table 2- 2 LED 

Display Meaning 
top left  
2 positions 

The active drive object of the BOP is displayed here. 
The displays and key operations always refer to this drive object. 

RUN Lit if at least one drive in the drive line-up is in the RUN state (in operation). 
RUN is also displayed via bit r0899.2 of the drive. 

top right  
2 positions 

The following is displayed in this field: 
• More than 6 digits: Characters that are still present but are invisible (e.g. "r2" ––> 2 

characters to the right are invisible, "L1" ––> 1 character to the left is invisible) 
• Faults: Selects/displays other drives with faults 
• Designation of BICO inputs (bi, ci) 
• Designation of BICO outputs (bo, co) 
• Source object of a BICO interconnection to a drive object different than the active one. 

S Is lit (bright) if at least one parameter was changed and the value was not transferred into the 
non-volatile memory. 

P Is lit (bright) if, for a parameter, the value only becomes effective after pressing the P key. 
C Is lit (bright) if at least one parameter was changed and the calculation for consistent data 

management has still not been initiated. 
Below, 6 digits Displays, e.g. parameters, indices, faults and alarms. 

Information on the keys 

Table 2- 3 Keys 

Key Name Meaning 

 
ON Powering up the drives for which the command "ON/OFF1" should come from the BOP. 

Binector output r0019.0 is set using this key. 

 
OFF Powering down the drives for which the commands "ON/OFF1", "OFF2" or "OFF3" should come 

from the BOP. 
The binector outputs r0019.0, .1 and .2 are simultaneously reset when this key is pressed. After 
the key has been released, binector outputs r0019.1 and .2 are again set to a "1" signal. 
Note: 
The effectiveness of these keys can be defined by appropriately parameterizing the BICO (e.g. 
using these keys it is possible to simultaneously control all of the existing drives). 

 
Functions The significance of these keys depends on the actual display. 

Note: 
The effectiveness of this key to acknowledge faults can be defined using the appropriate BiCo 
parameterization. 
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Key Name Meaning 

 
Parameters The significance of these keys depends on the actual display. 

If this key is pressed for 3 s, the "Copy RAM to ROM" function is executed. The "S" displayed on 
the BOP disappears. 

 
Raise 

 
Lower 

The keys depend on the current display and are used to either raise or lower values. 

BOP20 functions 

Table 2- 4 Functions 

Name Description 
Backlighting The backlighting can be set using p0007 in such a way that it switches itself off automatically 

after the set time if no actions are carried out. 
Changeover active drive From the BOP perspective the active drive is defined using p0008 or using the keys "FN" and 

"Arrow up". 
Units The units are not displayed on the BOP. 
Access level The access level for the BOP is defined using p0003. 

The higher the access level, the more parameters can be selected using the BOP. 
Parameter filter Using the parameter filter in p0004, the available parameters can be filtered corresponding to 

their particular function. 
Selecting the operating 
display 

Actual values and setpoints are displayed on the operating display. 
The operating display can be set using p0006. 

User parameter list Using the user parameter list in p0013, parameters can be selected for access. 
Unplug while voltage is 
present 

The BOP can be withdrawn and inserted under voltage. 
• The ON and OFF keys have a function. 

When withdrawing, the drives are stopped. 

Once the BOP has been inserted, the drives must be switched on again. 
• ON and OFF keys have no function 

Withdrawing and inserting has no effect on the drives. 
Actuating keys The following applies to the "P" and "FN" keys: 

• When used in a combination with another key, "P" or "FN" must be pressed first and then 
the other key. 
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Overview of important parameters (see SINAMICS S120/S150 List Manual) 

All drive objects 
● p0005 BOP operating display selection 
● p0006 BOP operating display mode 
● p0013 BOP user-defined list 
● p0971 Drive object, save parameters 

Drive object, Control Unit 
● r0002 Control Unit status display 
● p0003 BOP access level 
● p0004 BOP display filter 
● p0007 BOP background lighting 
● p0008 BOP drive object selection 
● p0009 Device commissioning, parameter filter 
● p0011 BOP password input (p0013) 
● p0012 BOP password confirmation (p0013) 
● r0019 CO/BO: Control word, BOP 
● p0977 Save all parameters 

Other drive objects (e.g. Servo, Vector, Infeed, TM41 etc.) 
● p0010 Commissioning parameter filter 

2.3.1.2 Displays and using the BOP20 

Features 
● Operating display 
● Changing the active drive object 
● Displaying/changing parameters 
● Displaying/acknowledging faults and alarms 
● Controlling the drive using the BOP20 
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Operating display 
The operating display for each drive object can be set using p0005 and p0006. Using the 
operating display, you can change into the parameter display or to another drive object. The 
following functions are possible: 
● Changing the active drive object 

– Press key "FN" and "Arrow up" -> the drive object number at the top left flashes 
– Select the required drive object using the arrow keys 
– Acknowledge using the "P" key 

● Parameter display 
– Press the "P" key. 
– The required parameters can be selected using the arrow keys. 
– Press the "FN" key -> parameter r0000 is displayed 
– Press the "P" key -> changes back to the operating display 
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Parameter display 
The parameters are selected in the BOP20 using the number. The parameter display is 
reached from the operating display by pressing the "P" key. Parameters can be searched for 
using the arrow keys. The parameter value is displayed by pressing the "P" key again. You 
can toggle between the drive objects by simultaneously pressing the keys "FN" and the 
arrow keys. You can toggle between r0000 and the parameter that was last displayed by 
pressing the "FN" key in the parameter display. 

 
Figure 2-11 Parameter display 
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Value display 
To switch from the parameter display to the value display, press the "P" key. In the value 
display, the values of the adjustable parameters can be increased and decreased using the 
arrow. The cursor can be selected using the "FN" key. 

 
Figure 2-12 Value display 
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Example: Changing a parameter 
Precondition: The appropriate access level is set  
(for this particular example, p0003 = 3). 

 
Figure 2-13 Example: Changing p0013[4] from 0 to 300 
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Example: Changing binector and connector input parameters 
For the binector input p0840[0] (OFF1) of drive object 2 binector output r0019.0 of the 
Control Unit (drive object 1) is interconnected. 

 
Figure 2-14 Example: Changing indexed binector parameters 
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2.3.1.3 Fault and alarm displays 

Displaying faults 

 
Figure 2-15 Faults 

Displaying alarms 

 
Figure 2-16 Alarms 
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2.3.1.4 Controlling the drive using the BOP20 

Description 
When commissioning the drive, it can be controlled via the BOP20. A control word is 
available on the Control Unit drive object (r0019) for this purpose, which can be 
interconnected with the appropriate binector inputs of e.g. the drive.  
The interconnections do not function if a standard PROFIdrive telegram was selected as its 
interconnection cannot be disconnected. 

Table 2- 5 BOP20 control word 

Bit (r0019) Name Example, interconnection parameters 
0 ON / OFF (OFF1) p0840 
1 No coast down/coast down (OFF2) p0844 
2 No fast stop/fast stop (OFF3) p0848 
Note: 
For simple commissioning, only bit 0 should be interconnected. When interconnecting bits 0 ... 2, 
then the system is powered-down according to the following priority: OFF2, OFF3, OFF1. 
7 Acknowledge fault (0 -> 1) p2102 
13 Motorized potentiometer, raise p1035 
14 Motorized potentiometer, lower p1036 

2.3.2 Important functions via BOP20 

Description 
Using the BOP20, the following functions can be executed via parameters that support you 
when handling projects:  
● Restoring the factory settings 
● Copy RAM to ROM 
● Identification via LED 
● Acknowledging faults 

Restoring the factory settings 
The factory setting of the complete device can be established in the drive object CU. 
● p0009 = 30 
● p0976 = 1 
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Copy RAM to ROM 
You can initiate the saving of all parameters to the non-volatile memory (memory card) in the 
drive object CU: 
● Press the P key for 3 seconds,  

or 
● p0009 = 0 
● p0977 = 1 

 

NOTICE  
 

This parameter is not accepted if an identification run (e.g. motor identification) has 
been selected on a drive.  

 

Identification via LED 
The main component of a drive object (e.g. Motor Module) can be identified using the index 
of p0124. The "Ready" LED on the component starts to flash. The index matches the index 
in p0107. The drive object type can be identified via this parameter. 
On the drive objects, the components can also be identified via the following parameters: 
● p0124 Power unit detection via LED 
● p0144 Voltage Sensing Module detection via LED 
● p0144 Sensor Module detection via LED 

Acknowledging faults 
To acknowledge all the faults that have been rectified, press the Fn key. 
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2.4 Creating a project in STARTER 

2.4.1 Creating a project offline 
To create a project offline, you need the PROFIBUS address, the device type, e.g. 
SINAMICS S120, and the device version, e.g. firmware version 4.3. 

Table 2- 6 Example of a sequence for creating a project in STARTER 
 What to do? How to do it? Comment 

• Operator action: 
– Menu "Project"--> New ... 

• User projects: 
– Projects already in the target directory 

• Name: Project_1 (can be freely selected) 
Type: Project 
Storage location (path): Default (can be set as 
required) 

1. Create a new project The project is created offline and 
loaded to the target system when 
configuration is complete. 

2. Add individual drive Operator action: 
--> Double-click "Add individual drive unit". 
Device type: SINAMICS S120 (can be selected) 
Device version: 4.3 (can be selected) 
Address type: PROFIBUS/USS/PPI (can be selected) 
Bus address: 37 (can be selected) 

Information about the bus 
address: 
The PROFIBUS address of the 
Control Unit must be set for initial 
commissioning. 
Using the rotary coding switches 
on the Control Unit, the address 
can be set to a value between 1 
and 126 and read via p0918. If 
the coding switches are at "0" 
(factory setting), the value can be 
alternatively set between 1 and 
126 using p0918.  
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 What to do? How to do it? Comment 
 

 

 
3. Configure the drive unit. Once you have created the project, you have to configure the drive unit. The following 

sections provide some examples. 
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2.4.2 Searching for a drive unit online 
To search for a drive unit online, the drive unit and the PG/PC must be connected via 
PROFIBUS/PROFINET. 

Table 2- 7 Sequence for searching for a drive unit in STARTER (example) 

 What to do? How to do it? 
Operator action: 
Menu "Project"--> New with Wizard 
Click "Find drive unit online". 

1. Create a new 
project 

 
Project name: Project_1 (can be freely selected) 
Author: Any 
Comment: Any 

1.1 Enter the project 
data. 

 
2. Set up the PG/PC Here, you can set up the PG/PC interface by clicking "Change and test". 
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 What to do? How to do it? 
interface 

 
Here, you can search for nodes that have been accessed. 3. Insert drives 
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 What to do? How to do it? 
You have now created the project. 
-> Click "Complete". 

4. Summary 

 
5. Configure the drive 

unit. 
Once you have created the project, you have to configure the drive unit. The following 
sections provide some examples. 

2.4.3 Searching for nodes that can be accessed 
To search for a drive unit online, the drive unit and the PG/PC must be connected via 
PROFIBUS or PROFINET. The interface must be set correctly in STARTER. 
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2.5 Initial commissioning using servo (booksize) as an example 
The example provided in this section explains all the configuration and parameter settings, 
as well as the tests that are required for initial commissioning. Commissioning is carried out 
using the STARTER commissioning tool. 

Requirements for commissioning 
1. The commissioning requirements have been met according to Section 1.1. 
2. The checklist for commissioning (Table 1-1 or 1-2 from Section 1.1) has been filled out 

and the points ticked off. 
3. STARTER is installed and activated. 

--> see the "Readme" file on the STARTER installation CD. 
4. The power supply (24 V DC) is switched on. 

2.5.1 Task 
1. Commission a drive system with the following components: 

Table 2- 8 Component overview 

Designation Component Order number 
Closed-loop control and infeed 
Control Unit 1 Control Unit 320-2 6SL3040-1MA00-0AA0 
Active Line Module 1 Active Line Module 16 kW 6SL3130-7TE21-6AAx 
Line filter package 16 kW Line filter and line reactor 6SL3000-0FE21-6AAx 
Drive 1 
Motor Module 1 Single Motor Module 9 A 6SL3120-1TE21-0AAx 
Sensor Module 1.1 SMC20 6SL3055-0AA00-5BAx 
Motor 1 Synchronous motor 1FK7061–7AF7x–xxxx 
Motor encoder 1 Incremental encoder sin/cos C/D 

1 Vpp 2048 p/r 
1FK7xxx–xxxxx–xAxx 

Sensor Module 1.2 SMC20 6SL3055-0AA00-5BAx 
External encoder Incremental encoder 

sin/cos 1 Vpp 4096 p/r 
- 

Drive 2 
Motor Module 2 Single Motor Module 18 A 6SL3120-1TE21-8AAx 
Motor 2 Induction motor 1PH7103–xNGxx–xLxx 
Sensor Module 2 SMC20 6SL3055-0AA00-5BAx 
Motor encoder 2 Incremental encoder sin/cos  

1 Vpp 2048 p/r 
1PH7xxx–xMxxx–xxxx 

 
1. The enable signals for the infeed and the two drives must be transmitted via PROFIBUS. 
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● Telegram for the Active Line Module 
● Telegram 370 Infeed, 1 word 
● Telegram for drive 1 
● Standard telegram 4: Speed control, 2 position encoders 
● Enable signals for drive 2 
● Standard telegram 3: Speed control, 1 position encoder 

 

 
 

Note 
For more information on the telegram types, see "Communication via PROFIBUS" or 
refer to the SINAMICS S120/S150 List Manual.  
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2.5.2 Component wiring (example) 
The following diagram shows a possible component configuration and wiring option. 
The DRIVE-CLiQ wiring is highlighted in bold. 

 
Figure 2-17 Component wiring (example) 

For more information on wiring and connecting the encoder system, see Manual. 
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2.5.3 Signal flow for commissioning example 

 
Figure 2-18 Signal flow for initial commissioning example (servo; part 1) 
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Figure 2-19 Signal flow for initial commissioning example (servo; part 2) 
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2.5.4 Commissioning with Starter (example) 
The table below describes the steps for commissioning with STARTER. 

Table 2- 9 Sequence for commissioning with STARTER (example) 

 What to do? How to do it? Comment 
1. Automatic 

configuration 
Operator action: 
-> "Project" -> "Connect to target system" 
-> Double-click "Automatic configuration". 
-> Follow the instructions provided in the wizard. 

- 

Note: 
When the factory setting is p7826 = 1, the firmware is automatically updated to the status on the memory card when a 
configured DRIVE-CLiQ component is first booted. This may take several minutes and is indicated by the READY-LED on 
the corresponding components flashing green/red and the Control Unit flashing orange (0.5 Hz). Once all updates have 
been completed, the READY-LED on the Control Unit flashes orange at 2 Hz and the corresponding READY-LED on the 
components flashes green/red at 2 Hz. For the firmware to be activated, a POWER ON must be carried out for the 
components. 
2. Configure the infeed The infeed must be configured.  

Name of infeed -> Double-click "Configuration" -> Click 
"Wizard" 

- 

2.1 Infeed wizard The wizard displays the data determined automatically from 
the electronic rating plate. 
You can now set the line/DC link identification. 
The device supply voltage must be entered; the rated line 
frequency is automatically determined by the firmware. 
"Line filter available" must be active. 
With a booksize infeed, one of up to three line filter types can 
be selected in the offered menu when this option is activated. 
With a chassis infeed, only one AIM line filter suitable for the 
infeed is automatically added with the above option. 
PROFIBUS telegram type 370 must be installed. 
Then the configuration for the infeed is completed. 

If the line environment or DC 
link components are 
changed, line/DC link 
identification should be 
repeated. 

3. Configuring drives The drives must be configured individually. 
-> "Drives" -> Drive name -> Double-click "Configuration" -> 
Click "Configure DDS" 

- 

3.1 Control structure You can activate the function modules. 
You can select the control type. 

- 

3.2 Power unit The wizard displays the data determined automatically from 
the electronic rating plate. 

- 

Caution 
If the infeed is controlled by a different Control Unit, the "Ready" signal for the infeed r0863.0 must be interconnected with 
drive parameter p0864 "Infeed ready" via a digital input/output. If this is not taken into account, the infeed may be 
damaged. 
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 What to do? How to do it? Comment 
3.3 Motor The name of the motor (e.g. equipment marking) can be 

entered. 
Select standard motor from list: Yes 
Select the motor type (see rating plate). 

You can select a standard 
motor from the motor list or 
you can enter the motor data 
manually. You can then 
select the motor type. 

3.4 Motor brakes Here, you can configure the brake and activate the "Extended 
brake control" function module. 

For more information, see 
the Function Manual. 

3.5 Motor data You can enter the motor data on the rating plate here.  
Induction motors (rotary): 
If known, mechanical data for the motor and drive train can be 
entered. 
Synchronous motors (rotary, permanent-magnet) 
If known, the data for a PE spindle can be entered. 

If you do not enter any 
mechanical data, it is 
estimated on the basis of the 
data on the rating plate. 
The equivalent circuit 
diagram data is also 
estimated on the basis of the 
data on the rating plate or 
determined by means of 
automatic motor data 
identification. 

3.6 Encoder Motor encoder (encoder 1): 
Choose standard encoder from list: Yes 
Select "2048, 1 Vpp, A/B C/D R" 
External encoder (encoder 2): 
rotary: Yes 
Measuring system: "incremental sinusoidal/cosinusoidal" 
Resolution: "4096" 
Zero mark: "No zero marker" 

If you are using an encoder 
that is not in the list, you can 
also enter the data 
manually. 

3.7 Process data 
exchange 

PROFIBUS telegram type 4 (drive 1) and 3 (drive 2) must be 
selected. 

- 

3.8 Drive functions Here, after entering the motor data the technological 
application can be selected. 

Your choice of application 
influences the calculation for 
the open-loop/closed-loop 
control parameters. 

3.9 Summary The drive data can be copied to the clipboard for plant 
documentation purposes and then added to a text program, 
for example. 

- 

Note 
The reference parameters and limit values can be protected from being automatically overwritten in the STARTER by 
p0340 = 1: Drive -> Configuration-> Reference parameters / blocked list tab. 
4. Line contactor Line contactor 

p0728.8 = 1 Set DI/DO as output 
p0738 =863.1 Line contactor ON 
p0860 = 723.9 Line contactor, feedback signal 

The line contactor must be 
controlled by the infeed_1 
drive object. 
See function diagram [8934] 
In the function --> Line 
contactor control screen, 
you can check that the 
interconnection is correct. 
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 What to do? How to do it? Comment 

 
5. Save the parameters 

on the device 
• Connect with target system (go online) 
• Target system -> Download to target device 
• Target system -> Copy from RAM to ROM 

(save the data on the memory card) 

Position cursor on drive unit 
(SINAMICS S120) and right-
click. 

6. The motor starts to 
run. 

The drives can be started via the control panel in STARTER.  
• Once the pulses for the infeed have been enabled the 

line/DC link identification will be activated and carried out. 
The infeed then switches to operational mode. 

For more information about 
the control panel, see 
Getting Started. 
The control panel supplies 
the control word 1 (STW1) 
and speed setpoint 1 
(NSOLL). 
For more information about 
line/DC link identification, 
see the SINAMICS S120 
Function Manual. 

STARTER diagnosis options 
Under "Component" -> Diagnosis -> Control/status words 
● Control/status words 
● Status parameters 
● Missing enable signals 
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2.6 Initial commissioning using vector (booksize) as an example 
The example provided in this section explains all the configuration and parameter settings as 
well as the tests that are required for initial commissioning. Commissioning is carried out 
using the STARTER commissioning tool. 

Requirements for commissioning 
1. The commissioning requirements have been met according to Section 1.1. 
2. The checklist for commissioning (Table 1-1 or 1-2 from Section 1.1) has been filled out 

and the points ticked off. 
3. STARTER is installed and ready to run. 

--> see the "Readme" file on the STARTER installation CD. 
4. The electronics power supply (24 V DC) is switched on. 

2.6.1 Task 
1. Commission a drive system with the following components: 

Table 2- 10 Component overview 

Designation Component Order number 
Closed-loop control and infeed 
Control Unit Control Unit 320-2 6SL3040-1MA00-0AA0 
Smart Line Module Smart Line Module 10 kW 6SL3130-6AE21-0AAx 
Line filter package 10 kW Line filter and line reactor 6SL3130-0GE21-0AAx 
Drive 1 
Motor Module Single Motor Module 5 A 6SL3120-1TE15-0AAx 
Motor Induction motor 1LA 
Drive 2 
Motor Module Single Motor Module 5 A 6SL3120-1TE15-0AAx 
Motor Induction motor 1LA 

 
1. The enable signals for the infeed and the drive should be realized via terminals. 
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2.6.2 Component wiring (example) 
The following diagram shows a possible component configuration and wiring option. 
The DRIVE-CLiQ wiring is highlighted in bold. 

 
Figure 2-20 Component wiring (example) 

For more information on wiring and connecting the encoder system, see Manual. 
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2.6.3 Signal flow for commissioning example 

 
Figure 2-21 Signal flow for initial commissioning example (booksize; vector) 

2.6.4 Commissioning with STARTER (example) 
The table below describes the steps for commissioning the example with STARTER. 

Table 2- 11 Sequence for commissioning with STARTER (example) 

 What to do? How to do it? Comment 
1. Automatic 

configuration 
Operator action: 
-> "Project" -> "Connect to target system" 
-> Double-click "Automatic configuration" 
-> Follow the instructions provided in the wizard. 

 

Note: 
When the factory setting is p7826 = 1, the firmware is automatically updated to the status on the memory card when a 
configured DRIVE-CLiQ component is first booted. This may take several minutes and is indicated by the READY-LED on 
the corresponding components flashing green/red and the Control Unit flashing orange (0.5 Hz). Once all updates have 
been completed, the READY-LED on the Control Unit flashes orange at 2 Hz and the corresponding READY-LED on the 
components flashes green/red at 2 Hz. For the firmware to be activated, a POWER ON must be carried out for the 
components. 
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 What to do? How to do it? Comment 
2. Configuring drives The drives must be configured individually. 

-> "Drives" -> Drive name -> Double-click "Configuration" -> 
Click "Configure DDS" 

 

2.1 Control structure You can activate the function modules. 
You can select the control type. 

 

2.2 Power unit The wizard displays the data determined automatically from the 
electronic rating plate. 

Caution 
If a sine-wave filter is 
connected, it must be 
activated here to prevent it 
from being destroyed. 

2.3 BICO power unit Infeed in operation 
Control Unit: r0722.4 (digital input 4) 

 

Caution 
If the infeed is controlled from another Control Unit, then the ready signal of the infeed must be connected to parameter 
p0864 "infeed ready" of the drive through a digital input/output. If this is not taken into account, the infeed may be 
damaged. 
2.4 Drive setting You can select the motor standard (IEC/NEMA) and power unit 

application (duty cycles). 
 

2.5 Motor The name of the motor (e.g. equipment marking) can be entered. 
Enter motor data: Yes 
Select motor type "1LAx". 

You can select a standard 
motor from the list of 
motors or you can enter the 
motor data yourself 
manually. You can then 
select the motor type. 

2.6 Motor data You can enter the motor data from the rating plate here. 
If known, mechanical data for the motor and drive train can be 
entered.  
Equivalent circuit diagram data: No 

If you do not enter any 
mechanical data, it is 
estimated on the basis of 
the data on the rating plate.
The equivalent circuit 
diagram data is also 
estimated on the basis of 
the data on the rating plate 
or determined by means of 
automatic motor data 
identification. 

2.7 Motor brake Here, you can configure the brake and activate the "Extended 
brake control" function module. 

For further information see 
Function Manual. 

2.8 Encoder The encoder must be deselected in this example. If you are using an encoder 
that is not in the list, you 
can also enter the data. 
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 What to do? How to do it? Comment 
2.9 Drive functions You can choose the application and motor identification here. 

Motor identification: "1" 
Your choice of application 
influences the calculation 
for the open-loop/closed-
loop control parameters. 
When the pulses are 
enabled, a one-off 
identification run is carried 
out. Current flows through 
the motor which means that 
it can align itself by up to a 
quarter of a revolution. 
Once the measurement is 
complete, optimization with 
rotating motor is carried out 
the next time the pulses are 
enabled. 

2.10 Important 
parameters 

You must enter important parameters in accordance with the 
relevant application. 
Note, for example, the general mechanical conditions for the 
drive train. 

 

2.11 Summary The drive data can be copied to the clipboard for system 
documentation purposes and then pasted into a word processing 
program, for example. 

 

Note 
The reference parameters and limit values in the STARTER can be protected from being automatically overwritten by 
p0340 = 1. In the STARTER, you will find this under Drive -> Configuration-> Reference parameters / blocked list tab. 
3. Enable signals and 

BICO 
interconnections 

The enable signals for the infeed and the two drives must be 
realized via the digital inputs on the Control Unit. 

 

Line contactor • Line contactor 

p0728.8 = 1 Set DI/DO as output 

p0738 = 863.1 Activate line contactor 

p0860 = 723.9 Line contactor, feedback signal 

The line contactor must be 
controlled by the 
Einspeisung_1 drive object. 
The inputs/outputs are 
located on the Control Unit. 
See the function diagram 
[8934] 

3.1 

 
3.2 Enable Motor 

Module 
• Enable signals for the Motor Module (drive_1) 

p0840 = 722.0 ON/OFF1 

p0844 = 722.1 1st OFF2 

p0845 = 1 2nd OFF2 

p0848 = 722.2 1st OFF3 

p0849 = 1 2nd OFF3 

p0852 = 722.3 Enable operation 

See function diagram 
[2501] 
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 What to do? How to do it? Comment 

 
Ramp-function 
generator 

• Ramp-function generator 

p1140 = 1 Ramp-function generator enable 

p1141 = 1 Ramp-function generator start 

p1142 = 1 Enable setpoint 

See function diagram 
[3060] 

3.3 

 

Setpoint • Specify setpoint 

p1001 = 40 Fixed setpoint 1 
See function diagram 
[3010] 

3.4 
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 What to do? How to do it? Comment 
4 Save the 

parameters on the 
device 

• Connect target system (go online) 
• Target device -> Load to target device 
• Target device -> Copy from RAM to ROM 

Position cursor on drive 
unit (SINAMICS S120) and 
right-click. 

5 The motor starts to 
run. 

The drives can be started via the control panel in STARTER. 
• Line/DC link identification will be carried out once  

the pulses for the infeed have been enabled and line/DC link 
identification has been activated. The infeed then switches to 
operational mode. 

• Once the pulses are enabled, a one-off motor data 
identification run (if activated) is carried out. 

• When the pulses are enabled again, optimization with a 
rotating motor (if activated) is carried out. 

For more information about 
the control panel, see 
Getting Started. 
During motor identification, 
a current flows through the 
motor, which means that it 
can align itself by up to a 
quarter of a revolution. 
For more information about 
line/DC link/motor 
identification, see the 
Function Manual. 

STARTER diagnosis options 
Under "Component" -> Diagnosis -> Control/status words 
● Control/status words 
● Status parameters 
● Missing enable signals 
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2.7 Initial commissioning using vector (chassis) as an example 
The example provided in this section explains all the configuration and parameter settings as 
well as the tests that are required for initial commissioning. Commissioning is carried out 
using the STARTER commissioning tool. 

Requirements for commissioning 
1. The commissioning requirements have been met according to Section 1.1. 
2. The check list for commissioning (Table 1-1 or 1-2 from Section 1.1) has been filled out 

and the points complied with. 
3. STARTER is installed and ready to run. 

--> see the "Readme" file on the STARTER installation CD. 
4. The electronics power supply (24 V DC) is switched on. 

2.7.1 Task 
1. Commission a drive system with the following components: 

Table 2- 12 Component overview 

Designation Component Order number 
Closed-loop control and infeed 
Control Unit Control Unit 320-2 6SL3040-1MA00-0AA0 
Active Line Module Active Line Module 380 kW / 400 V 6SL3330–7TE36–1AAx 
Active Interface Module Active Interface Module 6SL3300–7TE38–4AAx 
Drive 1 
Motor Module Motor Module 380 A 6SL3320–1TE33–8AAx 
Motor Induction motor 

• Without brake 
• With encoder 

Type: 1LA8 
rated voltage = 400 V 
rated current = 345 A 
rated power = 200 kW 
rated power factor = 0.86 
rated frequency = 50.00 Hz 
rated speed = 989 rpm 
cooling type = natural cooling 
HTL encoder, 1024 p/r, A/B, R 
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Designation Component Order number 
Drive 2 
Motor Module Motor Module 380 A 6SL3320–1TE33–8AAx 
Motor Induction motor 

• Without brake 
• With encoder 

Type: 1LA8 
rated voltage = 400 V 
rated current = 345 A 
rated power = 200 kW 
rated power factor = 0.86 
rated frequency = 50.00 Hz 
rated speed = 989 rpm 
cooling type = natural cooling 
HTL encoder, 1024 p/r, A/B, R 

 
1. The enable signals for the infeed and the drive should be realized via terminals. 
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2.7.2 Component wiring (example) 
The following diagram shows a possible component configuration and wiring option. 
The DRIVE-CLiQ wiring is highlighted in bold. 

 
Figure 2-22 Component wiring (example) 

For more information on wiring and connecting the encoder system, see Manual. 
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2.7.3 Signal flow for commissioning example 

 
Figure 2-23 Signal flow from initial commissioning example (chassis) 
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2.7.4 Commissioning with STARTER (example) 
The table below describes the steps for commissioning the example with STARTER. 

Table 2- 13 Sequence for commissioning with STARTER (example) 

 What to do? How to do it? Comment 
1. Automatic 

configuration 
Operator action: 
-> "Project"--> "Connect to target system" 
-> Double-click "Automatic configuration" 
-> Follow the instructions provided in the wizard. 
STARTER then automatically switches to offline 
mode. 

The DRIVE-CLiQ topology is 
determined and the electronic 
rating plates are read. The data is 
then transferred to STARTER. 
The next steps are carried out 
offline. 

Note: 
When the factory setting is p7826 = 1, the firmware is automatically updated to the status on the memory card when a 
configured DRIVE-CLiQ component is first booted. This may take a few minutes and is indicated by the READY-LED on 
the corresponding components flashing green/red and the Control Unit flashing orange (0.5 Hz). Once all updates have 
been completed, the READY-LED on the Control Unit flashes orange at 2 Hz and the corresponding READY-LED on the 
components flashes green/red at 2 Hz. For the firmware to be activated, a POWER ON must be carried out for the 
components. 
2. Configure the infeed The infeed must be configured. 

Name of infeed -> Double-click "Configuration" -> 
Click "Wizard" 

 

2.1 Infeed wizard The wizard displays the data determined 
automatically from the electronic rating plate. 
You can now set the line/DC link identification. 
The device supply voltage must be entered; the 
rated line frequency is automatically 
determined/specified for this by the firmware. 
"Line filter available" must be active. 
With a booksize infeed, one of up to three line filter 
types can be selected in the offered menu when this 
option is activated. 
With a chassis infeed, only one AIM line filter 
suitable for the infeed is automatically added with the 
above option. 
PROFIBUS telegram type 370 must be installed. 
This completes the configuration for the infeed. 

If the network environment or 
components in the DC link change, 
the line/DC link identification 
should be carried out again. 

3. Configuring drives The drives must be configured individually. 
-> "Drives" -> Drive name -> Double-click 
"Configuration" -> Click "Configure DDS" 

 

3.1 Control structure You can activate the function modules. 
You can select the control type. 
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 What to do? How to do it? Comment 
3.2 Power unit The wizard displays the data determined 

automatically from the electronic rating plate. 
Caution 
If a sine-wave filter is connected, 
then it must be activated here as 
otherwise it could be destroyed! 

Caution 
If the infeed is controlled by a different Control Unit, the "Ready" signal for the infeed r0863.0 must be interconnected with 
drive parameter p0864 "Infeed ready" via a digital input/output. If this is not taken into account, the infeed may be 
damaged. 
3.3 Drive setting You can select the motor standard (IEC/NEMA) and 

power unit application (duty cycles). 
 

3.4 Motor The name of the motor (e.g. equipment marking) can 
be entered. 
Enter motor data: Yes 
Select motor type "1LA8" 

You can select a standard motor 
from the list of motors or you can 
enter the motor data yourself. You 
can then select the motor type. 

3.5 Motor data You can enter the motor data on the rating plate 
here. 
If known, mechanical data for the motor and drive 
train can be entered. 
Equivalent circuit diagram data: No 

If you do not enter any mechanical 
data, it is estimated on the basis of 
the data on the rating plate. 
The equivalent circuit diagram data 
is also estimated on the basis of 
the data on the rating plate or 
determined by means of automatic 
motor data identification. 

3.6 Motor brake Here, you can configure the brake and activate the 
"Extended brake control" function module. 

For more information, see the 
Function Manual. 

3.7 Encoder Choose standard encoder from list: Yes 
Choose "1024 HTL A/B R to X521/X531". 

If you are using an encoder that is 
not in the list, you can also enter 
the data. 

3.8 Drive functions You can choose the application and motor 
identification here. 
Motor identification: "1" 

Your choice of application 
influences the calculation for the 
open-loop/closed-loop control 
parameters. 
When the pulses are enabled, a 
one-off identification run is carried 
out. Current flows through the 
motor which means that it can align 
itself by up to a quarter of a 
revolution. Once the measurement 
is complete, optimization with 
rotating motor is carried out the 
next time the pulses are enabled. 

3.9 Important parameters You must enter important parameters in accordance 
with the relevant application. 
Note, for example, the general mechanical 
conditions for the drive train. 
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 What to do? How to do it? Comment 
3.10 Summary The drive data can be copied to the clipboard for 

plant documentation purposes and then added to a 
text program, for example. 

 

Note 
The reference parameters and limit values in the STARTER can be protected from being automatically overwritten by 
p0340 = 1. In the STARTER, you will find this under Drive -> Configuration-> Reference parameters / blocked list tab. 
4. Enable signals and 

BICO interconnections 
The enable signals for the infeed and the two drives 
must be realized via the digital inputs on the Control 
Unit. 

Note: 
If an Active Line Module is 
installed, the same signal source 
must not be used to enable both 
the infeed and the drive. 

Active Line Module • Enable signals for the Active Line Module 

p0840 = 722.4 ON/OFF1 

p0844 = 722.5 OFF2 

p0852 = 722.6 Enable operation 

See function diagram [8920] 4.1 

 

Enable Motor Module • Enable signals for the Motor Module (drive_1) 

p0840 = 722.0 ON/OFF1 

p0844 = 722.1 1st OFF2 

p0845 = 1 2nd OFF2 

p0848 = 722.2 1st OFF3 

p0849 = 1 2nd OFF3 

p0852 = 722.3 Enable operation 

p0864 = 863.0 Infeed operation 

See function diagram [2501] 4.2 
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 What to do? How to do it? Comment 
Ramp-function 
generator 

• Ramp-function generator 

p1140 = 1 Ramp-function generator enable 

p1141 = 1 Ramp-function generator start 

p1142 = 1 Enable setpoint 

See function diagram [3060] 4.3 

 

Setpoint • Specify setpoint 

p1001 = 0 Fixed setpoint 1 

p1002 = 40 Fixed setpoint 2 

p1020 = r0722 Fixed speed setpoint selection 

r1024 = p1070 Fixed setpoint active 

A setpoint of 0 (0 signal) or 40 (1 
signal) is defaulted via digital input 
7. This setpoint is then applied to 
the main setpoint p1070. 
See function diagram [3010] 

4.4 

 
5. Load parameters to 

device 
• Connect with target system (go online) 
• Target device –> Load to target device 

Position cursor on drive unit and 
right-click. 
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 What to do? How to do it? Comment 
Motor temperature Thermistor selection: via Motor Module (11) 

Temperature sensor type: KTY84 (2) 
Response to overtemperature: alarm and fault 
(no reduction of Imax) 
Fault message for thermistor failure: ON 
Deceleration time: 0.100 s 
Alarm threshold: 120.0° C 
Fault threshold: 155.0° C 

 6. 

 
7. Save the parameters 

on the device 
Target device -> Copy from RAM to ROM Position cursor on drive unit and 

right-click. 
8. The motor starts to 

run. 
The drives can be started via the control panel in 
STARTER.  
• Line/DC link identification will be carried out once 

the pulses for the infeed have been enabled and 
line/DC link identification has been activated. The 
infeed then switches to operational mode. 

• When the pulses are enabled, a one-off motor 
data identification run (if activated) is carried out. 

• When the pulses are enabled again, optimization 
with a rotating motor (if activated) is carried out. 

For more information about the 
control panel, see Getting Started. 
During motor identification, a 
current flows through the motor, 
which means that it can align itself 
by up to a quarter of a revolution. 
For more information about line/DC 
link/motor identification, see the 
SINAMICS S120 Function Manual. 

Diagnostics parameters (see the SINAMICS S120/S150 List Manual) 
● r0002 Infeed/drive operating display 
● r0046 Missing enable signals (for more information, see "Diagnostics") 
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2.8 Commissioning for the first time using as an example Vector AC 
DRIVE with BOP20 

The example provided in this section explains all the configuration and parameter settings as 
well as the tests that are required for initial commissioning. Commissioning is performed 
using the BOP20. 

Requirements for commissioning 
1. The commissioning requirements have been met according to Section 1.1. 
2. The check list for commissioning (Table 1-1 or 1-2 from Section 1.1) has been filled out 

and the points complied with. 

2.8.1 Task 
1. A drive unit is to be commissioned (operating mode vector, closed-loop speed control), 

without DRIVE-CLiQ and without speed encoder with the following components: 

Table 2- 14 Component overview 

Designation Component Order number 
Closed-loop control 
Control Unit Control Unit 320-2 6SL3040-1MA00-0AA0 
Control Unit Adapter CUA31 6SL3040-0PA00-0AA1 
Operator Panel Basic Operator Panel BOP20 6SL3055-0AA00-4BAx 
Infeed and drive 
Power Module Power Module 340 6SL3210-1SB14-xxxx 
Motor Induction motor  

(without DRIVE-CLiQ interface) 
1LA7 

 
2. Commissioning is performed using the BOP20. 
3. The function keys on the BOP20 must be parameterized so that the ON/OFF signal and 
speed settings can be defined via these keys. 
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2.8.2 Component wiring (example) 
The following diagram shows a possible component configuration and wiring option. 

 
Figure 2-24 Component wiring (example) 

For more information on wiring, see Manual. 
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2.8.3 Quick commissioning using the BOP (example) 

Table 2- 15 Quick commissioning for a vector drive without a DRIVE-CLiQ interface 

 Procedure Description Factory 
setting 

Restore the drive to the factory setting: 
Device commissioning parameter filter * 

0 Ready 
1 Device configuration 

1. p0009 = 30 

30 Parameter reset 

1 

Reset and load all parameters 
0 Not active 

2. p0976 = 1 

1 Start restoring all parameters to their factory settings 

0 

Wait approx. 15 sec. When ready, the BOP display shows = 35 and the RDY-LED is green. P0009 is automatically set to 
1, p0976 to 0.  
Note: 
As soon as the RDY-LED is green again, the factory setting has been completed and commissioning can start. 

Device commissioning parameter filter * 
0 Ready 
1 Device configuration 

3. p0009 = 1 

30 Parameter reset 

1 

Select drive object type * 
0 No selection 
1 Drive object type SERVO 

4. p0097 = 2 

2 Drive object type VECTOR 

0 

Device commissioning parameter filter * 
0 Ready 

5. p0009 = 0 

1 Device configuration 

1 

Note: 
Wait approx. 10 sec. The basic configuration is saved once the RDY lights green. In order to transfer this state into ROM, 
press the "p" until the display flashes. When the flashing stops, the RDY changes from orange to green and the transfer 
has been completed. Alarm A07991 indicates that the motor identification function has been activated at drive DO 2.  
The drive parameters are entered: 

Select drive object (DO) = 2 ( = VECTOR) 
1 Expert list of the CU 
2 Expert list of the drive 

6. DO = 2 

To select a drive object (DO), simultaneously press the Fn key and the arrow up 
key.  
The selected drive object is displayed at the top left. 

1 

Drive, commissioning parameter filter * 
0 Ready 

7. p0010 = 1 

1 Quick commissioning 

1 
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 Procedure Description Factory 
setting 

IEC/NEMA motor standard 
0 IEC motor (SI units, e.g. kW) 

Preset: 
Rated motor frequency (p0310): 50 Hz 
Specification of the power factor cos ϕ (p0308) 

1 NEMA motor (US units, e.g. hp) 
Preset: 
Rated motor frequency (p0310): 60 Hz 
Specification of the efficiency (p0309) 

8. p0100 = 0 

Note: 
When p0100 is changed, all the rated motor parameters are reset. 

0 

Rated motor data [MDS] 
Only when p0300 < 100 (third-party motor) 
Enter the rated motor data in accordance with the rating plate, e.g. 

p0304[0] Rated motor voltage [MDS] 
p0305[0] Rated motor current [MDS] 
p0307[0] Rated motor output [MDS] 
p0308[0] Rated motor power factor [MDS] (only when p0100 = 0) 
p0309[0] Rated motor efficiency [MDS] (only when p0100 = 1) 
p0310[0] Rated motor frequency [MDS] 
p0311[0] Rated motor speed [MDS] 

9. p030X[0] = ... 

p0335[0] Motor cooling type [MDS] * 
0: Natural cooling 
1: Forced cooling 
2 Water cooling 

- 

Motor data identification and rotating measurement* 
0 Inhibited 
1 Motor data identification for rotating motor 
2 Motor data identification for a stationary motor 

10. p1900 = 2 

Message A07991 is displayed, motor identification was activated. 
Danger 
During motor identification, the drive may cause the motor to move. The EMERGENCY OFF functions must 
be fully operational during commissioning. To protect the machines and personnel, the relevant safety 
regulations must be observed. 
Operation is configured: 

2 

Drive, commissioning parameter filter * 
0 Ready 

11. p0010 = 0 

1 Quick commissioning 
RDY is lit red, fault F07085 signals that a control parameter has been changed. 

1 

12. p0840[0] = 
r0019.0(DO 1) 

BI: ON/OFF1 [CDS] 
Sets the signal source for STW1.0 (ON/OFF1) 
Interconnection with r0019.000 of the drive object Control Unit (DO 1) 
Effect: Signal ON/OFF1 from the BOP 

0 
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 Procedure Description Factory 
setting 

13. p1035[0] = 
r0019.0013 

(DO 1) 

BI: Motor potentiometer setpoint higher [CDS] 
Sets the signal source to increase the setpoint for the motorized potentiometer 
Interconnection with r0019.013 of the drive object Control Unit (DO 1) 
Effect: Signal, motorized potentiometer setpoint higher from BOP 

0 

14. p1036[0] = 
r0019.0014 

(DO 1) 

BI: Motor potentiometer setpoint lower [CDS] 
Sets the signal source to reduce the setpoint for the motorized potentiometer 
Interconnection with r0019.014 of the drive object Control Unit (DO 1) 
Effect: Signal, motorized potentiometer lower setpoint from BOP 

0 

15. p1070[0] = 
r1050 (DO 63) 

CI: Main setpoint [CDS] 
Sets the signal source for speed setpoint 1 of the speed controller. 
Interconnection with r1050.000 to the separate drive object (DO 63) 
Effect: Motorized potentiometer supplies the speed setpoint 

0 

16. "FN", then press "P". The display indicates 41, press "O", the display jumps to 31. 
17. Start the motor identification with "I". The drive switches off again after approx. 5 sec. the display goes back to 41. 
18. 31 is displayed again after pressing "O", the drive is now ready. The drive is switched on by pressing "I", the motor 

accelerates by pressing the "arrow up" key. 
19. Save all 

parameters 
Press the P key for approx. 5 sec until the display flashes. 

* These parameters offer more setting options than the ones described here. For further setting options see 
SINAMICS S120/S150 List Manual 
[CDS] Parameter depends on command data sets (CDS). Data set 0 is preset. 
[DDS] Parameter depends on drive data sets (DDS). Data set 0 is preset. 
[MDS] Parameter depends on motor data sets (MDS). Data set 0 is preset. 
BI binector input 
BO binector output 
CI connector input 
CO connector output 
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2.9 Initial commissioning using as an example servo AC DRIVE with 
BOP20 

The example provided in this section explains all the configuration and parameter settings, 
as well as the tests that are required for initial commissioning. Commissioning is performed 
using the BOP20. 

Requirements for commissioning 
1. The commissioning requirements have been met according to Section 1.1. 
2. The relevant check list for commissioning, Table 1-1, 1-2 or 1-3 from Chapter 1.2, has 

been filled out and the points complied with. 

2.9.1 Task 
1. A drive unit should be commissioned (operating mode servo, closed-loop speed control) 

with the following components: 

Table 2- 16 Component overview 

Designation Component Order number 
Closed-loop control 
Control Unit Control Unit 320-2 6SL3040-1MA00-0AA0 
Control Unit Adapter CUA31 6SL3040-0PA00-0AA1 
Operator Panel Basic Operator Panel 20 (BOP20) 6SL3055-0AA00-4BAx 
Infeed and drive 
Power Module Power Module 340 6SL3210-xxxx-xxxx 
Motor Synchronous motor with DRIVE-

CLiQ interface 
1FK7061–7AF7x–xAxx 

Motor encoder via DRIVE-CLiQ Incremental encoder sin/cos C/D 
1 Vpp 2048 p/r 

1FK7xxx–xxxxx–xAxx 

 
1. Commissioning is performed using the BOP20. 
2. The Basic Operator Panel (BOP) should be parameterized so that the ON/OFF signal 

and the speed setpoints are entered using the function keys. 
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2.9.2 Component wiring (example) 
The following diagram shows a possible component configuration and wiring option. 

 
Figure 2-25 Component wiring with integrated Sensor Module (example) 

For more information on wiring and connecting the encoder system, see Manual. 

2.9.3 Quick commissioning using the BOP (example) 

Table 2- 17 Quick commissioning of a servo drive with a DRIVE-CLiQ interface 

 Procedure Description Factory 
setting 

Note: 
Before commissioning for the first time, in the drive mode DO = 1, the drive is restored to the factory setting. 

Device commissioning parameter filter 
0 Ready 
1 Device configuration 

1. p0009 = 30 

30 Parameter reset 

1 
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 Procedure Description Factory 
setting 

Reset and load all parameters 
0 Not active 

2. p0976 = 1 

1 Start restoring all parameters to their factory settings 

0 

Note: 
As soon as the RDY-LED is green again, the factory setting has been established and commissioning can start. 

Access levels 
1 Standard 
2 Extended 

3.  p0003 = 3 

3 Expert 

1 

Device commissioning parameter filter * 
0 Ready 
1 Device configuration 

4. p0009 = 1 

30 Parameter reset 

1 

Select drive object type * 
0 No selection 
1 Drive object type SERVO 

5. p0097 = 1 

2 Drive object type VECTOR 

0 

Device commissioning parameter filter * 
0 Ready 
1 Device configuration 

6. p0009 = 0 

30 Parameter reset 

1 

Note: 
For the firmware to be activated, a POWER ON must be carried out for the components. 
The extended setpoint channel must be opened for motorized potentiometer simulation with p0108[1] = H0104 

Device commissioning parameter filter * 
0 Ready 
1 Device configuration 
2 Defining the drive type / drive options 

7. p0009 = 2 

30 Parameter reset 

1 

Drive object, function module * 
Bit 2 Closed-loop speed/torque control 

8. p0108[1] = 
H0104 

Bit 8 Extended setpoint channel 

H0000 

Device commissioning parameter filter * 
0 Ready 
1 Device configuration 

9. p0009 = 0 

30 Parameter reset 

1 

Note: 
Wait until the RDY-LED changes from orange to green. To save the setting in the ROM, press about 5 seconds on the "P" 
key until the BOP display flashes, then wait until flashing has stopped. The drive is now prepared.  
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 Procedure Description Factory 
setting 

Select drive object (DO) 2 ( = SERVO) 
1 Expert list of the CU 
2 Expert list of the servo drive 

10. DO = 2 

To select a drive object (DO), simultaneously press the Fn key and the "Arrow up" 
key. 
The selected drive object is displayed at the top left. 

1 

11. p0840[0] = 
r0019.0(DO 1) 

BI: ON/OFF1 [CDS] 
Sets the signal source for STW1.0 (ON/OFF1) 
Interconnection with r0019.0 of the drive object Control Unit (DO 1) 
Effect: Signal ON/OFF1 from the BOP 

0 

12. p1035[0] = 
r0019.0013 

(DO 1) 

BI: Motor potentiometer setpoint higher [CDS] 
Sets the signal source to increase the setpoint for the motorized potentiometer 
Interconnection with r0019.13 of the drive object Control Unit (DO 1) 
Effect: Signal, motorized potentiometer setpoint higher from BOP 

0 

13. p1036[0] = 
r0019.0014 

(DO 1) 

BI: Motor potentiometer setpoint lower [CDS] 
Sets the signal source to reduce the setpoint for the motorized potentiometer 
Interconnection with r0019.14 of the drive object Control Unit (DO 1) 
Effect: Signal, motorized potentiometer lower setpoint from BOP 

0 

14. p1037 = 6.000 Max. speed, setpoint potentiometer 0.000 
15. p1070[0] = 

r1050 (DO 63) 
CI: Main setpoint [CDS] 
Sets the signal source for speed setpoint 1 of the speed controller. 
Interconnecting to r1050 on its own drive object (DO 63) 
Effect: Motorized potentiometer supplies the speed setpoint 

1024 

BOP operating display mode* 
0 Operation -> r0021, otherwise r0020 <-> r0021 
1 Operation -> r0021, otherwise r0020 
2 Operation -> p0005, otherwise p0005 <-> r0020 
3 Operation -> r0002, otherwise r0002 <-> r0020 

16. p0006 = 0 

4 p0005 

4 

"FN", then press "P", the display in DO = 2 displays 31.  
17. Save all 

parameters 
Press the "P" key for approx. 5 sec, 41 is displayed. After pressing the "O" key, the display 
jumps to 31 - and the drive is now ready. 10 is displayed in DO = 1. 

* These parameters offer more setting options than the ones described here. For further setting options see 
SINAMICS S120/S150 List Manual 
[CDS] Parameter depends on command data sets (CDS). Data set 0 is preset. 
[DDS] Parameter depends on drive data sets (DDS). Data set 0 is preset. 
BI binector input 
BO binector output 
CI connector input 
CO connector output 
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2.10 Commissioning of power units connected in parallel 
During commissioning, power units connected in parallel are treated like a power unit on the 
line or motor side. With parallel connection, the parameter display for the actual values 
changes only slightly. Suitable "total values" are derived from the individual values of the 
power units. 
For parallel connection only  
● chassis type infeeds 
● chassis type Motor Modules in vector control mode 
may be used. 
During first commissioning of power units the parallel connection is activated using the 
wizard in STARTER. You can also select parallel connection as an option (see following 
diagrams) when choosing the power unit (infeed and/or Motor Module).  

Parallel connection of infeeds in STARTER 

 
Figure 2-26 Example of parallel connection of 3 Active Line Modules (chassis type)  
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You need to specify the number of infeeds to be connected in parallel in the appropriate field 
(maximum 8 infeeds). 
You can also choose possible Master/Slave functions for the Active Line Modules using an 
option on this screen (see chapter "Master/slave function for infeeds"). 
The line filter is offered as an option, depending on the infeed. An Active Interface Module 
(AIM) with integrated line filter is required to operate an "Active Line Module" (ALM). We 
recommend external line filters to operate the "Basic Line Module" (BLM) and "Smart Line 
Module" (SLM) infeeds. 

Parallel connection of Motor Modules in STARTER 

 
Figure 2-27 Example of parallel connection of 3 Motor Modules (chassis type, vector control)  

You need to specify the number of Motor Modules to be connected in parallel in the 
appropriate field (maximum 8 Motor Modules). 
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NOTICE  
For parallel connection, SIEMENS only enables the operation of a maximum of 8 power 
units connected in parallel (for a maximum of 4 infeeds and a maximum of 4 Motor 
Modules). The user is responsible for additional configurations.  

 

Configuration of parallel connections using parameters 
From the point of view of a higher-level PLC, the parallel connection of infeeds behaves like 
the activation of a single infeed, with the running total outputs of the individual infeeds. 
A connection via PROFIdrive telegrams permits the power units to be individually activated 
and their status queried using parameter services from a higher-level controller. Infeeds may 
also be activated using the appropriate control and status words. These are documented in 
the chapter "Communication by PROFIdrive" in /FH1/: SINAMICS S120 Drive Functions 
Function Manual. 
Power units should only be activated and deactivated if an error occurs, that is when a power 
unit fails and must be exchanged. This approach is unsuitable for variable power control, as 
the drive line-up control parameters need to be recalculated after every firmware change, for 
instance when the drive line-up is commissioned. Optimal, highly dynamic control behavior 
of the drive line-up can only be ensured by recalculation.  
The power units can be monitored and parameterized individually: 
via the individual parameters p0125..p0128, p0895, r7000, p7001ff: 
● Parameter p0125[0...n] "activate/deactivate power unit components" permits targeted 

activation or deactivation of a power unit in the topology (choice via the topology 
number). 

● With p0895[0...n] BI: power unit components, a power unit is activated or deactivated 
using an interconnected digital input (BI). 

● The number of currently active power units connected in parallel can be displayed by 
parameter r7000. 

● After an error or exchange of units, parameter p7001[0...n] (Par_circuit enable power 
units) allows targeted activation or deactivation of connected power units. 

You can still cancel alarms in this state (due to overtemperatures for example). Individual 
power units cannot be disabled for motors with separate winding systems (p7003 = 1). 
p7001 is reset automatically if a power unit is deactivated with p0125 or p0895. 
● You can use parameter r7002[0..n] to query whether the pulse in a power unit is inhibited 

or enabled. 
● Parameters r7050[0..n], r7051[0..n] and r7052[0..n] can be used to display the circuit 

currents for U, V, W on the power units. 
● Overload states and various temperature states in the power units can be displayed with 

parameters from r7200[0..n] onwards. 



Commissioning  
2.10 Commissioning of power units connected in parallel 

 Commissioning Manual 
116 Commissioning Manual, (IH1), 11/2009, 6SL3097-4AF00-0BP0 

Parallel connection is indicated with a "P" in front of the value shown on the parameter value 
display. 
You can find out more about other parameters relevant for the operation and 
parameterization of power units in the literature /LH1/: SINAMICS S120/S150 List Manual 
from parameter r7002ff or p0125 onwards. 

Parallel connection with one or two Control Units  
If an infeed is deactivated, the pre-charging must be able to charge the rest of the infeeds in 
the DC link. E.g. the pre-charging time is doubled when only one infeed is available instead 
of previously two infeeds in parallel. If possible, the infeeds should be dimensioned such that 
one infeed, or with redundant interconnection (2 CUs), one subsystem is able to pre-charge 
the whole DC link. 
The connected capacitance should not be too large. However, pre-charging double an 
infeed's rated capacitance (one of two infeeds previously out of operation) will work with no 
problems. 

Pre-charging contactor monitoring 
To monitor pre-charging contactors (for infeed failure), auxiliary terminal blocks must be 
retrospectively connected to the pre-charging contactors. 
The following diagram shows the basic concept of interconnection: 

 
Figure 2-28 Pre-charging monitoring 

 
The contactor states are monitored using the logic blocks "free blocks" in the SINAMICS 
drive. If one of the contactors does not pick up, an external fault message is generated. 
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Operating state of power units connected in parallel 
Fault messages and alarms from A05000ff or F05000ff onwards indicate errors in a power 
unit.  
Power unit faults are stored in the fault buffer in the appropriate Control Unit and can be read 
as a fault value using parameter r0949 (interpreted decimally). This fault value corresponds 
to the drive object number in the drive line-up topology. The number of the fault occurring is 
stored in parameter r0945. 
The power unit's operating state (infeed or Motor Module) is displayed via both front LEDs on 
the corresponding Communication Board Interface (CBI). 
You can identify the power unit for a particular drive using parameter p0124[0...n] "Power 
unit detection via LED". During p0124 = 1, the LED READY on the power unit concerned 
flashes green/orange or red/orange at 2 Hz. For parallel connections the parameter index is 
assigned to one power unit in each case. 

Configuration of power units connected in parallel 
Information on the hardware configuration and wiring the power units is provided in the 
Manual /GH3/ SINAMICS S120 Manual GH3 Power Units. 
You can find information on configuration in "SINAMICS Configuration Manual G130, G150, 
S120 Chassis, S120 Cabinet Modules, S150". The installation of power units within a control 
cabinet with Line Connection Modules is also described there. 
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2.11 Learn devices 

Description 
Using a software update, the "learning devices" function amends an existing STARTER 
(from version V4.1 SP2) with knowledge of later drive firmware versions. 
The update is implemented with a SINAMICS Support Package (SSP) from the current 
STARTER version 4.1 SP2. In STARTER, equipment descriptions are added to without 
changing the code or newly installing STARTER, and without the drive being physically 
available. 
A SINAMICS Support Package must be installed if SINAMICS STARTER versions need to 
be supported that are not covered by STARTER version 4.1 SP2. You can download 
SINAMICS Support Packages on the Internet from the eSupport and Product Support pages. 
The existence of new SSPs in Product Support will be announced when a new SINAMICS 
version is released for delivery. 

SSP (SINAMICS Support Package)  
An SSP contains only description files of the devices and drive objects. By installing an SSP, 
new drive objects and devices can be added to an existing STARTER installation, without 
changing its program code.  
After installation, all the functions of the new SINAMICS version can be configured with the 
expert list. All screens and wizards are also available for all the functions compatible with the 
previous version.  
SSP content: 
● New drive objects 
● New device versions 
● New and changed parameters in the expert list 
● New and changed faults, alarms and messages 
● New and changed sequence parameterizations 
● Expansions of the component catalog (new motors, encoders, DRIVE-CLiQ components) 
● Expansion of the configuration catalog (SD) 
● Changed online help files (parameter help, function diagrams) 
 
Installation 
All SSPs released for a STARTER version may be installed in any order. 
The SINAMICS Support Packages installed are displayed in SIMATIC/Product notes/Installed 
software under "Components" as "SINAMICS Support Package", and on the Info dialog. 
If a new STARTER version has been created and delivered, this STARTER contains all 
SSPs released up until the present time, or is compatible with them.  
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Compatible SSPs can also be installed on top if repairs are necessary, without functional 
changes. 
STARTER should not be running during SSP installation. The installation program should be 
started and run through. Only once the installation is finished and STARTER has been called 
up again, can you now configure the newly installed SINAMICS versions offline and operate 
them online (via "Accessible nodes" for example). 

2.12 Selection and configuration of encoders 

Encoder selection  
For SINAMICS drives there are three possibilities of selecting the encoder using STARTER: 
1. Evaluating the motor and encoder data via a DRIVE-CLiQ interface. 

The encoder is automatically identified by setting the parameter p0400 = 10000 or 10100, 
i.e. all of the motor and encoder data required for the configuration are read out of the 
encoder. For p0400 = 10100, the identification time is not limited. 

2. Select a standard encoder from a list (also possible via the motor order number for 
encoder 1/motor encoder). Every encoder type on the list has a code number (see 
SINAMICS S120/S150 List Manual), that can also be assigned using parameter p0400 
(encoder type selection). 

3. Manually entering user-defined encoder data. The user himself can configure the encoder 
using the encoder-specific STARTER screens. 

 
The encoders can also be configured on their own using parameters (parameter p0400ff). 

Table 2- 18 Assigning encoder type, encoder code and evaluation modules for standard encoders 

Encoder type Encoder code Encoder evaluation procedure  Evaluation module 
Resolver Incremental 

rotary 
1001 
1002 
1003 
1004 

Resolver 1-speed 
Resolver 2-speed 
Resolver 3-speed 
Resolver 4-speed 

SMC10, SMI10 

Encoder with 
sin/cos 1Vpp 

Incremental 
encoder 
rotary 

2001 
2002 
2003 
2005 
2010 

2048, 1 Vpp, A/B C/D R 
2048, 1 Vpp, A/B R 
256, 1 Vpp, A/B R 
512, 1 Vpp, A/B R 
18000, 1 Vpp, A/B R distance-coded 

SMC20, SMI20, 
SME20, SME120 
 
 

EnDat 
encoder 

Absolute value 
rotary 

2051 
2052 
2053 
2054 
2055 

2048, 1 Vpp, A/B, EnDat, multiturn 4096 
32, 1 Vpp, A/B, EnDat, multiturn 4096 
512, 1 Vpp, A/B, EnDat, multiturn 4096 
16, 1 Vpp, A/B, EnDat, multiturn 4096 
2048, 1 Vpp, A/B, EnDat, singleturn 

SMC20, SMI20,  
SME25 
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Encoder type Encoder code Encoder evaluation procedure  Evaluation module 
SSI encoder 
with 
sin/cos 1Vpp 

Absolute value 
rotary 

2081 
2082 
2083 
2084 

2048, 1 Vpp, A/B, SSI, singleturn 
2048, 1 Vpp, A/B, SSI, multiturn 4096 
2048, 1 Vpp, A/B, SSI, singleturn, error bit 
2048, 1 Vpp, A/B, SSI, multiturn 4096, error 
bit  

SMC20, SMI20, 
SME25, SME125 

Incremental 
linear 

2110 
2111 
2112 
2151 

4000 nm, 1 Vpp, A/B R distance-coded 
20000 nm, 1 Vpp, A/B R distance-coded 
40000 nm, 1 Vpp, A/B R distance-coded 
16000 nm, 1 Vpp, A/B, EnDat, resolution 
100 nm 

SMC20, SMI20, 
SME20 

Linear 
encoder 

Absolute value 
linear 

2151 16000 nm, 1 Vpp, A/B, EnDat,  
resolution 100 nm 

SMC20, SMI20,  
SME25 

HTL/TTL  
encoders 

Incremental 
right angle 
rotary 

3001 
3002 
3003 
3005 
3006 
3007 
3008 
3009 
3011 
3020 

1024 HTL A/B R 
1024 TTL A/B R 
2048 HTL A/B R 
1024 HTL A/B 
1024 TTL A/B 
2048 HTL A/B 
2048 TTL A/B 
1024 HTL A/B unipolar 
2048 HTL A/B unipolar 
2048 TTL A/B R, with Sense 

SMC30 

SSI encoder 
absolute 

Absolute value 
rotary 

3081 
3082 

SSI, singleturn, 24 V 
SSI, multiturn 4096, 24 V 
Not for motor control, 
only as a direct measurement system 

SMC20, SMI20, 
SME25, SME125 

SSI encoder 
absolute HTL 

Absolute value 
rotary 

3090 4096, HTL, A/B, SSI, singleturn 
 

SMC30 

DRIVE-CLiQ  
encoder 
 

Absolute rotary 
value  

202 
242 
204 
244 

Abs., singleturn 20 bit 
abs., singleturn 24 Bit 
abs., multiturn 12 bit, singleturn 20 bit) 
abs., multiturn 12 bit, singleturn 24 bit) 

- 

SIMAG H2 Incremental 
encoder 
rotary 

2002 
2003 
2004 
2005 
2006 
2007 
2008 

2048, 1 Vpp, A/B R 
256, 1 Vpp, A/B R 
400, 1 Vpp, A/B R 
512, 1 Vpp, A/B R 
192, 1 Vpp, A/B R 
480, 1 Vpp, A/B R 
800, 1 Vpp, A/B R 

SMC20, SMI20, 
SME20 
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Encoder configuration  
You can configure the encoders using a screen in STARTER. 
1. If you mark the appropriate checkbox option, encoders with a DRIVE-CLiQ interface are 

automatically identified on the encoder configuration screen. 

 
Figure 2-29 Identifying DRIVE-CLiQ encoders 
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2. You can select standard encoders from a list. The encoder 1/motor encoder can also be 
selected and configured at the same time using the motor order number. 

 
Figure 2-30 Standard encoder option 

When configuring the drive you can select the standard encoders offered by Siemens from a 
list under "encoder". When the encoder type is chosen, all necessary parameterizations are 
simultaneously and automatically transferred into the encoder configuration. The standard 
encoder type and the corresponding evaluation modules are shown in the above table. 
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1. The user can also configure the connected encoders specifically, using the STARTER 
screens. 

 
Figure 2-31 User-defined encoder option  

For this select the option "Enter data" and press the "Encoder data" button. 



Commissioning  
2.12 Selection and configuration of encoders 

 Commissioning Manual 
124 Commissioning Manual, (IH1), 11/2009, 6SL3097-4AF00-0BP0 

The following screen appears: 

 
Figure 2-32 Rotary encoder types  

You can choose between "rotary" and "linear" encoders on this screen. 
For rotary encoders, the following encoder types can be configured: 
● Resolver 
● Incremental encoder with sin/cos signal 
● Absolute encoder with EnDat protocol 
● Incremental encoder with HTL/TTL signal 
● Absolute encoder with SSI protocol 
● Absolute encoder with SSI protocol and HTL/TTL signal 
● Absolute encoder with SSI protocol and sin/cos signal 
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The linear encoder screen offers the following encoder types: 

 
Figure 2-33 Linear encoder types  

For linear encoders, you can configure the following encoder types: 
● Absolute encoder with EnDat protocol 
● Incremental encoder with sin/cos signal 
● Incremental encoder with HTL/TTL signal 
● Absolute encoder with SSI protocol 
● Absolute encoder with SSI protocol and HTL/TTL signal 
● Absolute encoder with SSI protocol and sin/cos signal 
 
The encoder-specific screens for both rotary and linear encoder types are self-explanatory 
and so will not be presented in more detail here. 
The following describes the commissioning and exchange of an encoder, using the DRIVE-
CLiQ encoder as an example. 
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Encoders with a DRIVE-CLiQ interface  
Encoder evaluation units with DRIVE-CLiQ interface are available in different versions, e.g. 
● as Sensor Module Cabinet-Mounted (SMCx) for rail mounting, 
● as Sensor Module External (SMEx) to be incorporated the feeder cable, 
● as Sensor Module Integrated (SMI), mounted on the motor, or 
● as DRIVE-CLiQ Module Integrated (DQI), integrated in the motor. 
A temperature sensor at the DRIVE-CLiQ encoder to detect the motor temperature is 
connected in the factory. 
Support with STARTER version 
STARTER V4.1.5 supports an encoder with DRIVE-CLiQ interface. Further order numbers 
(MLFBs) are available for the corresponding DRIVE-CLiQ motors in the encoder overview. 
The motor order number is used for SMI or DQI motor. 
When configuring a motor with DRIVE-CLiQ interface, a distinction is not made between SMI 
motors and DQI motors. 

 

 Note 
Restrictions for SMI/DQI motors 
The DRIVE-CLiQ encoder integrated in the motors is only available as absolute encoder. 

 

Exchanging a motor with encoder and DRIVE-CLiQ interface for a motor with SMI or DQI 
module is only possible by changing the parameter assignments or making the appropriate 
operator actions. The same behavior from a functional perspective is no longer given, if the 
encoder 
● is different in its measuring principle and resolution. 
● is used in an application where the evaluation requires a zero mark (for example for 

referencing purposes). The encoder with DRIVE-CLiQ interface itself does not deliver a 
separate zero mark, as an absolute encoder is definitely involved. So in these 
applications (and/or in the superimposed controls) the changed behavior must be 
selected. 

● should be used on an axis with SINAMICS Safety Integrated Extended Functions or 
SINUMERIK Safety Integrated. This is because a lower resolution of the redundant 
position value (POS2) results in lower positional accuracy (SOS Safe Operating Stop) 
and a lower maximum speed (SLS Safely Limited Speed). check again 

A new commissioning test and, if necessary, new configuration must be carried out for 
activated SINAMICS Safety Integrated Extended Functions or SINUMERIK Safety 
Integrated. 
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Commissioning encoders with a DRIVE-CLiQ interface 
For DRIVE-CLiQ encoders, the properties of a rotary-type absolute encoder are identified 
with the following CU parameters: 
● p0404[0..n] Encoder configuration active 
● p0408[0..n] Rotary encoder pulse number 
● p0421[0..n] Absolute encoder rotary multiturn resolution 
● p0423[0..n] Absolute encoder rotary singleturn resolution 
This data is pre-assigned according to the preset codes in p0400 (encoder type selection) 
from the encoder lists. Parameters p0404, p0408, p0421 and p0423 are checked by the CU 
during booting. 
Alternatively the data can be read out from the encoder with the setting p0400 = 10000 or 
p0400 = 10100 (identify encoder). If the encoder data read out matches a known encoder 
type, this code is entered in p0400 using the CU software. Otherwise the general code 
p0400 = 10050 (encoder with EnDat interface identified) will be entered. 
A DRIVE-CLiQ encoder is identified by the parameter p0404.10 = 1. 
For DRIVE-CLiQ encoders, encoder codes are defined respectively for parameter p0400 
(see SINAMICS S120/S150 List Manual and above table).  
If the CU software identifies a DRIVE-CLiQ encoder type for which no code is stored, during 
identification it enters the code p0400 = 10051 (DRIVE-CLiQ encoder identified). 
The data is also automatically identified if a DRIVE-CLiQ encoder is found during automatic 
commissioning. During identification, the CU reads out the values for p0404, p0421 and 
p0423 from the DRIVE-CLiQ encoder. The CU uses this data to find out the contents of 
p0400. The newly defined codes are not stored in the DRIVE-CLiQ encoder. 
Exchange of the DRIVE-CLiQ encoder 
There is already a spare parts concept for existing SMI motors. The motor and encoder data 
stored in SMI-EPROM are backed up on the memory card, and if the SMI should fail at the 
end customer the data can be imported into an "empty" SMI spare part (see literature /FH1/: 
SINAMICS S120 Function Manual Drive Functions). 
This spare parts concept is also applicable for the DRIVE-CLiQ Module Integrated (DQI). 
Contrary to the SMI encoder, only the motor data is backed up and imported again if spare 
parts are required. It is not necessary (or possible) to transfer the encoder data. 
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2.13 Commissioning linear motors (servo) 

2.13.1 General information on commissioning linear motors 
Before commissioning motors, the following questions must be answered: 
● Have all of the prerequisites for commissioning been met and were the points on the 

commissioning checklist checked, see Chapter "Checklists to commission SINAMICS S? 
Detailed information on linear motors, encoders and power connection, configuring and 
mounting are provided in: 
Configuration Manual for Linear Motors 1FN3 or 1FN6 

Terminology for rotary and linear drives 

Table 2- 19 Terminology 

Terminology for rotary drives Terminology for linear drives 
Speed Velocity 
Torque Force 
Stator Primary section 
Rotor Secondary section 
Rotor Secondary section 
Direction of rotation Direction 
Pulse number Grid spacing 
Rotate Run 

Checks in the no-current state 
The following checks can be made: 
1. Linear motor 
● What linear motor is used? 

1FN _ _ _ _ – _ _ _ _ _ – _ _ _ _ 
● Is the motor already mounted and ready to be powered up? 
● If a cooling circuit is being used, is it functional? 
1. Mechanical system 
● Is the axis easy to move over the complete traversing range? 
● Does the air gap between the primary and secondary section and the mounting 

dimensions correspond to the motor manufacturer's data? 
● Hanging (suspended) axis: 

If weight equalizing is used for the axis is this functioning? 
● Brake: 

If a brake is being used, is it correctly controlled (see the SINAMICS S120 Function 
Manual)? 
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● Traversing range limiting: 
Are the mechanical end stops available and tightly bolted to both ends of the traversing 
path? 

● Are the moving feeder cables correctly routed in a cable drag assembly? 
1. Measuring system 
● Which measuring system is being used? 

 
_ _ _ _ _ _ _ _ _ _ _ _ 
 
Absolute or incremental? abs incr  
 
Grid spacing _ _ _ _ _ _ _ _ _ _ µm 
 
Zero marks (number and position) _ _ _ _ _ _ _ _ _ _ _ _ 

● Where is the positive drive direction? 
Where is the positive counting direction of the measuring system?  
 
Invert (p0410)? yes / no 

1. Wiring 
● Power unit (connect UVW, phase sequence, clockwise rotating field) 
● Protective conductor connected? 
● Shield connected? 
● Temperature monitoring circuits: 

Are the cables connected to the terminal block of the shield connecting plate? 
– Temperature sensor (Temp-F): 

The temperature sensor (Temp-F) can be used to carry out an absolute measurement 
of the mean winding temperature. 

– Overtemperature switch (Temp-S): 
The overtemperature trip circuit (Temp-S) enables each individual motor phase 
winding to be digitally monitored for an overtemperature condition. 

 

DANGER  
 

The circuits of Temp-F and Temp-S neither have "protective separation" between 
each other nor to the power circuits in accordance with IEC 61800-5-1.  
For this reason, SELV/PELV circuits must not be used and no connection to a 
SELV/PELV circuit must be established either.  
See also the Configuration Manual for Linear Motors 1FN3 or 1FN6. 

 

– Temperature sensor evaluation 
● Alternatively, temperature monitoring with SME12x, (description in chapter "thermal motor 

protection") 
● Encoder system connection  

Is the encoder system connected correctly to SINAMICS? 
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2.13.2 Commissioning: Linear motor with one primary section 

Commissioning with STARTER 
 

DANGER  
Linear drives can achieve significantly higher rates of acceleration and velocities than 
conventional drives.  
The traversing range must always be kept clear in order to avoid any potential danger for 
man or machine.  

 

Commissioning the motor with STARTER 
1. Selecting the motor type 

You can select a standard motor from the list of motors. You can enter the motor data for 
third-party motors manually. The number of parallel primary sections (p0306) must be 
entered. 

 
Figure 2-34 STARTER screen, linear motor selection 1FN3 
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2. Enter motor data 
The following motor data must be entered for third-party motors: 

Table 2- 20 Motor data 

Parameter Description Comment 
p0305 Rated motor current - 
p0311 Motor rated velocity - 
p0315 Motor pole pair width - 
p0316 Motor force constant - 
p0322 Motor velocity, maximum - 
p0323 Maximum motor current - 
p0338 Motor limit current - 
p0341 Motor weight - 
p0350 Motor stator resistance, cold - 
p0356 Motor stator leakage inductance - 

 

Table 2- 21 Optionally, further motor data (linear synchronous motor) can be entered for third-party 
motors: 

Parameter Description Comment 
p0312 Rated motor force - 
p0317 Motor voltage constant - 
p0318 Motor stall current - 
p0319 Motor stall force - 
p0320 Rated motor magnetizing current - 
p0326 Stall torque correction factor - 
p0329 Pole position identification current - 
p0348 Speed at start of field weakening - 
p0353 Motor series inductance - 
p0391 Current controller adaptation, lower application 

point 
- 

p0392 Current controller adaptation, upper application 
point 

- 

p0393 Current controller adaptation, P gain, scaling upper  

1. User-defined encoder data 
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With linear motors, the encoder is configured in the "User-defined encoder data" screen. 

 
Figure 2-35 Encoder data screen in STARTER 

 

WARNING  
When linear motors are configured for the first time, the commutation angle offset (p0431) 
must be adjusted. For more information about the commutation angle offset and pole 
position identification (servo), see the Function Manual S120, servo control chapter. 
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2.13.3 Commissioning: Linear motor with several identical primary sections 

General information 
If you are sure that the EMF of more than one motor has the same relative phase position to 
another, the connecting cables can be connected in parallel and operated from one drive. 
Linear motors, which are connected in parallel, are commissioned, based on the 
commissioning of a single linear motor. The number of parallel-connected primary sections is 
entered in the "Motor" screen (p0306) when the drive is configured in STARTER. 
The linear motors are connected individually in sequence to the drive, and are commissioned 
as a single motor (1FNx ...). The angular commutation offset is automatically determined and 
noted for each motor. Finally, the measured angular commutation offset of the motors are 
compared with each other. 
If the difference between the angular commutation offset is less than 10 degrees (electrical), 
all the motors can be connected to the drive in parallel and commissioned as a parallel 
configuration of n linear motors (e.g. 2 • 1FN3xxx). 

 

 Note 
Only identical linear motors (the same forces, winding types, secondary section types and air 
gap) may be connected in parallel. (The order number of the primary sections to be 
connected in parallel must be identical, including the winding direction and/or primary section 
length.)  
If linear motors in an axis are connected in parallel, the position of the primary sections with 
respect to one another and to the secondary sections must exhibit a specific grid, in order to 
achieve a matching electrical phase position.  
For more information see: /PJLM/ Configuration Manual for Linear Motors 1FN3 or 1FN6 

 

Temperature sensor and electrical wiring 
The temperature sensors can be evaluated, for example, as follows: 
● Temperature sensor 

– Motor 1: Evaluated via the drive 
– Motor n: not connected  

(short-circuited and connected to the PE) 
● Temperature switch 

– Motor 1 to n: Evaluation via a PLC 
See also: /PJLM/ Configuration Manual for Linear Motors 1FN3 or 1FN6 

 

WARNING  
When connecting up the temperature monitoring circuits, carefully observe the 
specifications relating to protective separation according to DIN EN 50178.  
See also: /PJLM/ Configuration Manual for Linear Motors 1FN3 or 1FN6 
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2.13.4 Thermal motor protection 

Description 
Two independent monitoring circuits are available for the 1FN3, 1FN6 primary sections for 
thermal motor protection. Temperature measurements for thermal motor protection can also 
be carried out using sensor modules from the SME12x series. 
The absolute average winding temperature can be measured using the temperature sensor 
(Temp-F) comprising a temperature sensor (KTY 84). 
The overtemperature shutdown circuit (Temp-S) allows each individual motor phase winding 
to be digitally monitored for an overtemperature condition. 
The two independent temperature circuits Temp-F and Temp-S can be used for motor 
protection, either separately or together. At least one Temp_S must be used for the motor 
overtemperature protection. 
The circuit and connection system for Temp-F and Temp-S are described in detail in the 
Configuration Manual; linear motors 1FN3 or 1FN6. 
The SME12x (Sensor Module External) is a device with connectors enabling the connection 
of various sensors of a direct drive (WMS, Hall sensors, temperature sensors). The output of 
the SME12x is connected to SINAMICS drive systems via DRIVE-CLiQ. The requirements 
regarding protective separation in accordance with EN 61800-5-1 are fulfilled by the 
electrical isolation between the voltage circuits for power and sensors. The SME 12x 
therefore fulfills the following functions: 
● All signal lines can be connected close to the motor. 
● Temperature sensors can be fully evaluated: 

– Thermal motor protection through evaluation of Temp-S 
– Display of the temperature curve via evaluation of Temp-F 

● The drive system evaluates the temperature. 
There are two variants of SME12x: 
● SME120 for incremental position measurement systems 
● SME125 for absolute position measurement systems 
You will find further information on the SME12x in the SINAMICS S120 Manual, Control 
Units and Additional System Components, in the chapter Encoder System Connection. 

 

DANGER  
The circuits of Temp-F and Temp-S neither have "protective separation" between each 
other nor to the power circuits in accordance with VDE 0160/EN 50178.  

 



 Commissioning 
 2.13 Commissioning linear motors (servo) 

Commissioning Manual 
Commissioning Manual, (IH1), 11/2009, 6SL3097-4AF00-0BP0 135 

DANGER  
Temp-S must be connected for thermal motor protection; it is not permissible not to connect 
Temp-S!  
Temp-F can be optionally connected to a measuring device for commissioning and testing. 
For regular operation, the Temp-F connections should be short-circuited and connected to 
PE.  

 

 Note 
The temperature sensor (Temp-F) only evaluates the winding temperature of one phase in 
the primary section. The phases in the synchronous motor are, however, loaded to different 
degrees with the result that, in the worst case, the phases that are not measured have higher 
temperatures.  

 

 Note 
If protection by electrical separation is provided, Temp-F must not be connected to a Sensor 
Module in the SINAMICS drive system without the use of a suitable protection module.  
When handling and connecting Temp-F, it must be assumed that when the drive is powered 
up, there are hazardous voltages at the terminals on the motor side and at the Temp-F 
connecting cable. This means that the drive must always be disconnected to ensure that it 
really is in a no-voltage condition.  

 

 Note 
If protection by electrical separation is provided, Temp-S must not be connected to the PLC 
or Sensor Module in the SINAMICS drive system without the use of a thermistor motor 
protection (3RN1013-1BW10) or a suitable protection module.  
When handling and connecting Temp-F, it must be assumed, that when the drive is powered 
up, there are hazardous voltages at the terminals on the motor side and at the Temp-F 
connecting cable. This means that the drive must always be disconnected to ensure that it 
really is in a no-voltage condition.  

 

Evaluating the temperature sensors 
See also: Configuration Manual for Linear Motors 1FN3 or 1FN6. 
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2.13.5 Measuring system 

Determining the control sense 
The control sense of an axis is correct if the positive direction of the drive (= clockwise 
rotating field U, V, W) coincides with the positive counting direction of the measuring system. 

 

 Note 
The data to determine the drive direction is only valid for Siemens motors (1FNx motors).  
If the positive direction of the drive and positive counting direction of the measuring system 
do not match, the actual speed value (P0410.0) must be inverted when the drive is 
commissioned.  
The control sense can also be checked by first parameterizing the drive, and then manually 
moving it, with the enable signals inhibited (switched out).  
If the axis is moved in the positive direction, the actual speed value must also count in the 
positive direction.  

 

Determining the drive direction 
The direction of the drive is positive if the primary section moves relative to the secondary 
section in the opposite direction to the cable outlet direction. 

 
Figure 2-36 Determining the positive direction of the drive 

Determining the counting direction of the measuring system 
The counting direction is determined depending on the measuring system. 
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Measuring systems from Heidenhain 
 

 Note 
The counting direction of the measuring system is positive, if the distance between the 
sensor head and rating plate increases. 

 

+

 
Figure 2-37 Determining the counting direction for measuring systems from the Heidenhain Company 

Measuring systems from Renishaw (e.g. RGH22B) 
As the reference mark for the Renishaw RGH22B has a direction-dependent position, with 
control cables BID and DIR, the encoder must be parameterized, so that the reference mark 
is only output in one direction. 
The direction (positive/negative) depends on the geometrical arrangement at the machine 
and the reference point approach direction. 

Table 2- 22 Overview of signals 

Connected to Signal Cable color Circular connector
12-pin +5 V 0 V 

BID Black Pin 9 Reference marks in 
both directions 

Reference marks in 
one direction 

DIR Orange Pin 7 Positive directions Negative direction 
+5 V Brown Pin 12 
0 V White Pin 10 

 

The counting direction of the measuring system is positive if the sensor head moves relative 
to the gold band in the cable outlet direction. 

 
Figure 2-38 Determining the counting direction for measuring systems from Renishaw 

 

 Note 
If the sensor head is mechanically connected to the primary section, the cable outlet 
direction must be different. Otherwise, invert the actual value.  
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2.13.6 Checking the linear motor by taking measurements 

Why make measurements?  
If the linear motor was commissioned according to the relevant instructions, and unexplained 
fault messages still occur, then all of the signals must be checked using an oscilloscope. 

Checking the phase sequence U-V-W 
For primary sections connected in parallel, the EMF_U from motor 1 must be in phase with 
the EMF_U from motor 2. The same is true for EMF_V and EMF_W.  
It is absolutely necessary that this is checked by making the appropriate measurements. 

Taking the necessary measurements 
● Disconnect the drive line-up from the power supply. 
● Notice: Wait until the DC link has been discharged! 
● Disconnect the power cables from the drive. 

Disconnect any primary components connected in parallel. 
● Form an artificial neutral point using 1 kOhm resistors. 

 
Figure 2-39 Configuration for taking the measurements 

For a positive traversing direction, the phase sequence must be U-V-W. The direction of the 
drive is positive if the primary section moves relative to the secondary section in the opposite 
direction to the cable outlet direction. 
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Figure 2-40 The positive direction of the drive (clockwise rotating field) 

Determining the commutation angle using an oscilloscope 
Once the oscilloscope has been connected, the drive must first pass the zero mark so that 
fine synchronization can be carried out. 
The angular, commutation offset can be determined by measuring the EMF and normalized 
electrical pole position via an analog output. 

 
Figure 2-41 Oscillogram 

Definition of channels (Ch1 ... Ch4): 
● Ch1 EMF phase U to neutral point 
● Ch2: EMF phase V to neutral point 
● Ch3: EMF phase W to neutral point 
● Ch4: Normalized electrical angular pole position via analog output 
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Figure 2-42 Setting of the measuring socket T0 on CU320 

When the drive is synchronized, the difference between the EMF/phase U and the electrical 
rotor position is a maximum of 10°. 
If the difference is greater, the commutation angle offset must be adjusted. 

2.14 Notes on commissioning SSI encoders 

Using error bits 
The number and position of error bits may vary for SSI encoders. In the event of faults, error 
codes may even sometimes be transferred within the position information.  
It is therefore essential that you assess all the error bits present (see below for 
parameterization and limitations) as otherwise an error code may be interpreted as position 
information if faults are present. 

Hardware requirements 
● SMC20 Sensor Module Cabinet-Mounted 
● SME25 Sensor Module External 
● SMC30 Sensor Module Cabinet-Mounted 
● CU320-2 Control Unit 
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Types of encoder that can be connected  

Table 2- 23 Overview of encoder types that can be connected depending on the SIEMENS evaluation module  

Encoder 
evaluation 
through module 

Incremental tracks Absolute position Power supply for 
encoder 

SSI baud rate Remarks 

SMC20 sin/cos, 1 Vpp SSI not cyclic 1) 5 V 100 kHz - 
SME25 sin/cos, 1 Vpp SSI not cyclic 1) 5 V 100 kHz SME25 is only 

suited to direct 
measuring 
systems 

SMC30 Square or  
no incremental 
tracks 

SSI not cyclic 1), 3) 
SSI, cyclic 2) 

5 V or 24 V 100-250 kHz - 

1) "not cyclic" means that the absolute position is only read when initializing the Sensor Module, after which the position is 
only calculated by the incremental tracks. 
2) "cyclic" means that the absolute position is read permanently (usually in the PROFIBUS or position controller cycle) and 
the position (X_IST1) formed from this. 
3) the SSI protocol is cyclically read-out for the plausibility checks 

 
 

 Note 
Only encoders that support a transfer rate of 100 kHz and that have a high level in idle state 
may be used. 
The monoflop time should be parameterized such that it is greater than or equal to the 
specified monoflop time of the encoder. This must lie in the range between 15 – 30 µs. 
The level during the monoflop time must be low. 

 

Ramp-up time of the encoder 
In order to ensure that correct sensor data is received, the encoder evaluation module 
checks, after its own ramp-up, whether the connected encoder has also ramped up.  
To do this, the SINAMICS converter system proceeds as follows: 
● After the power supply is switched on at the encoder, no signals are evaluated for a 

waiting period of 800 ms. 
● After the waiting period has expired, clock signals are applied to the clock cable and the 

response of the data line observed. As long as the encoder has not ramped up, the 
encoder holds the data line permanently in the idle state (as a rule "high"). 
It is expected that the encoder has completed its own ramp-up by this time. 

● If the encoder has not ramped up after approx. 10 seconds, the encoder evaluation 
module signals a timeout error. 
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The waiting period starts again when: 
● The 5 V power supply is applied to the encoder. 
● Switchover to 24 V power supply after completed ramp-up of the encoder evaluation in 

accordance with the parameterized voltage level. 
 

 Note 
There is a serial ramp-up (evaluation -> encoder) with the corresponding ramp-up times after 
every disconnection and connection of the encoder. 

 

 
 

 Note 
An external supply of the encoder with 24 V is permitted. 

 

Parameterization 
Predefined encoders 
Several predefined SSI encoders are available for commissioning. These can be selected 
from the STARTER's commissioning screens. 
User-defined encoders 
If there are no predefined entries for the encoder used, user-defined encoder data can be 
entered on screens using the commissioning wizard. 

Special settings 
● Error bits (special case, several error bits) 

If an SSI encoder has several error bits, the evaluation is activated in the list of experts as 
follows using parameter p0434[x]: 
Value = dcba 
ba: Position of error bit in protocol (0 ... 63) 
c: Level (0: Low level 1: High level) 
d: Status of evaluation (0: Off, 1: On with 1 error bit, 2: On with 2 error bits ... 9: On with 
9 error bits) 
The following applies in the event of several error bits: 
- The position specified under ba and the other bits are assigned in ascending order. 
- The level set under c applies to all error bits. 
Example: 
p0434 = 1013 
--> The evaluation is activated and the error bit is in position 13 and a low level. 
p0434 = 1113 
--> The evaluation is activated and the error bit is in position 13 and high level. 
p0434 = 2124 
--> The evaluation is activated and the 2 error bits are as of position 24 and high level 
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● Fine resolution p0418 and p0419 
In order to make full use of the entire traversing range of the absolute encoder, the 
position information, including fine resolution, must not exceed 32 bits. 
Example: 
An SSI encoder without incremental tracks is used. The encoder has a singleturn 
resolution of 16 bits and a multiturn resolution of 14 bits. The absolute position's 
resolution is therefore 30 bits.  
Consequently, only a fine resolution of two bits can be set. Parameters p0418[x] and 
p0419[x] in the list of experts should therefore be set to the value 2. 

Diagnostics 
Example 1 
An SSI encoder without incremental tracks is used. The encoder has a singleturn resolution of 
16 bits and a multiturn resolution of 14 bits. The fine resolution p0418[x] and p0419[x] is set to 
the value 2. In parameter r0482[x] (X_IST1), the product is formed from "pulses per revolution" 
and fine resolution p0418[x]. If using SSI encoders without incremental tracks, the number of 
pulses and singleturn resolution are identical. In our example, the actual position value X_IST1 
(r0482[x]) must therefore have changed after an encoder resolution by the value  
singleturn resolution * fine resolution = 2^16 * 2^2 = 262144. 
Example 2 
An SSI encoder with incremental tracks is used. In this case, incorrect SSI protocol settings 
can be seen, e.g. by the fact that once the system has been switched on a different absolute 
position is indicated from that before it was last deactivated. 
The absolute position X_IST2 (r0483[x]) must be considered by way of a check. Following 
PROFIdrive, however, just one value is displayed in this parameter if bit 13 (request absolute 
value in cycles) is set to the value 1 in the encoder control word p0480[x]. 
This bit can be set, e.g. with the aid of the binector-connector converter. 
Once switched on, the SSI encoder is now turned a few revolutions. Once switched off and 
on again, the absolute position of X_IST2 (r0483[x]) must indicate an unchanged value. Only 
minor deviations may occur in the fine resolution area. 
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2.15 Notes on the commissioning of a 2-pole resolver as absolute 
encoder 

Description  
You can use 2-pole (1 pole pair) resolvers as singleturn absolute encoders. The absolute 
encoder position actual value is provided in Gn_XIST2 (r0483[x]).  
Actual position value format 
The factory setting for the fine resolution of Gn_XIST1 differs from the fine resolution in 
Gn_XIST2 (p0418 = 11, p0419 = 9). This may cause a slight displacement of the encoder 
position after switching the drive unit off/on. 
Therefore, when using a 2-pole resolver as an absolute encoder, we recommend that the 
fine resolution for Gn_XIST1 (p0418) is set the same as the fine resolution for Gn_XIST2 
(p0419), e.g. p0418 = p0419 =11. 
2-pole resolvers are automatically entered in the PROFIdrive profile (r0979) as singleturn 
absolute encoders. 
Position tracking 
You can also activate position tracking for a 2-pole resolver. Please note, however, that the 
resolver may not be moved more than half an encoder revolution (pole width) when switched 
off. The activation and configuration of the position tracking is described in the chapter 
"Position tracking". 
EPOS - absolute encoder adjustment 
If the 2-pole resolver is used as an absolute encoder for basic positioning (EPOS), the 
absolute encoder adjustment must be performed: 
● via STARTER (Basic positioner → Referencing) or 
● via the expert list. 
To do this, set reference point coordinate p2599 to the value corresponding to the 
mechanical system and request the adjustment with p2507 = 2. 
You will then need to back up the data from RAM to ROM.  
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2.16 Temperature sensors for SINAMICS components 
The following table provides an overview of the SINAMICS drive system components 
available with temperature sensor connections.  

 

DANGER  
Safe electrical separation of the temperature sensors 
Only temperature sensors that meet the safety isolation specifications contained in EN 
61800-5-1 may be connected to terminals "+Temp" and "-Temp". If safe electrical 
separation cannot be guaranteed (for linear motors or third-party motors, for example), a 
Sensor Module External (SME120 or SME125) must be used. If these instructions are not 
complied with, there is a risk of electric shock! 

 

 

Table 2- 24 Temperature sensor connections for SINAMICS components 

Module Interface Pin Signal name Technical specifications 
SMC10/SMC20 X520 (sub D) 13 

25 
+Temp 
- Temp 
 

Temperature sensor  
KTY84-1C130 / PTC 

X520 (sub D) 
Temperature 
channel 2 

1 
8 

+Temp 
- Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic-
element switch with NC contact 

SMC30 

X531 (terminal) 
Temperature 
channel 1 

3 
4 

- Temp 
+Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic-
element switch with NC contact 

CUA31 X210 (terminal) 1 
2 

+Temp  
- Temp 

Temperature sensor  
KTY84–1C130 / PTC 

X210 (terminal) 
Temperature 
channel 2 

1 
2 

+Temp  
- Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic-
element switch with NC contact 

CUA32 

X220 (sub D) 
Temperature 
channel 1 

1 
8 

+Temp  
- Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic-
element switch with NC contact 

TM31 X522 (terminal) 7 
8 

+Temp 
- Temp  

Temperature sensor  
KTY84–1C130 / PTC 

SME20 Measuring system  
interface 

7 
9 

- Temp 
+Temp 

Temperature sensor  
KTY84-1C130 / PTC 
connection cable order number 
6FX8002-2CA88- xxxx necessary 
1) 

X200 (connector) 
Temperature 
channel 2 

1 
2 

- Temp  
+Temp  

Temperature sensor 
KTY84-1C130 / PTC / bimetallic-
element switch with NC contact 

SME120 /  
SME125 

X200 (connector) 
Temperature 
channel 3 

3 
4 

+Temp 
- Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic-
element switch with NC contact 
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Module Interface Pin Signal name Technical specifications 
X200 (connector) 
Temperature 
channel 4 

5 
6 

+Temp 
- Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic-
element switch with NC contact 

Active Line Module X21 (terminal) 
 

1 
2 

+Temp  
- Temp 

Active Line Module temperature 
sensor 
Temperature switch type: 
bimetallic-element switch with NC 
contact 

Basic Line Module X21 (terminal) 
 

1 
2 

+Temp  
- Temp 

Basic Line Module temperature 
sensor Temperature switch type: 
bimetallic-element switch with NC 
contact 

Motor Module X21/X22 (terminal) 
 
The following 
applies to chassis: 
X41 (terminal) 
 

1 
2 
4 
3 

+Temp  
- Temp 
+Temp  
- Temp 

Temperature sensor  
KTY84–1C130 / PTC 
Bimetallic switch with NC contact: 
Alarm and timer (only for 
temperature evaluation via MM) 
A PT100 temperature sensor can 
also be evaluated with a DAC-CIM 
module. 

1) Cable for connection to direct measurement systems: Order number 6FXx002-2CB54-xxxx 
 

Commissioning information 
The index [0..n] used in the following identifies either the motor data set or the encoder data 
set. 
SMC10/SMC20  
You can use the STARTER screen (\signals and monitoring \ motor temperature) to 
parameterize the motor temperature evaluation via SUB-D socket X520.  
SMC30 (from Order No. 6SL3055-0AA00-5CA2) 
In addition to temperature evaluation via terminal X531 (temperature channel 1), this module 
also has temperature evaluation at SUB-D socket X520 (temperature channel 2). 
At the default setting (p0600 = 1 "Temperature via encoder 1" and p0601 = 2 "KTY") the 
temperature is evaluated via the first temperature channel. The temperature sensor is 
connected to terminal X531 on the SMC30. The temperature is shown via r0035. 
The parameterization of the motor temperature evaluation via the sub D socket X520 must 
be performed in the expert list as follows: 
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● p0600[0..n]: Selection of the encoder (1, 2 or 3) to which the SMC30, that is used for the 
temperature evaluation, is assigned (n = motor data set). 

● p0601[0..n] = 10 (evaluation via several temperature channels), n = motor data set. 
● p4601[0..n]: Select the temperature sensor type for temperature channel 2 (depends on 

encoder data set n, not motor data set). 
 

 
 

Note 
With several encoders, the index [n] of the relevant encoder / encoder data set, via which 
the temperature evaluation is performed, must be used. 

 

The temperature is displayed in parameter r4620[1] (temperature channel 2). For multiple 
temperature channels (use of temperature channels 1 and 2 on SMC30), parameter r0035 
shows the maximum temperature. 
Example: 
A KTY temperature sensor is connected at the sub D socket X520 on the SMC30 of Encoder 1.  
This is parameterized via: 
● p0600[0..n] = 1 / p0601[0..n] = 10 / p4601[0..n] = 20 
Both temperature channels (X520 and X531) can be used at the same time. In addition to 
the above parameterization, the sensor type of the temperature sensor connected at terminal 
X531 must be entered in p4600[0..n]. The maximum value is then generated for the motor 
temperature and displayed in r0035. 

 

 Note 
With several encoders, the index [n] of the relevant encoder / encoder data set, via which the 
temperature evaluation is performed, must be used. 

 

CUA31 
The parameterization of the temperature evaluation via terminal X210 can be performed 
using the STARTER screen (\Signals and monitoring \ Motor temperature). "Temperature 
sensor via Motor Module (11)" should be selected in the "Temperature sensor selection" 
field. The temperature of the sensor is displayed in r0035. 
 
CUA32 
The parameterization of the temperature evaluation via terminal X210 or sub D socket X220 
is performed using two temperature channels. 
p0600 = 11: Temperature sensor via Motor Module 
For the SINAMICS S120 AC Drive (AC/AC) and if Control Unit Adapter CUA31/CUA32 is 
used, the temperature sensor connection is on the adapter (X210). 
 
TM31 
With Terminal Module TM31, the sensor type used is set via p4100 and the temperature 
signal interconnected via r4105.  
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SME20 
The evaluation of KTY or PTC temperature sensors can be parameterized using the 
STARTER screen (\Signals and monitoring \ Motor temperature): 
● Temperature sensor selection (≙ p0600[0..n]): Selection of the source to which the SME 

module is assigned (temperature sensor via encoder (1, 2 or 3), temperature sensor via 
BICO interconnections or temperature sensor via Motor Module) 

● Temperature sensor type (≙ p0601[0..n]): Sets the sensor type for motor temperature 
monitoring. 

 
Figure 2-43 Selection of temperature sensor for SME20 modules 

 
SME120/SME125 
For modules with several temperature sensor connections (SME Modules), the temperature 
sensor is selected depending on encoder data set n via parameters p4601[0..n]..p4603[0..n]. 
A maximum of three motor temperature sensors can be evaluated simultaneously via 
terminal X200.  
The parameterization of the motor temperature evaluation via terminal X200 must be 
performed in the expert list as follows: 
● p0600[0..n]: Selection of the encoder (1, 2 or 3) to which the SME Module, that is used 

for the temperature evaluation, is assigned (n = motor data set). 
● p0601[0..n] = 10 (evaluation via several temperature channels), n = motor data set. 
● p4601[0..n]-p4603[0..n]: Select the temperature sensor type of temperature channel 2-4, 

depending on encoder data set n. 
Only temperature channels 2-4 are available at terminal X200. 

● Parameter r4620[0...3] Motor temperatures SME 
is used to display the current temperatures in the motor, measured via an SME120 or 
SME125. The indices mean: 
[1] = SME temperature channel 2 / motor temperature sensor 2 
[2] = SME temperature channel 3 / motor temperature sensor 3 
[3] = SME temperature channel 4 / motor temperature sensor 4 
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Diagnostics parameter r0458[0...2] Sensor Module properties 
Index [0...2]: Encoder 1...encoder 3 
Parameter r0458 allows the following properties to be queried at the temperature sensor 
modules: 
 
Bit  Feature 
02 Temperature sensor connection present 
03 Connection for PTC for motors with DRIVE-CLiQ 

also present 
04 Module temperature available 
08 Evaluation set up across several temperature 

channels 

 
Selection of several temperature channels p4601 .. p4603 is only possible, for example, 
when parameter p0601 = 10 is set. This can be checked using the entry r0458.8 = 1. 
You can find further information on parameter r0458 in: /LH1/ SINAMICS S 120/S150 List 
Manual. 
Active Line Module, Basic Line Module 
Parameter p0601 "Motor temperature sensor type" enables the setting for the sensor type for 
the temperature measurement at input X21. The measured value is displayed in r0035. 

Faults and alarms 
F07011 drive: Motor overtemperature 
KTY sensor: 
The motor temperature has exceeded the fault threshold (p0605) or the timer stage (p0606) 
after the alarm threshold was exceeded (p0604) has expired. 
This results in the reaction parameterized in p0610. 
PTC sensor: 
The response threshold of 1650 Ohm was exceeded and the timer stage (p0606) has 
expired. 
This results in the reaction parameterized in p0610. 
If an SME Module is used (p0601 = 10), parameter r949 displays the number of the sensor 
channel that has triggered the message. 
 
A07015 drive: Motor temperature sensor alarm 
A fault was detected when evaluating the temperature sensor set in p0600 and p0601. 
With the fault, the time is started in p0607. If the fault is still present after this time has 
expired, then fault F07016 is output, however, at the earliest 0.2 s after alarm A07015. 
If an SME Module is used (p0601 = 10), parameter r2124 displays the number of the sensor 
channel that has triggered the message. 
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F07016 drive: Motor temperature sensor fault 
An error was detected when evaluating the temperature sensor set in p0600 and p0601. 
If alarm A07015 is present, the time in p0607 is started. If the fault is still present after this 
time has expired, then fault F07016 is output; 1 s after alarm A07015 at the earliest, 
however. 
If an SME Module is used (p0601 = 10), parameter r949 displays the number of the sensor 
channel that has triggered the message. 

Function diagrams (see SINAMICS S120/S150 List Manual) 
● 8016 Signals and monitoring - Thermal monitoring of motor 

Overview of important parameters (refer to the SINAMICS S120/S150 List Manual) 
● r0035 Motor temperature 
● p0600[0..n] Motor temperature sensor for monitoring 
● p0601[0..n] Motor temperature sensor type 
● p0601 Motor temperature sensor type 
● p0603 CI: Motor temperature signal source 
● p0604[0...n] Motor overtemperature alarm threshold 
● p0605[0...n] Motor overtemperature fault threshold 
● p0606[0...n] Motor overtemperature timer stage 
● p0607[0...n] Temperature sensor fault timer stage 
● p0610[0...n] Motor overtemperature reaction 
● p4100 TM31 temperature evaluation sensor type 
● r4105 CO: TM31 temperature evaluation actual value 
● p460x[0...n] Motor temperature sensor (x+1) sensor type, x = 0..3 
● r0458[0...2] Sensor Module properties 
● r4620[0...3] Motor temperatures SME / Mot Temp SME, n = channel 1-4 
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Diagnostics 3
 

This chapter describes the following diagnostic features of the SINAMICS S drive system: 
● Diagnostics via LEDs 
● Diagnostics via STARTER 
● Diagnostic buffer 
● Fault and alarm messages 

3.1 Diagnostics via LEDs 

3.1.1 LEDs when the Control Unit is booted 
The individual states when booting are indicated by means of the LEDs on the Control Unit.  
● The duration of the individual statuses varies. 
● If an error occurs, booting is aborted and the cause of the error is indicated via the LEDs. 

Remedy: Insert the appropriate CompactFlash card with the correct software and 
parameterization. 

● Once the unit has been successfully booted, all the LEDs are switched off briefly. 
● Once the unit has been booted, the LEDs are driven via the loaded software. 

The description of the LEDs after booting applies. 

Control Unit – behavior of the LEDs while booting 

Table 3- 1 Load software 1 

LED 
RDY DP1 OPT MOD 

Status Comment 

red red red off Reset – 
red 2 Hz red red off error • Memory card not inserted 

or 
• Load software 2 has not been 

installed on the memory card or is 
defective. 
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Table 3- 2 Load software 2 

LED 
RDY DP1 OPT MOD 

Status Comment 

off red red off Loaded – 
off Orange red off Running – 
off red 2 Hz red off error file Software on the memory card is 

incomplete or defective. 
off red 0.5 Hz red off error crc CRC invalid. 
off off red off Firmware 

loaded 
– 

 

Table 3- 3 Firmware 

LED 
RDY DP1 OPT MOD 

Status Comment 

off off off off initializing – 
alternating Running refer to the following table 

3.1.2 LEDs after the Control Unit has booted 

Behavior of the LEDs after booting 

Table 3- 4 Control Unit - Description of the LEDs after booting 

LED Color Status Description, cause  Remedy 
- OFF Electronics power supply is missing or outside 

permissible tolerance range. 
– 

Continuous 
light 

The component is ready and cyclic DRIVE-CLiQ 
communication takes place or the Control Unit 
waits for initial commissioning. 

– Green 

2 Hz 
flashing 
light 

Writing to the memory card. – 

Continuous 
light 

At least one fault is present in this component. Remedy and acknowledge 
fault 

Red 

2 Hz 
flashing 
light 

Boot error Make sure that the memory 
card has been inserted 
properly 
Replace the memory card 
Replace Control Unit 
Carry out a POWER ON 

RDY (READY) 

Green/ 
red 

0.5 Hz 
flashing 
light 

Control Unit is ready for operation. 
However there are no software licenses. 

Obtain licenses 
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LED Color Status Description, cause  Remedy 
Continuous 
light 

System booting and DRIVE-CLiQ communication 
is being established. 

– 

0.5 Hz 
flashing 
light 

Updating the firmware of the DRIVE-CLiQ 
components 

- 

Orange 

2 Hz 
flashing 
light 

Firmware update is complete for components. 
Wait for POWER ON for the components in 
question. 

Turn POWER ON for the 
components in question 

Green/ 
orange or 
red/ 
orange 

1 Hz 
flashing 
light 

Detection of the components via LED is activated 
(p0124[0]). 
Note: 
Both options depend on the LED status when 
activated via p0124[0] = 1. 

- 

- Off Cyclic communication is not (yet) running. 
Note: 
The PROFIdrive is ready for communication 
when the Control Unit is ready for operation (see 
RDY LED). 

– 

Continuous 
light 

Cyclic communication is taking place. – Green 

0.5 Hz 
flashing 
light 

Full cyclic communication has not yet taken 
place. 
Possible causes: 
• The controller is not transferring any 

setpoints. 
• During isochronous operation, no global 

control (GC) or a faulty global control (GC) is 
transferred by the controller. 

– 

Red Continuous 
light 

Cyclic communication has been interrupted. Remedy fault 

DP1 
PROFIdrive 
cyclic 
operation 

Orange 2 Hz 
flashing 
light 

Firmware CRC error. Make sure that the memory 
card has been inserted 
properly 
Replace the memory card 
Replace Control Unit 
Carry out a POWER ON 

– Off Electronics power supply missing,  
is outside permissible tolerance range, 
component is not ready for operation, 
Option Board is not available,  
no associated drive object has been created, 

– 

Continuous 
light 

Option board is ready. – Green 

0.5 Hz 
flashing 
light 

Depends on the option board used. – 

OPT 
(OPTION) 

Red Continuous 
light 

There is at least one fault of this component. 
The Option Board is not ready (e.g. after 
switching on). 

Remedy and acknowledge 
fault 

MOD – Off Reserved – 
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3.1.3 Active Line Module 

Table 3- 5 Active Line Module - description of the LEDs 

Status Description, cause Remedy 
Ready (H200) DC link (H201)   
off off Electronics power supply is missing or outside 

permissible tolerance range. 
– 

off The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is present. 

– 

Green 

Red The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is too high. 

Check line voltage 

Orange Orange DRIVE-CLiQ communication is being established. – 
Red – At least one fault is present in this component. 

Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and acknowledge 
fault 

Green/ 
red (0.5 Hz)  

- Firmware is being downloaded. – 

Green/red 
(2 Hz) 

- Firmware download is complete. Wait for POWER ON.  Carry out a POWER ON 

Green/orange 
or 
Red/orange 

– Component detection via LED is activated (p0124). 
Note: 
Both options depend on the LED status when 
component recognition is activated via p0124 = 1. 

– 

 
 

DANGER  
Hazardous DC link voltages may be present at any time regardless of the status of the "DC 
link" LED. 
The warning information on the components must be carefully observed!  
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3.1.4 Basic Line Module 

Table 3- 6 Basic Line Module - description of the LEDs 

Status Description, cause Remedy 
Ready (H200) DC link (H201)   
off off Electronics power supply is missing or outside 

permissible tolerance range. 
– 

off The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is present. 

– 

Green 

Red The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is too high. 

Check the line voltage. 

Orange Orange DRIVE-CLiQ communication is being established. – 
Red – At least one fault is present in this component. 

Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and acknowledge 
fault. 

Green/ 
red (0.5 Hz) 

– Firmware is being downloaded. – 

Green/red 
(2 Hz) 

- Firmware download is complete. Wait for POWER ON.  Carry out a POWER ON 

Green/orange 
or 
Red/orange 

– Component detection via LED is activated (p0124). 
Note: 
Both options depend on the LED status when 
component recognition is activated via p0124 = 1. 

– 

 
 

DANGER  
Hazardous DC link voltages may be present at any time regardless of the status of the "DC 
link" LED. 
The warning information on the components must be carefully observed!  
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3.1.5 Smart Line Modules 5 kW and 10 kW 

Table 3- 7 5 kW and 10 kW Smart Line Modules – description of the LEDs 

LED Color State Description, cause Remedy 
– OFF Electronics power supply is missing or outside 

permissible tolerance range. 
– 

Green Continuous Component is ready to operate. – 
Yellow Continuous Pre-charging not yet complete. 

bypass relay dropped out 
EP terminals not supplied with 24 VDC. 

– 

READY 

Red Continuous Overtemperature 
Overcurrent switch-off 

Diagnostics fault (via 
output terminals) and 
acknowledge it (via input 
terminal) 

– OFF Electronics power supply is missing or outside 
permissible tolerance range. 

– 

Yellow Continuous DC-link voltage within permissible tolerance range. – 

DC LINK 

Red Continuous DC-link voltage outside permissible tolerance range. 
Line supply fault. 

Check the line voltage. 

 
 

DANGER  
Hazardous DC-link voltages may be present at any time regardless of the state of the "DC 
link" LED. 
The warning information on the components must be carefully observed! 
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3.1.6 Smart Line Modules 16 kW and 36 kW 

Table 3- 8 Smart Line Module ≥ 16 kW - description of the LEDs 

State Description, cause Remedy 
Ready (H200) DC link (H201)   
OFF OFF Electronics power supply is missing or outside 

permissible tolerance range. 
– 

OFF The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC-link voltage is present. 

– 

Green 

Red The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC-link voltage is too high. 

Check the line voltage. 

Orange Orange DRIVE-CLiQ communication is being established. – 
Red – At least one fault is present in this component. 

Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and acknowledge 
fault 

Green/Red 
(0.5 Hz) 

– Firmware is being downloaded. – 

Green/Red 
(2 Hz) 

- Firmware download is complete. Waiting for POWER 
ON. 

Carry out a POWER ON 

Green/Orange 
or 
Red/Orange 

– Component detection via LED is activated (p0124). 
Note: 
Both options depend on the LED status when 
component recognition is activated via p0124 = 1. 

– 

 
 

DANGER  
Hazardous DC-link voltages may be present at any time regardless of the state of the "DC 
link" LED. 
The warning information on the components must be carefully observed! 
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3.1.7 Single Motor Module / Double Motor Module / Power Module 

Table 3- 9 Single Motor Module / Double Motor Module / Power Module - description of the LEDs 

Status Description, cause Remedy 
Ready (H200) DC link (H201)   
OFF OFF Electronics power supply is missing or outside 

permissible tolerance range. 
– 

OFF The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is present. 

– 

Green 

Red The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is too high. 

Check supply voltage 

Orange Orange DRIVE-CLiQ communication is being established. – 
Red – At least one fault is present in this component. 

Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and acknowledge 
fault 

Green/red 
(0.5 Hz) 

– Firmware is being downloaded. – 

Green/red 
(2 Hz) 

- Firmware download is complete. Wait for POWER ON.  Carry out a POWER ON 

Green/orange 
or 
Red/orange 

– Component detection via LED is activated (p0124). 
Note: 
Both options depend on the LED status when 
component recognition is activated via p0124 = 1. 

– 

 
 

DANGER  
Hazardous DC link voltages may be present at any time regardless of the status of the "DC 
link" LED. 
The warning information on the components must be carefully observed! 
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3.1.8 Braking Module Booksize 

Table 3- 10 Braking Module Booksize – description of the LEDs 

LED Color Status Description, cause Remedy 
- off Electronics power supply is missing or outside permissible 

tolerance range. 
Component deactivated via terminal. 

– 

Green Continuous Component is ready to operate. – 

READY 

Red Continuous Overtemperature 
Overcurrent switch-off 
I2t monitoring activated.. 
Ground fault/short-circuit. 
Note: 
In the event of an overtemperature, the error cannot be 
acknowledged until a cooling time has elapsed. 

Diagnose fault (via 
output terminals) and 
acknowledge it (via 
input terminal) 

- off Electronics power supply is missing or outside permissible 
tolerance range. 
Component not active. 

– DC LINK 

Green Flashing Component active (DC link discharge via braking resistor in 
progress). 

– 

3.1.9 Control Supply Module 

Table 3- 11 Control Supply Module – description of the LEDs 

LED Color Status Description, cause Remedy 
- off Electronics power supply is missing or outside permissible 

tolerance range. 
– READY 

Green Continuous Component is ready to operate. – 
- off Electronics power supply is missing or outside permissible 

tolerance range. 
– 

Orange Continuous DC link voltage within permissible tolerance range. – 

DC LINK 

Red Continuous DC link voltage outside permissible tolerance range. – 

3.1.10 Sensor Module Cabinet SMC10 / SMC20 

Table 3- 12 Sensor Module Cabinet 10 / 20 (SMC10 / SMC20) – description of the LEDs 

LED Color Status Description, cause Remedy 
- off Electronics power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

RDY 
READY 

Orange Continuous DRIVE-CLiQ communication is being established. – 
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LED Color Status Description, cause Remedy 
Red Continuous At least one fault is present in this component. 

Note: 
LED is driven irrespective of the corresponding messages 
being reconfigured. 

Remedy and 
acknowledge fault 

0.5 Hz 
flashing 
light 

Firmware is being downloaded. – Green/ 
red 

2 Hz 
flashing 
light 

Firmware download is complete. Wait for POWER ON Carry out a POWER 
ON 

Green/ 
orange 
or 
Red/ 
orange 

Flashing 
light 

Component recognition via LED is activated (p0144) 
Note: 
Both options depend on the LED status when component 
recognition is activated via p0144 = 1. 

– 

3.1.11 Sensor Module Cabinet SMC30 

Table 3- 13 Sensor Module Cabinet SMC30 – description of the LEDs  

LED Color Status Description, cause Remedy 
- Off Electronics power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

At least one fault is present in this component. 
Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge fault 

Green/ 
red 

0.5 Hz 
flashing 
light 

Firmware is being downloaded. – 

Green/ 
red 

2 Hz 
flashing 
light 

Firmware download is complete. Wait for POWER ON.  Carry out a POWER 
ON 

RDY 
READY 

Green/ 
orange 
or 
Red/ 
orange 

Flashing 
light 

Component recognition via LED is activated (p0144). 
Note: 
Both options depend on the LED status when component 
recognition is activated via p0144 = 1. 

– 
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LED Color Status Description, cause Remedy 
- Off Electronics power supply is missing or outside permissible 

tolerance range. 
Power supply ≤ 5 V. 

– OUT > 5 V 

Orange Continuous 
light 

Electronics power supply for encoder system available. 
Power supply > 5 V. 
Important: 
Make sure that the connected encoder can be operated 
with a 24 V power supply. If an encoder that is designed 
for a 5 V supply is operated with a 24 V supply, this can 
destroy the encoder electronics. 

– 

3.1.12 Terminal Module TM15 

Table 3- 14 Terminal Module TM15 - description of LEDs 

LED Color State Description, cause Remedy 
- OFF Electronics power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous DRIVE-CLiQ communication is being established. – 
Red Continuous At least one fault is present in this component. 

Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge fault 

Flashing 
0.5 Hz 

Firmware is being downloaded. – Green/r 
ed 

Flashing 
2 Hz 

Firmware download is complete. Wait for POWER ON Carry out a POWER 
ON 

READY 

Green/ 
orange 
or 
Red/ 
orange 

Flashing Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when component 
recognition is activated via p0154 = 1. 

– 
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3.1.13 Terminal Module TM31 

Table 3- 15 Terminal Module TM31 - description of LEDs 
LED Color State Description, cause Remedy 

- OFF Electronics power supply is missing or outside permissible 
tolerance range. 

– 

Green Continuous The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous DRIVE-CLiQ communication is being established. – 
Red Continuous At least one fault is present in this component. 

Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge fault 

Flashing 
0.5 Hz 

Firmware is being downloaded. – Green/ 
red 

Flashing 
2 Hz 

Firmware download is complete. Wait for POWER ON Carry out a POWER 
ON 

READY 

Green/ 
orange 
or 
Red/ 
orange 

Flashing Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when component 
recognition is activated via p0154 = 1. 

– 

3.1.14 Terminal Module TM41 

Table 3- 16 Terminal Module TM41 - description of LEDs 
LED Color Status Description, cause Remedy 

- Off Electronics power supply is missing or outside permissible 
tolerance range. 

– 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

At least one fault is present in this component. 
Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge fault 

0.5 Hz 
flashing 
light 

Firmware is being downloaded. – Green/ 
red 

2 Hz 
flashing 
light 

Firmware download is complete. Wait for POWER ON.  Carry out a POWER 
ON 

READY 

Green/ 
orange 
or 
Red/ 
orange 

Flashing 
light 

Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when component 
recognition is activated via p0154 = 1. 

– 
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LED Color Status Description, cause Remedy 
– Off Zero marker found; wait for zero marker output; OR 

component switched off. 
– 

Red Continuous 
light 

Zero mark not enabled or zero mark search. – 

Continuous 
light 

Stopped at zero mark. – 

Z pulses 

Green 

Flashing 
light 

Zero mark is output at each virtual revolution. – 

3.1.15 Terminal Module TM54F 

Table 3- 17 Terminal Module TM54F - description of LEDs 

LED Color Status Description, cause Remedy 
- Off Electronics power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

At least one fault is present in this component. 
Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge 
fault 

0.5 Hz 
flashing light 

Firmware is being downloaded. – Green/red 

2 Hz 
flashing light 

Firmware download is complete. Wait for POWER ON Carry out a 
POWER ON 

READY 

Green/orange 
or 
Red/orange 

Flashing 
light 

Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when component 
recognition is activated via p0154 = 1. 

– 

– ON The controllable sensor power supply is functioning fault-
free. 

– L1+, L2+,  

Red Continuous 
light 

There is a fault in the controllable sensor power supply. – 

L3+ – ON Sensor power supply is functioning fault-free.  
 Red Continuous 

light 
There is a fault in the sensor power supply.  

Fail-safe inputs / double inputs 
F_DI z 
(input x, 
(x+1)+, 
(x+1)-) 
 

LED  
x 
– 
– 
 
– 
– 

LED  
x+1 
Red 
 – 
 
Red 
– 

 
 
Cont. light 
– 
 
Cont. light 
– 

 
NC contact / NC contact 1): (z = 0..9, x = 0, 2, ..18) 
Different signal states at input x and x+1  
No signal at input x and no signal at input x+1 
NC contact / NO contact 1): (z = 0..9, x = 0, 2, ..18) 
Same signal states at input x and x+1  
No signal at input x and a signal at input x+1 

– 
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LED Color Status Description, cause Remedy 
LED  
x  
Green  
 
Green 

LED  
 x+1 
Green 
 
Green 

 
 
Cont. light 
 
Cont. light 

 
NC contact / NC contact 1): (z = 0..9, x = 0, 2, ..18)  
A signal at input x and a signal at input x+1 
NC contact / NO contact 1): (z = 0..9, x = 0, 2, ..18)  
A signal at input x and no signal at input x+1 

– 

1) Inputs x+1 (DI 1+, 3+, .. 19+) can be set individually via parameter p10040. 
 p10040 = 0: Input x+1 ist NC contact. 
 p10040 = 1: Input x+1 is NO contact. 
 Factory setting: p10040 = 0 for all inputs x+1. 
Single digital inputs, not fail-safe 

– Off No signal at digital input x (x = 20..23) – DI x 
 Green Cont. light Signal at digital input x – 
Fail-safe digital outputs with associated readback channel 
F_DO y 
(0+..3+, 
0-..3-) 

Green Continuous 
light 

Output y (y=0 .. 3) carries a signal – 

Readback input DI 2y for output F_DO y (y = 0..3) at test stop. 
The state of the LEDs also depends on the type of external circuit. 
DI 2y – Off One of the two output lines y+ or y- or both lines of output y 

carry a signal 
– 

 Green Cont. light Both output lines y+ and y- carry no signal – 

3.1.16 Communication Board CAN (CBC10) 

Table 3- 18 Communication Board CAN CBC10 – Description of the LEDs  

LED Color Status Description, cause  Remedy 
– OFF Electronics power supply is missing or outside permissible 

tolerance range. 
Communication Board either defective or not inserted. 

– 

Cont. light OPERATIONAL – 
Flashing light PREOPERATIONAL 

No PDO communication possible 
– 

Green 

Single flash STOPPED 
Only NMT communication possible 

 

Continuous 
light 

BUS OFF Check baud rate 
Check cabling 

Single flash ERROR PASSIVE MODE 
The error counter for "error passive" has reached the 
value 127. After the SINAMICS drive system was booted 
no further active CAN component was on the bus. 

Check baud rate 
Check cabling 

OPT on the 
Control Unit 

Red 

Double flash Error Control Event, a Guard Event has occurred Check connection to 
CANopen master 
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3.1.17 Communication Board Ethernet CBE20 

Table 3- 19 Communication Board Ethernet CBE20 – description of the LEDs  

LED Color Status Description, cause Remedy 
- Off Electronics power supply is missing or outside permissible 

tolerance range. 
– Link port 

Green Continuous 
light 

A different device is connected to port x and a physical 
connection exists. 

– 

- Off Electronics power supply is missing or outside permissible 
tolerance range. 

– Activity port 

Yellow Continuous 
light 

Data is being received or sent at port x. – 

– Off If the Link Port LED is green: 
The CBE20 is operating normally, data is being 
exchanged with the configured IO Controller 

– 

Flashing • The response monitoring interval has elapsed. 
• Communications is interrupted. 
• The IP address is incorrect. 
• Incorrect or no configuration. 
• Incorrect parameter settings. 
• Incorrect or missing device name. 
• IO Controller not connected/switched off, although an 

Ethernet connection has been established. 
• Other CBE20 errors 

– 

Fault 

Red 

Continuous 
light 

CBE20 bus error 
• No physical connection to a subnet/switch. 
• Incorrect transmission rate 
• Full duplex transmission is not activated. 

– 

– Off If the Link Port LED is green: 
Control Unit task system is not synchronized with the IRT 
clock. An internal substitute clock is generated. 

– 

Flashing 
light 

The Control Unit task system has synchronized with the 
IRT clock cycle and data is being exchanged. 

– 

Sync 

Green 

Continuous 
light 

Task system and MC-PLL have synchronized with the IRT 
clock. 

– 

– OFF Electronics power supply is missing or outside permissible 
tolerance range. 
Communication Board either defective or not inserted. 

– 

Continuous 
light 

Communication Board is ready and cyclic communication 
is taking place. 

– 

OPT on the 
Control Unit 

Green 

0.5 Hz 
flashing 
light 

The Communication Board is ready, but cyclic 
communication is not yet taking place. 
Possible causes: 
• At least one fault is present. 
• Communication is being established. 

– 
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LED Color Status Description, cause Remedy 
Continuous 
light 

Cyclic communication via PROFINET has not yet been 
established. However, non-cyclic communications are 
possible. SINAMICS waits for a 
parameterizing/configuring telegram 

– 

0.5 Hz 
flashing 
light 

The firmware has not been successfully downloaded to 
the CBE20 (error). 
Possible causes: 
• The CBE20 is defective. 
• The memory card for the Control Unit is defective. 
In this state CBE20 cannot be used. 

– 

Red 

2.5 Hz 
flashing 
light 

Communication between the Control Unit and CBE20 is 
faulty. 
Possible causes: 
• Board was withdrawn after booting. 
• The board is defective 

Correctly insert the 
board, if required, 
replace. 

Orange 2.5 Hz 
flashing 
light 

Firmware is being downloaded. – 

3.1.18 Voltage Sensing Module VSM10 

Table 3- 20 Voltage Sensing Module VSM10 – description of LEDs 

LED Color State Description, cause Remedy 
- OFF Electronics power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous DRIVE-CLiQ communication is being established. – 
Red Continuous At least one fault is present in this component. 

Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge fault 

Flashing 
0.5 Hz 

Firmware is being downloaded. – Green/ 
red 

Flashing 2 
Hz 

Firmware download is complete. Wait for POWER ON Carry out a POWER 
ON 

READY 

Green/ 
orange 
or 
Red/ 
orange 

Flashing Component recognition via LED is activated (p0144) 
Note: 
Both options depend on the LED status when component 
recognition is activated via p0144 = 1. 

– 
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3.1.19 DRIVE-CLiQ Hub Module DMC20 

Table 3- 21 DRIVE-CLiQ Hub Module DMC20 – description of the LEDs 

LED Color State Description, cause Remedy 
- OFF Electronics power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous DRIVE-CLiQ communication is being established. – 
Red Continuous At least one fault is present in this component. 

Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge fault 

Flashing 
0.5 Hz 

Firmware is being downloaded. – Green/ 
red 

Flashing 
2 Hz 

Firmware download is complete. Wait for POWER ON Carry out a POWER 
ON 

READY 

Green/ 
orange 
or 
Red/ 
orange 

Flashing Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when component 
recognition is activated via p0154 = 1. 

– 
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3.2 Diagnostics via STARTER 

Description 
The diagnostic functions support commissioning and service personnel during 
commissioning, troubleshooting, diagnostics and service activities.  

General information 
Prerequisites: Online operation of STARTER. 
The following diagnostic functions are available in STARTER: 
● Specifying signals with the ramp-function generator 
● Signal recording with the trace function 
● Analyzing the control response with the measuring function 
● Outputting voltage signals for external measuring devices via test sockets 

3.2.1 Function generator 

Description 
The ramp-function generator can be used, for example, for the following tasks:  
● To measure and optimize control loops. 
● To compare the dynamic response of coupled drives. 
● To specify a simple traversing profile without a traversing program. 
The ramp-function generator can be used to generate different signal shapes.  
In the connector output operating mode (r4818), the output signal can be injected into the 
control loop via the BICO interconnection. 
In servo operation and depending on the mode set, this setpoint can also be injected into the 
control structure as a current setpoint, disturbing torque, or speed setpoint, for example. 
The impact of superimposed control loops is automatically suppressed. 
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Parameterizing and operating the ramp-function generator  
The ramp-function generator is parameterized and operated via the parameterization and 
commissioning tool STARTER. 

 
Figure 3-1 "Ramp-function generator" initial screen 

 

 Note 
Please refer to the online help for more information about parameterizing and operation.  

 

Properties 
● Concurrent injection to several drives possible.  
● The following parameterizable signal shapes can be set: 

– Square-wave 
– Staircase 
– Triangular 
– Sinusoidal 
– PRBS (pseudo random binary signal, white noise) 

● An offset is possible for each signal. The ramp-up to the offset is parameterizable. Signal 
generation begins after the ramp-up to the offset. 
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● Restriction of the output signal to the minimum and maximum value settable. 
● Operating modes of the ramp-function generator for servo and vector 

– Connector output 
● Operating modes of the ramp-function generator (servo only) 

– Current setpoint downstream of filter (current setpoint filter) 
– Disturbing torque (downstream of current setpoint filter) 
– Speed setpoint downstream of filter (speed setpoint filter) 
– Current setpoint upstream of filter (current setpoint filter) 
– Speed setpoint upstream of filter (speed setpoint filter) 

Injection points of the ramp-function generator 

 
Figure 3-2 Injection points of the ramp-function generator 

Further signal shapes 
Further signal shapes can be parameterized. 
Example: 
The "triangular" signal form can be parameterized with "upper limitation" to produce a 
triangle with no peak. 

 
Figure 3-3 "Triangular" signal without peak 

Starting/stopping the ramp-function generator 
 

CAUTION  
With the corresponding ramp-function generator parameter settings (e.g. offset), the motor 
can "drift" and travel to its end stop.  
The movement of the drive is not monitored while the ramp-function generator is active.  
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To start the ramp-function generator: 
1. Establish the preconditions for starting the ramp-function generator: 

– Click the button: 

 
– Select the "Function generator" tab. 

or 
– In the project field, under Drives, call → Drives_xy → Commissioning → Function 

generator with a double click. 
2. Select the operating mode, e.g. speed setpoint after the filter 
3. Select the drive, e.g. Drive_01 
4. Set the signal waveform e.g. rectangular 
5. Click on the "Assume control priority!" button 
6. Accept "Sign-of-life monitoring" (master control - button turns yellow) 
7. Click on the green button "Drive on" 
8. Start the ramp-function generator ("Start FctGen" button) 
9. After reading, confirm the "Caution" note with "yes" 
To stop the measuring function: 
1. "Stop FctGen" button 
2. The drive can also be stopped by pressing the red "Drive off" button. 

Parameterization 
The "Function generator" parameterizing screen is selected using the following symbol in the 
function bar in the STARTER commissioning tool: 

 
Figure 3-4 STARTER icon for "trace function/ramp-function generator"  
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3.2.2 Trace function 

Description 
The trace function can be used to record measured values over a defined period depending 
on trigger conditions.  

Parameterizing and using the trace function 
The trace function is parameterized and operated via the parameterization and 
commissioning tool STARTER. 

 
Figure 3-5 Trace function 

The device cycle clock display flashes 3 times at around 1 Hz when the time slice is changed 
from < 4 ms to ≥4 ms (see description under "Properties"). 

 

 Note 
Please refer to the online help for more information about parameterizing and operation.  
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Properties 
● Up to 8 recording channels for each recorder 

When more than 4 channels per single trace are used, the trace's device clock cycle is 
switched automatically from 0.125 ms (0.250 ms for vector control) to 4 ms. This action 
ensures that the CU320's performance is not influenced too strongly by the trace. 

● Up to 4 recording channels per trace 
● Device clock cycles of SINAMICS S120 trace for single traces: 

4 channels: 0.125 ms (Servo)/0.250 ms (Vector) 
8 channels: 4 ms (Servo/Vector) 

● Two independent trace recorders per Control Unit 
● Endless trace 

After the last trace parameter has been written, the drive automatically starts writing to 
the trace memory from the beginning again (ring buffer function). 
Device clock cycle of SINAMICS S120 trace for endless trace: 
4 channels: 0.125 ms (Servo)/0.250 ms (Vector) 
8 channels: 4 ms (Servo/Vector) 
The time slice 4 ms may not be available due to the system condition. In this case the 
next higher time slice is used. 

● Triggering 
– Without triggering (recording immediately after start) 
– Triggering on signal with edge or on level 
– Trigger delay and pretrigger possible 

● STARTER parameterization and commissioning tool 
– Automatic or adjustable scaling of display axes 
– Signal measurement via cursor 

● Settable trace cycle: Integer multiples of the basic sampling time 
● Averaging the trace values 

If a float value with a clock cycle slower than the device cycle clock is recorded, then the 
values recorded will not be averaged. This is obtained using parameter p4724. 
Parameter p4724[0...1] "Trace averaging in time range" is at "0" in the default setting. 
Index "0" and "1" stand for both the trace recorders each with 8 channels. 
If the values recorded should be averaged, parameter p4724 should be set to "1". 

Parameterization 
The "trace function" parameter screen is selected via the following icon in the toolbar of the 
STARTER commissioning tool. 

 
Figure 3-6 STARTER icon for "trace function/ramp-function generator" 
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3.2.3 Measuring function 

Description 
The measuring function is used for optimizing the drive controller. By parameterizing the 
measuring function, the impact of superimposed control loops can be suppressed selectively 
and the dynamic response of the individual drives analyzed. The ramp-function generator 
and trace function are linked for this purpose. The control loop is supplied with the ramp-
function generator signal at a given point (e.g. speed setpoint) and recorded by the trace 
function at another (e.g. speed actual value). The trace function is parameterized 
automatically when the measuring function is parameterized. Specific predefined operating 
modes for the trace function are used for this purpose. 

Parameterizing and using the measuring function 
The measuring function is parameterized and operated via the parameterization and 
commissioning tool STARTER. 

 
Figure 3-7 "Measuring function" initial screen 

 

 Note 
Please refer to the online help for more information about parameterizing and operation.  
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Properties 
● Measuring functions 

– Current controller setpoint change (downstream of the current setpoint filter) 
– Current controller reference frequency response (downstream of the current setpoint 

filter) 
– Speed controller setpoint change (downstream of the speed setpoint filter) 
– Speed controller disturbance step change (fault downstream of the current setpoint 

filter) 
– Speed controller reference frequency response (downstream of the speed setpoint 

filter) 
– Speed controller reference frequency response (upstream of the speed setpoint filter) 
– Speed controller interference frequency response (fault downstream of the current 

setpoint filter) 
– Speed controller path (excitation downstream of current setpoint filter) 

Starting/stopping the measuring function 
 

CAUTION  
With the corresponding measuring function parameter settings (e.g. offset), the motor can 
"drift" and travel to its end stop.  
The movement of the drive is not monitored while the measuring function is active.  

 

To start the measuring function: 
1. Ensure that the prerequisites for starting the measuring function are fulfilled. 

– Activate the control board. 
Drives –> Drive_x –> Commissioning –> Control board 

– Switch on the drive. 
Control board –> Activate enable signals –> Switch on 

2. Select the drive (as control board). 
3. Set the measuring function. 

e.g. current controller setpoint change 
4. Load the settings to the target system ("Download parameterization" button). 
5. Start the ramp-function generator ("Start measuring function" button) 

To stop the measuring function: 
● "Stop measuring function" button 
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Parameterization 
The "measuring function" parameter screen is selected via the following icon in the toolbar of 
the STARTER commissioning tool: 

 
Figure 3-8 STARTER icon for "Measuring function" 

3.2.4 Measuring sockets 

Description 
The measuring sockets are used to output analog signals. Any interconnectable signal can 
be output to any measuring socket on the Control Unit.  

 

CAUTION  
The measuring sockets should be used for commissioning and servicing purposes only.  
The measurements may only be carried out by properly trained specialist personnel.  

 

T0

T1

T2

M

Measuring socket 0

Measuring socket 1

Measuring socket 2

Reference
with default scale setting

 
Figure 3-9 Arrangement of the measuring sockets on the CU320 Control Unit 
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Parameterizing and using the measuring sockets 
The measuring sockets are parameterized and operated via the STARTER parameterization 
and commissioning tool. 

 
Figure 3-10 "Measuring sockets" initial screen 

 

 Note 
Please refer to the online help for more information about parameterizing and operation.  

 

Properties 
 
• Resolution 8-bit 
• Voltage range 0 V to +4.98 V 
• Measuring cycle Depends on the measuring signal 

(e.g. actual speed value in speed controller cycle 125 μs) 
Short-circuit-proof 
Parameterizable scaling 
Adjustable offset 
Adjustable limitation 
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Signal chart for measuring sockets 

 
Figure 3-11 Signal chart for measuring sockets 

Which signal can be output via measuring sockets?  
The signal to be output via a measuring socket is specified by parameterizing the connector 
input p0771[0...2]. 

Important measuring signals (examples) 
 
r0060 CO: Speed setpoint before speed setpoint filter 
r0063 CO: Actual speed value 
r0069[0...2] CO: Phase currents actual value 
r0075 CO: Field-generating current setpoint 
r0076 CO: Field-generating actual current 
r0077 CO: Torque-generating current setpoint 
r0078 CO: Torque-generating actual current 

Scaling 
Scaling specifies how the measuring signal is processed. A straight line with 2 points must 
be defined for this purpose. 
Example: 
x1 / y1 = 0.0% / 2.49 V x2 / y2 = 100.0% / 4.98 V (default setting) 
– 0.0% is mapped onto 2.49 V 
– 100.0% is mapped onto 4.98 V 
– 100.0% is mapped onto 0.00 V 
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Offset 
The offset is applied additively to the signal to be output. The signal to be output can thus be 
displayed within the measuring range. 

Limitation 
● Limitation on 

If signals are output outside the permissible measuring range, the signal is limited to 4.98 
V or to 0V. 

● Limitation off 
The output of signals outside the permissible measuring range causes a signal overflow. 
In the event of an overflow, the signal jumps from 0 V to 4.98 V or from 4.98 to 0 V. 

Example of a measurement 
Assumption: 
The actual speed (r0063) is to be output for a drive via measuring socket T1. 
How do you do it? 
1. Connect and set the measuring device. 
2. Interconnect the signal (e.g. STARTER). 

Interconnect the connector input (CI) belonging to the measuring socket with the desired 
connector output (CO). 
CI: p0771[1] = CO: r0063 

3. Parameterize the signal characteristic (scaling, offset, limitation). 

Function diagrams (see SINAMICS S120/S150 List Manual)  
● 8134 measuring sockets 

Overview of important parameters (refer to the SINAMICS S120/S150 List Manual)  

Adjustable parameters 
● p0771[0...2] CI: Measuring sockets signal source 
● p0777[0...2] Measuring sockets characteristic value x1 
● P0778[0...2] Measuring sockets characteristic value y1 
● p0779[0...2] Measuring sockets characteristic value x2 
● p0780[0...2] Measuring sockets characteristic value y2 
● p0783[0...2] Measuring sockets offset 
● p0784[0...2] Measuring sockets limit on/off 

Display parameters 
● r0772[0...2] Measuring sockets output signal 
● r0774[0...2] Measuring sockets output voltage 
● r0786[0...2] Measuring sockets normalization per volt 



Diagnostics  
3.3 Diagnostic buffer 

 Commissioning Manual 
180 Commissioning Manual, (IH1), 11/2009, 6SL3097-4AF00-0BP0 

3.3 Diagnostic buffer 

Description 
A diagnostic buffer mechanism has already been implemented in the SIMATIC S7 
environment. It can record important operational events in the automation system as a kind 
of log book (restriction: The availability of the diagnostics buffer mechanism is also 
dependent on the hardware release of the Control Unit. The mechanism is available with 
hardware release E or higher. For other hardware releases, a message will inform you that 
the diagnostics buffer cannot be read.  
The diagnostic buffer is in the non-volatile memory, so data written to it can be read out for 
subsequent analysis of a malfunction (including pre-history). 
The essential events recorded in the buffer are: 
● Faults 
● Important changes to the boot status (end status) and partial booting of DOs 
● Commissioning procedures 
● State change of PROFIBUS/PROFINET communication 
● Exceptions 
The entries in the diagnostic buffer can be called up via the drive unit properties (symbol in 
project navigator --> right mouse-click) under the menu option Target device --> Device 
diagnostics. 

 

 Note 
STEP7 Full version 
The STARTER device diagnostics function is displayed only when you have installed the full 
version of STEP7. 

 

 

Events recorded by the diagnostic buffer 
The following list shows the entries defined for SINAMICS drive units. Additional information 
is marked with <>. 
Faults 
An entry is defined for each possible DO number. The fault code and fault value are entered 
in the additional information.  
Example:  
Fault DO 5: Fault code 1005 fault value 0x30012 
Alarms are not recorded in the diagnostic buffer. Propagated faults (faults which are signaled 
to all DOs) are only stored in the diagnostic buffer once. 
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Booting procedures and booting status changes 
In principle, only start and completion are recorded for booting procedures. Booting status 
(see r3988) are only recorded when an end status arises that can only be exited by user 
action (r3988 = 1, 10, 200, 250, 325, 370, 800). Booting statuses and booting status 
changes are: 
● POWER ON 
● Error in booting (r3988 = 1) 
● Fatal error in booting (r3988 = 10) 
● Waiting for first commissioning (r3988 = 200) 
● Topology error in booting (r3988 = 250) 
● Waiting for entry of drive type (r3988 = 325) 
● Waiting until p0009 = 0 is set (r3988 = 370) 
● Boot status r3988 = <state at which 670 or 680> reached 
● Booting finished, cyclic operation 
● Reason for new boot < 0 = Internal reason; 1 = Warm start; 2 = Booting from saved data; 

3 = Booting after download> 
● Drive reset via p0972 = <Mode> 
● Partial booting DO started <DO number> 
● Partial booting DO <DO number> finished 
Commissioning procedures 
● Device commissioning: New status p0009 = <new value p0009> 
● Commissioning DO <DO number>: New status p0010 = <new value p0010> 
● Ram2Rom DO <0 for all DOs> started 
● Ram2Rom DO <0 for all DOs> completed 
● Project download started 
● DO <DO_Number> deactivated 
● DO <DO_Number> reactivated 
● Component <Component number> deactivated 
● Component <Component number> reactivated 
● Power Off/ Power On required after firmware update (DO <DO number> 

Component < Component number >) 
● DO <DO-No> deactivated and not available 
● Component <component number> deactivated and not available 
Communication (PROFIBUS, PROFINET, ...) 
● PZD <IF1 or IF2> cyclic data exchange started 
● PZD <IF1 or IF2> cyclic data exchange completed 
● Changeover to UTC time for operating hours count status <Days> <Milliseconds> 
● Time correction (correct) by <correction value> seconds 
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Exceptions 
Exceptions can be taken from the crash diagnostics already available in the new boot run. 
The exceptions are always entered into the diagnostic buffer first, even before the entry 
"POWER ON". 
● Data Abort Exception Address: <Content Program Counter> 
● Floating Point Exception Address: <Content Program Counter> 
● Prefetch Abort Exception Address: <Content Program Counter> 
● Exception type <Type coding> Info: <Info depends on type> 

Treatment of the time stamp  
After successful time synchronization (in cyclic operation), the UTC time is used as a time 
stamp. Up until this time (POWER ON and switching to UTC time) the operating hours 
counter is used for all entries. The UTC time is entered for following entries. 
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3.4 Diagnostics of uncommissioned axes 

Description 
To be able to identify uncommissioned drive objects of the classes "Infeeds", "Motor 
Module", "SERVO" and "VECTOR", there is an operating display in parameter r0002.  
● r0002 "Infeed operating display" = 35: Carry out the first start-up 
● r0002 "Drive operating display" = 35: Carry out the first start-up 
 
The parameter r0002 "drive operating display" = 35 is then displayed when p3998[D]=0 is in 
any data set. Parameter p3998 specifies whether the first commissioning of the drive is still 
to be carried out (0 = yes, 2 = no). 
Parameter p3998 is set to the value 2 when the calculation of the motor and control 
parameters for all data sets has been completed without errors (see r3925 bit0=1) and the 
encoder selection p0400 is not on 10100 (encoder identification). 
The limitation that all drive data sets (DDS) must be commissioned in order to exit 
commissioning is ensured by checking the parameters involved (see also F07080 in the 
SINAMICS S120/S150 List Manual). 
 
Infeeds 
An infeed (Active Line Modules, Basic Line Modules or Smart Line Modules with DRIVE-
CLiQ) is considered commissioned when the line voltage and line frequency have been 
parameterized with appropriate values. A basic setting of 50 Hz or 60 Hz is expected for the 
line frequency. 
The line voltage p0210 may need to be adjusted to the existing power supply. 
To leave the state r0002 "Infeed operating display" = 35, set parameter p3900 "completion of 
quick commissioning" to the value 3, after any necessary adjustment to the line voltage. 
For a 400V unit, for example, the voltage p0210 is always initialized with 400 V. Although it is 
possible to switch on with all power supplies from 380V to 480V, operation is not optimal and 
alarm messages appear (see SINAMICS S120/S150 List Manual). 
If the unit is not being used with a 400V power supply, the rated voltage p0210 should be 
adjusted. This can also be done after the first time the unit is switched on, by setting 
p0010=1. 
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Motor Module SERVO and VECTOR 
A drive is considered commissioned when valid data fills the relevant motor and encoder 
data sets in every drive data set (DDS) assigned to it:  
● Motor data sets (MDS): 

p0131, p0300, p0301 etc. (see SINAMICS S120/S150 List Manual) 
● Encoder data sets (EDS): 

p0141, p0142, p0400 etc. (see SINAMICS S120/S150 List Manual) 
After parameterizing the motor and encoder data via quick commissioning 
(p0010 = 1 ->0) use p3900 "completion of quick commissioning" > 0 to exit. 
If commissioning should not be run using quick commissioning, the motor data should be 
entered via p0010 = 3 (p0340[0...n] "Automatic calculation of motor/control parameters" =1) 
after entering the rating plate data, and after that the encoder data entered via p0010 = 4. 
If the above conditions are not met, in r0002 of the drive concerned the value r0002 = 35: 
"Carry out first commissioning" is shown. 
It is not taken into account whether BICO sources like, for example: 
● p0840 "BI: ON/OFF1" or 
● p0864 "BI: Infeed operation" 
needed for switching on (pulse enable) have already been parameterized or are still at the 
value 0. 
If, after commissioning all DDSs, parameter p0010 is set once more to a value greater than 
0, in r0002 the value r0002 = 46: "Switching on inhibited - exit the commissioning mode 
(p0009, p0010)" will be displayed. 
The drive has been commissioned, but no pulse can be enabled. 
Note on p0010 = 1 (quick commissioning): 
Quick commissioning with p3900 > 0 (when p0010 = 1) works for all DDSs where motor and 
encoder data have been entered. 
This means that if quick commissioning is carried out a second or third time (or more), 
previously calculated and possibly user-adjusted data will be overwritten or recalculated. 
For this reason we recommend carrying out any subsequent commissioning of a certain 
DDS (e.g. changing the motor), specifically using p0010 = 3 and p0010 = 4 instead of 
p0010 = 1. 
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Example 
The image below shows a diagram of the diagnostic performance of uncommissioned 
infeeds and drives. A configuration with one power unit (DO2) and respectively two DDSs, 
MDSs and EDSs has been assumed. DO1 represents the CU. 
The unit has already been commissioned. 
The number of data sets and the components assigned to the DO2 have already been 
entered and the data set allocated. 

 
Figure 3-12 Diagnostics of uncommissioned axes 



Diagnostics  
3.5 Fault and alarm messages 

 Commissioning Manual 
186 Commissioning Manual, (IH1), 11/2009, 6SL3097-4AF00-0BP0 

3.5 Fault and alarm messages 

3.5.1 General information about faults and alarms 

Description 
The errors and states detected by the individual components of the drive system are 
indicated by messages.  
The messages are categorized into faults and alarms. 

 

 Note 
The individual faults and alarms are described in the SINAMICS S120/S150 List Manual in 
the chapter "Faults and Alarms". Function diagrams for the fault buffer, alarm buffer, fault 
trigger and fault configuration are also contained in the Section "Function diagrams" -> 
"Faults and alarms". 

 

Properties of faults and alarms 
● Faults 

– Are identified by Fxxxxx. 
– Can lead to a fault reaction. 
– Must be acknowledged once the cause has been remedied. 
– Status via Control Unit and LED RDY. 
– Status via PROFIBUS status signal ZSW1.3 (fault active). 
– Entry in the fault buffer. 

● Alarms (code A56789)  
– Are identified by Axxxxx. 
– Have no further effect on the drive. 
– The alarms are automatically reset once the cause has been remedied. No 

acknowledgement is required. 
– Status via PROFIBUS status signal ZSW1.7 (alarm active). 
– Entry in the alarm buffer. 

● General properties of faults and alarms 
– Can be configured (e.g. change fault to alarm, fault reaction). 
– Triggering on selected messages possible. 
– Initiation of messages possible via an external signal. 
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Acknowledgement of faults 
The list of faults and alarms specifies how each fault is acknowledged after the cause has 
been remedied.  
1. Acknowledgement of faults by "POWER ON" 

– Switch the drive on/off (POWER ON) 
– Press the RESET button on the Control Unit 

2. Acknowledgement of faults by "IMMEDIATE" 
– Via PROFIBUS control signal 

STW1.7 (reset fault memory): 0/1 edge 
Set STW1.0 (ON/OFF1) = "0" and "1" 

– Via external input signal 
Binector input and interconnection with digital input 
p2103 = "Requested signal source" 
p2104 = "Requested signal source" 
p2105 = "Requested signal source" 
Across all of the drive objects (DO) of a Control Unit 
p2102 = "Requested signal source" 

3. Acknowledge faults with "PULSE INHIBIT" 
– The fault can only be acknowledged with a pulse inhibit (r0899.11 = 0). 
– The same possibilities are available for acknowledging as described under 

acknowledge IMMEDIATELY. 
 

 
 

Note 
The drive cannot resume operation until all active faults have been acknowledged.  
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3.5.2 Buffer for faults and alarms 
 

 Note 
A fault and alarm buffer is provided for each drive. The drive and device-specific messages 
are entered in this buffer.  
The contents of the fault buffer are saved to non-volatile memory when the Control Unit is 
powered down, i.e. the fault buffer history is still available when the unit is powered up again. 

 

NOTICE  
The entry in the fault/alarm buffer is made after a delay. For this reason, the fault/alarm 
buffer should not be read until a change in the buffer is also recognized (r0944, r2121) after 
"Fault active"/"Alarm active" is output.  

 

Fault buffer 
Faults which occur are entered in the fault buffer as follows:  

r0949[63] [I32]
r2133[63] [ Float]

r0945[0]

r0945[1]

r0945[7]

r0945[56]

r0945[57]

r0945[63]

r0945[8]

r0945[9]

r0945[15]

r0949[0] [I32]
r2133[0] [Float]

r0949[1] [I32]
r2133[1] [Float]

r0949[7] [I32]
r2133[7] [Float]

r0949[56] [I32]
r2133[56] [ Float]

r0949[57] [I32]
r2133[57] [ Float]

r0949[8] [I32]
r2133[8] [Float]

r0949[9] [I32]
r2133[9] [Float]

r0949[15] [I32]
r2133[15] [ Float]

r0948[0] [ms]
r2130[0] [ d]

r0948[1] [ms]
r2130[1] [ d]

r0948[7] [ms]
r2130[7] [ d]

r0948[56] [ms]
r2130[56] [d]

r0948[57] [ms]
r2130[57] [d]

r0948[63] [ms]
r2130[63] [d]

r0948[8] [ms]
r2130[8] [ d]

r0948[9] [ms]
r2130[9] [ d]

r0948[15] [ms]
r2130[15] [d]

r2109[0] [ ms]
r2136[0] [d]

r2109[1] [ ms]
r2136[1] [d]

r2109[7] [ ms]
r2136[7] [d]

r2109[56] [ms]
r2136[56] [d]

r2109[57] [ms]
r2136[57] [d]

r2109[63] [ms]
r2136[63] [d]

r2109[8] [ ms]
r2136[8] [d]

r2109[9] [ ms]
r2136[9] [d]

r2109[15] [ms]
r2136[15] [d]

r3115[63]

r3115[57]

r3115[56]

r3115[15]

r3115[9]

r3115[8]

r3115[7] <1>

r3115[7]

r3115[0]

 
Figure 3-13 Structure of the fault buffer 
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Properties of the fault buffer 
● A new fault incident encompasses one or more faults and is entered in "Current fault 

incident". 
● The entries are arranged in the buffer according to the time at which they occurred. 
● If a new fault incident occurs, the fault buffer is reorganized. The history is recorded in 

"Acknowledged fault incident" 1 to 7. 
● If the cause of at least one fault in "Current fault incident" is remedied and acknowledged, 

the fault buffer is reorganized. Faults that have not been remedied remain in "Current 
fault incident". 

● If "Current fault incident" contains eight faults and a new fault occurs, the fault in the 
parameters in index 7 is overwritten by the new fault. 

● r0944 is incremented each time the fault buffer changes. 
● A fault value (r0949) can be output for a fault. The fault value is used to diagnose the fault 

more accurately; please refer to the fault description for details of the meaning. 

Clearing the fault buffer 
● The fault buffer is reset as follows: p0952 = 0 

Alarm buffer, alarm history 
The alarm buffer comprises the alarm code, the alarm value and the alarm time (received, 
resolved). The alarm history occupies the last indices ([8...63]) of the parameter.  

 
Figure 3-14 Structure of alarm buffer 



Diagnostics  
3.5 Fault and alarm messages 

 Commissioning Manual 
190 Commissioning Manual, (IH1), 11/2009, 6SL3097-4AF00-0BP0 

Alarms that occur are entered in the alarm buffer as follows: 
A maximum of 64 alarms are displayed in the alarm buffer: 
● Index 0 .. 6: The first 7 alarms are displayed. 
● Index 7: The most recent alarm is displayed. 
A maximum of 56 alarms are displayed in the alarm history: 
● Index 8: The most recent alarm is displayed. 
● Index 9 .. 63: The first 55 alarms are displayed. 
Properties of the alarm buffer/alarm history: 
● The arrangement in the alarm buffer is made after the time that they occurred from 7 to 0. 

In the alarm history, this is from 8 to 63. 
● If 8 alarms have been entered into the alarm buffer, and a new alarm is received, then the 

alarms that have been resolved are transferred into the alarm history. 
● r2121 is incremented each time the alarm buffer changes. 
● An alarm value (r2124) can be output for an alarm. The alarm value is used to diagnose 

the alarm more accurately; please refer to the alarm description for details of the 
meaning. 

Deleting the alarm buffer, index [0...7]: 
● The alarm buffer index [0...7] is reset as follows: p2111 = 0 

3.5.3 Configuring messages 
The properties of the faults and alarms in the drive system are permanently defined.  
The following can be configured for some of the messages within a permanently defined 
framework for the drive system: 
 
Change message type (example) 
Select message Set message type 
p2118[5] = 1001 p2119[5] = 1: Fault (F) 
  = 2: Alarm (A) 
  = 3: No message (N) 
Change fault reaction (example) 
Select message Set fault response 
p2100[3] = 1002 p2101[3] = 0: None 
  = 1: OFF1 
  = 2: OFF2 
  = 3: OFF3 
  = 4: STOP1 (available soon) 
  = 5: STOP2 
  = 6: IASC/DC brake 

Internal armature short-circuit braking 
or DC brake 

  = 7: ENCODER (p0491) 
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Change acknowledgement (example) 
Select message Set acknowledgement 
p2126[4] = 1003 p2127[4] = 1: POWER ON 
  = 2: IMMEDIATELY 
  = 3: PULSE INHIBIT 

 
 

 Note 
If BICO interconnections exist between drive objects, all interconnected objects must be 
configured.  
• Example: 

The TM31 has BICO interconnections with drives 1 and 2, and F35207 is to be 
reconfigured as an alarm. 
– p2118[n] = 35207 and p2119[n] = 2 
– This must be set for TM31 and drives 1/2. 

 

 Note 
Only those messages which are listed in the indexed parameters can be changed as 
desired. All other message settings retain their factory settings or are reset to the factory 
settings.  
Examples:  
• In the case of messages listed via p2128[0...19], the message type can be changed. 

The factory setting is set for all other messages. 
• The fault response of fault F12345 has been changed via p2100[n]. The factory settings 

are to be restored. 
– p2100[n] = 0 
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Triggering on messages (example)  
 
Select message Trigger signal 
p2128[0] = 1001 BO: r2129.0 
or 
p2128[1] = 1002 BO: r2129.1 

 
 

 Note 
The value from CO: r2129 can be used as group trigger. 
CO: r2129 = 0 No selected message has been output. 
CO: r2129 > 0 Group trigger. 
At least one selected message has been output. 
The individual binector outputs BO: r2129 should be investigated. 

 

Triggering messages externally 
If the appropriate binector input is interconnected with an input signal, fault 1, 2 or 3 or alarm 
1, 2 or 3 can be triggered via an external input signal.  
Once an external fault (1 to 3) has been triggered on the Control Unit drive object, this fault 
is also present on all associated drive objects. If one of these external faults is triggered on a 
different drive object, it is only present on that particular drive object. 
 
BI: p2106 ––> External fault 1 ––> F07860(A) 
BI: p2107 ––> External fault 2 ––> F07861(A) 
BI: p2108 ––> External fault 3 ––> F07862(A) 
BI: p2112 ––> External alarm 1 ––> A07850(F) 
BI: p2116 ––> External alarm 2 ––> A07851(F) 
BI: p2117 ––> External alarm 3 ––> A07852(F) 

 
 

 Note 
An external fault or alarm is triggered by a 1/0 signal.  
An external fault and alarm do not usually mean that an internal drive message has been 
generated. The cause of an external fault and warning should, therefore, be remedied 
outside the drive.  
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3.5.4 Parameters and function diagrams for faults and alarms 

Function diagrams (see SINAMICS S120/S150 List Manual)  
● 1710 Overview diagram – monitoring functions, faults, alarms 
● 8060 Faults and alarms – fault buffer 
● 8065 Faults and alarms – alarm buffer 
● 8070 Faults and alarms – fault/alarm trigger word r2129 
● 8075 Faults and alarms – fault/alarm configuration 

Overview of important parameters (refer to the SINAMICS S120/S150 List Manual) 
● r0944 Counter for fault buffer changes 

... 
● p0952 Fault counter 
● p2100[0...19] Fault code for fault reaction selection 

... 
● r2139 Status word for faults 

3.5.5 Forwarding of faults 

Forwarding of CU faults 
When faults are triggered on the drive object of the CU, it is always assumed that central 
functions of the drive unit are affected. For this reason, these faults are not only signaled on 
the drive object of the CU, but may also be forwarded to all other drive objects (propagation). 
The fault reaction affects the drive object of the CU and all other drive objects. This behavior 
also applies to the faults set in a DCC chart on the CU with the aid of DCB STM. 
A fault that is set on the drive object of the CU must be acknowledged on all drive objects to 
which this fault was forwarded. In this way, the fault is then automatically acknowledged on 
the drive object of the CU. Alternatively all faults of all drive objects can also be 
acknowledged on the CU.  
Alarms are not forwarded to other drive objects by the CU. 

Forwarding of faults due to BICO interconnections 
If two or more drive objects are connected via BICO interconnections, faults of drive objects 
of the type CU, TB30, DMC20, TM31, TM15, TM17, TM15DIDO, TM54F_MA, TM54F_SL 
and CU_LINK are forwarded to drive objects of the type AFE, AFEMV, DFEMV, SIC, BIC, 
SERVO, VECTOR, VECTOR_MV, VECTOR_GL, VECTOR_SL and TM41. There is no 
forwarding of faults within these two groups of drive object types. 
This behavior also applies to the faults set in a DCC chart on the above drive object types 
with the aid of DCB STM. 
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3.5.6 Alarm classes 

Fault and alarm classes 
There are differentiated alarm messages in the cyclic telegrams between the former alarm 
classes "Alarm" and "Fault". 
The alarm classes have been extended to give 3 additional levels of alarm between the 
"pure" alarm and the fault. 
The function permits higher-level control (SIMATIC, SIMOTION, SINUMERIK, etc.) to have 
different control reactions to alarm messages from the drive. 
The new statuses act as alarms for the drive, therefore there is NO immediate reaction from 
the drive (like for the former level "alarm"). 
Information on alarm classes are described in status word ZSW2 at bit positions bit 5 - 6 (for 
SINAMICS) or bit 11-12 (SIMODRIVE 611) (see also "ZSW2" in the chapter "Cyclic 
Communication" for PROFIdrive communication in /FH1/SINAMICS S120 Function Manual 
Drive Functions). 
ZSW2: Valid for SINAMICS Interface Mode p2038=0 (function diagram 2454) 
Bit 5 - 6 Alarm classes alarms 
= 0: Alarm (former alarm level) 
= 1: Alarm class A alarms 
= 2: Alarm class B alarms 
= 3: Alarm class C alarms 
ZSW2: Valid for SIMODRIVE 611 Interface Mode p2038=1 (function diagram 2453) 
Bit 11 - 12 Alarm classes alarms 
= 0: Alarm (former alarm level) 
= 1: Alarm class A alarms 
= 2: Alarm class B alarms 
= 3: Alarm class C alarms 
These attributes for differentiating the alarms are implicitly assigned to the appropriate alarm 
numbers. The reaction to the existing alarm classes in the alarm is defined by the user 
program in the higher-level control. 
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Explanations of the alarm classes 
● Alarm class A: Drive operation currently not limited 

– e.g. alarm when measurement systems inactive 
– no limitation on current movement 
– Prevent possible switching to the defective measuring system 

● Alarm class B: Time-limited operation 
– e.g. prewarning temperature: without further action the drive may need to be switched off 
– after a timer stage -> additional fault 
– after exceeding a switch-off threshold -> additional fault 

● Alarm class C: Functionally limited operation 
– e.g. reduced voltage/current/torque/speed limits (i2t) 
– e.g. continue with reduced accuracy / resolution 
– e.g. continue without encoder 

3.6 Troubleshooting for encoders 
If an encoder fault is present, it can be acknowledged separately according to encoder 
channels in a PROFIdrive telegram via the encoder interface (Gn_STW.15) or the drive 
interface of the appropriate DO. 
Sample configuration: 2-encoder system 
● Encoder G1 motor measurement system 
● Encoder G2 direct measurement system 
Case considered:  
All encoders signal encoder faults. 
● The errors are entered in the encoder interface, and from there into the encoder channel 

n of the PROFIDRIVE telegram. Bit15 is set as the encoder status word (Gn_ZSW.15=1). 
● The faults are forwarded to the drive DO. 
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● The motor measurement system faults set the drive DO to fault (ZSW1 bit3), the faults 
are additionally signaled via the drive interface. An entry is made in fault buffer p0945. 
The parameterized fault reaction is initiated internally. 

● The direct measurement system faults are readdressed as alarms via the appropriate 
drive DO and signaled via the drive interface (ZSW1 bit7). An entry is made in alarm 
buffer r2122. 
No drive reactions are initiated. 

A 

A 
F  

F  

FA

F  
F  

F

FA FA

F

F F

G21G

DO

 
Figure 3-15 Encoder troubleshooting 

Alarm A:  
The alarm is canceled immediately, if the encoder fault was able to be acknowledged. 
Fault F:  
The fault remains on the drive DO until it is acknowledged via the cyclic interface. 
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Cyclic acknowledgment 
Acknowledgment using the encoder interface (Gn_STW.15)  
The following responses are possible: 
● If no more faults are present, the encoder is set to fault free and the fault bit in the 

encoder interface is acknowledged. The evaluation modules indicate RDY LED=green 
after acknowledgement.  
This behavior is valid for all encoders connected to the encoder interface, irrespective of 
the measurement system type (motor or direct). 

● If the fault is still present, or other faults are, the acknowledgment is not successful; the 
highest priority fault (can be the same or another fault entry) is transmitted via the 
encoder interface.  
The evaluation modules indicate RDY LED=red continuously. 
This behavior is valid for all encoders connected to the encoder interface, irrespective of 
the measurement system type (motor or direct). 

● The drive DO is not recorded via the encoder interface. Faults set in the drive DO remain, 
the drive will not even start with the meanwhile fault-free encoder. 
The drive DO must also be acknowledged via the drive interface (fault memory RESET). 
 

 

 
 

Note 
The possibility to acknowledge directly via the encoder interface is especially important in 
the event that "free encoder assignment" is used. 
If an encoder on the drive side is assigned a certain drive X, but on the NC side a 
completely different axis Y, then such parameterized coupling with the fault memory reset 
(acknowledge drive) is not completely solvable. Drive X, waiting for a fault memory reset, 
does not receive one from the NC, but a completely different drive Y receives it, and 
cannot carry it out. 

 

 
Acknowledgment using the drive interface (STW1.7 (cyclic) or p3981(acyclic)) 
The following responses are possible: 
● If no more errors are present, the encoder is set to fault free and the fault bit in the drive 

interface is acknowledged. The evaluation modules indicate RDY LED=green.  
Acknowledgment takes place on all encoders that are logically assigned to the drive. 

● If the fault is still present, or other errors are, the acknowledgment is not successful; the 
next, highest priority fault is transmitted via the drive interface and also via the affected 
encoder interface. 

● The evaluation modules indicate RDY LED=red continuously. 
● The encoder interfaces of the assigned encoders are NOT reset by acknowledgement at 

the drive interface; the set faults remain. 
● The encoder interfaces must also be acknowledged via the corresponding encoder 

control word Gn_STW.15. 
 



Diagnostics  
3.6 Troubleshooting for encoders 

 Commissioning Manual 
198 Commissioning Manual, (IH1), 11/2009, 6SL3097-4AF00-0BP0 

 



 

Commissioning Manual 
Commissioning Manual, (IH1), 11/2009, 6SL3097-4AF00-0BP0 199 

Appendix A
A.1 Availability of hardware components 

Table A- 1 Hardware components available as of 03.2006 

No. HW component Order number Version Revisions 
1 AC Drive (CU320, PM340) refer to the Catalog  new 
2 SMC30 6SL3055-0AA00-5CA1  with SSI support 
3 DMC20 6SL3055-0AA00-6AAx  new 
4 TM41 6SL3055-0AA00-3PAx  new 
5 SME120 

SME125 
6SL3055-0AA00-5JAx 
6SL3055-0AA00-5KAx 

 new 

6 BOP20 6SL3055-0AA00-4BAx  new 
7 CUA31 6SL3040-0PA00-0AAx  new 

 

Table A- 2 Hardware components available as of 08.2007 

No. HW component Order number Version Revisions 
1 TM54F 6SL3055-0AA00-3BAx  new 
2 Active Interface Module 

(booksize) 
6SL3100-0BExx-xABx  new 

3 Basic Line Module (booksize) 6SL3130-1TExx-0AAx  new 
4 DRIVE-CLiQ encoder 6FX2001-5xDxx-0AAx  new 
5 CUA31 

Suitable for Safety Extended 
Functions PROFIsafe (dbSI1) 
and TM54 (dbSI2) 

6SL3040-0PA00-0AA1  new 

6 CUA32 6SL3040-0PA01-0AAx  new 
7 SMC30 (30 mm wide) 6SL3055-0AA00-5CA2  new 

 

Table A- 3 Hardware components available as of 10.2008 

No. HW component Order number Version Revisions 
1 TM31     6SL3055-0AA00-3AA1  new 
2 TM41 6SL3055-0AA00-3PA1  new 
3 DME20 6SL3055-0AA00-6ABx  new 
4 SMC20 (30 mm wide) 6SL3055-0AA00-5BA2  new 
5 Active Interface Module 

booksize 16 kW 
6SL3100-0BE21-6ABx  new 
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No. HW component Order number Version Revisions 
6 Active Interface Module 

booksize 36 kW 
6SL3100-0BE23-6ABx  new 

7 Smart Line Modules booksize 
compact 

6SL3430-6TE21-6AAx  new 

8 Motor Modules booksize 
compact 

6SL3420-1TE13-0AAx 
6SL3420-1TE15-0AAx 
6SL3420-1TE21-0AAx 
6SL3420-1TE21-8AAx 
6SL3420-2TE11-0AAx 
6SL3420-2TE13-0AAx 
6SL3420-2TE15-0AAx 

 new 

9 Power Modules blocksize liquid 
cooled 

6SL3215-1SE23-0AAx 
6SL3215-1SE26-0AAx 
6SL3215-1SE27-5UAx 
6SL3215-1SE31-0UAx 
6SL3215-1SE31-1UAx 
6SL3215-1SE31-8UAx 

 new 

10 Reinforced DC link busbars for 
50 mm components 

6SL3162-2DB00-0AAx  new 

11 Reinforced DC link busbars for 
100 mm components 

6SL3162-2DD00-0AAx  new 

 

Table A- 4 Hardware components available as of 11.2009 

No. HW component Order number Version Revisions 
1 CU320-2 DP 6SL3040-1MA00-0AA0  new 
2 TM120 6SL3055-0AA00-3KA0  new 
3 SMC10 (30mm) 6SL3055-0AA00-5AA0  new 
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Suggested improvements 
If you come across any misprints in this document, please let us know using this form. 
We would also be grateful for any suggestions and recommendations for improvement. 
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Index 

A 
Acknowledgment, 187 
Actual position value format 

2-pole resolver, 144 
Alarm buffer, 189 
Alarm classes 

Faults and alarms, 194 
Alarm history, 189 
Alarm value, 189 
Alarms, 186 

Alarm buffer, 189 
Alarm history, 189 
Configure, 190 

B 
Blocksize 

PM, 21 
Booksize 

Booksize power unit, 19 
BOP20 

Control word, drive, 73 
Important functions, 63, 73 

C 
Chassis, 19 
Commissioning 

Checklist, 19, 21 
with STARTER, 48 

Control Unit 
LEDs during booting, 151 

Control Unit CU320 
LEDs after booting, 152 

D 
DDS 

Drive data set, 184 
Diagnosis 

LEDs on Double Motor Module, 158 
LEDs on Power Module, 158 

using LEDs on Active Line Module, 154 
using LEDs on Basic Line Module, 155 
using LEDs on Braking Module Booksize, 159 
using LEDs on Control Supply Module, 159 
using LEDs on Sensor Module Cabinet 10, 159 
using LEDs on Sensor Module Cabinet 20, 159 
using LEDs on Single Motor Module, 158 

Diagnostic buffer, 180 
Diagnostic function, 168 

Function generator, 168 
Measuring sockets, 176 
Trace, 172 

Diagnostics 
LEDs on Smart Line Module, 156, 157 
using LEDs on Communication Board CBC10, 164 
using LEDs on Communication Board CBE20, 165 
using LEDs on Control Unit 320, 152 
using LEDs on Sensor Module Cabinet SMC30, 160 
using LEDs on Terminal Module TM15, 161 
using LEDs on Terminal Module TM31, 162 
using LEDs on Terminal Module TM41, 162 
using LEDs on Terminal Module TM54F, 163 
via LEDS for DRIVE-CLiQ Hub Module 
DMC20, 167 
via LEDs for Voltage Sensing Module VSM10, 166 

Drive interface, 195, 197 
DRIVE-CLiQ 

Wiring rules, 26 
DRIVE-CLiQ encoder, 126 

E 
EDS 

Encoder data set, 184 
Encoder 

Configuration, 121 
Linear, 125 
Rotary, 124 
Troubleshooting, 195 
User-defined, 123 

Encoder evaluation, 141 
Encoder interface, 195, 197 
Encoder selection, 119 
Encoder types, 141 
EPOS 

Absolute encoder adjustment, 144 
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F 
Fault buffer, 188 
Fault value, 188 
Faults, 186 

Acknowledgement, 187 
Configure, 190 
Fault buffer, 188 

Faults and alarms, 193 
Alarm classes, 194 
BICO interconnections, 193 

Function generator, 169 
Properties, 169 

G 
Generator for signals, 168 

H 
Hotline, 6 

I 
Initialization 

Initializing the interface, 55 
Internal Ethernet interface 

LAN interface, 52 

L 
Learning devices, 118 
LEDs 

for Power Module, 158 
for Sensor Module Cabinet SMC30, 160 
for Terminal Module TM15, 161 
for Terminal Module TM31, 162 
for Terminal Module TM41, 162 
for Terminal Module TM54F, 163 
for the DRIVE-CLiQ Hub Module DMC20, 167 
for the Voltage Sensing Module VSM10, 166 
on Active Line Module, 154 
on Basic Line Module, 155 
on Braking Module Booksize, 159 
on Control Supply Module, 159 
on Double Motor Module, 158 
on Sensor Module Cabinet 10, 159 
on Sensor Module Cabinet 20, 159 
on Single Motor Module, 158 
on Smart Line Module, 156, 157 

with Communication Board CBC10, 164 
with Communication Board CBE20, 165 
with Control Unit CU320, 152 

Line protection, 20 
Power unit, 20 

M 
MDS 

Motor data set, 184 
Measuring sockets, 176 
Messages, 186 

Configure, 190 
External triggering, 192 

Motor Modules 
Parallel connection commissioning, 113, 114 

Motor temperature monitoring 
Motor temperature, 20 

N 
Number of controllable drives 

Notes, 38 

O 
Online operation with STARTER, 51, 57 

P 
Parameterization 

using the BOP, 63 
Parameterize 

with STARTER, 48 
Parameterizing the internal LAN interface, 57 

Internal LAN interface, 57 
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